Contents


Product Basics .......................................................................................................................................... 16

Product Parts Locations ............................................................................................................................ 16

Product Parts - Front ............................................................................................................................... 17

Product Parts - Inside .............................................................................................................................. 19

Product Parts - Back .............................................................................................................................. 22

Optional Accessories and Replacement Parts ...................................................................................... 23

Using the Control Panel ........................................................................................................................ 24

Control Panel Buttons and Lights ........................................................................................................ 24

Status Icon Information ....................................................................................................................... 25

Changing the LCD Screen Language .................................................................................................... 26

Selecting the Date and Time .................................................................................................................. 27

Selecting Your Country or Region (WF-C17590/WF-C20590/WF-M20590F) ..................................... 30

Adjusting Control Panel Sounds ......................................................................................................... 31

Adjusting the Screen Brightness .......................................................................................................... 32

Changing the Operation Time Out Setting ......................................................................................... 33

Using Power Saving Settings .............................................................................................................. 36

Changing the Sleep Timer Settings ..................................................................................................... 36

Changing the Power Off Timer Settings .............................................................................................. 38

Entering Characters on the LCD Screen .............................................................................................. 39

Setting a Password and Locking the Control Panel .......................................................................... 39

Setting User Feature Restrictions (Access Control) ........................................................................... 42

Preventing PC Connection via USB ..................................................................................................... 43

Using Presets ........................................................................................................................................ 44

Checking the Print Counter .................................................................................................................. 47

Checking the Circuit Breaker ............................................................................................................... 48

Checking for Software Updates ......................................................................................................... 51

Epson Connect Solutions for Smartphones, Tablets, and More .......................................................... 51

Setting Up Epson Connect Services .................................................................................................... 52

Using Epson Email Print ...................................................................................................................... 53
Selecting Finishing Options - Windows ................................................................. 137
Finishing Options - Windows .............................................................................. 138
Selecting Additional Print Options - Windows ...................................................... 139
  Custom Color Correction Options - Windows ...................................................... 141
  Header/Footer Settings - Windows ..................................................................... 142
  Image Options and Additional Settings - Windows ............................................. 143
Selecting a Printing Preset - Windows ................................................................. 143
Selecting Extended Settings - Windows ............................................................... 144
  Extended Settings - Windows ......................................................................... 146
Printing Your Document or Photo - Windows ..................................................... 147
Locking Printer Settings - Windows .................................................................... 148
  Locked Setting Options .................................................................................. 150
Entering a User ID and Password for Printing .................................................. 151
Selecting Default Print Settings - Windows ......................................................... 152
  Changing the Language of the Printer Software Screens ............................... 152
Changing Automatic Update Options ............................................................... 153
Printing with the Epson Standard Printer Software - Mac ............................... 154
  Selecting Basic Print Settings - Mac ................................................................. 155
    Paper Source Options - Mac ....................................................................... 159
    Print Quality Options - Mac ....................................................................... 159
  Selecting Page Setup Settings - Mac ............................................................... 160
  Selecting Print Layout Options - Mac .............................................................. 161
Managing Color - Mac ...................................................................................... 161
  Color Matching and Color Options - Mac ....................................................... 162
Selecting Finishing Options - Mac ................................................................. 163
  Finishing Options - Mac ................................................................................ 164
Selecting Paper Configuration Settings - Mac .................................................... 165
Selecting Double-sided Printing Settings - Mac ................................................. 165
  Double-sided Printing Options and Adjustments - Mac ................................. 166
Selecting Printing Preferences - Mac ............................................................... 166
  Printing Preferences - Mac ......................................................................... 167
Printing Your Document or Photo - Mac ........................................................... 168
  Checking Print Status - Mac ....................................................................... 169
Printing with the Epson Universal Print Driver - Windows ................................................................. 169
Synchronizing Printer Settings - Epson Universal Print Driver - Windows ............................................. 170
Selecting Basic Print Settings - Epson Universal Print Driver - Windows ........................................... 171
Selecting Additional Layout and Print Options - Epson Universal Print Driver - Windows ................. 174
Selecting Maintenance Options - Epson Universal Print Driver - Windows ...................................... 176
Extended Settings - Epson Universal Print Driver - Windows ............................................................ 177
Selecting Default Print Settings - Epson Universal Print Driver - Windows ......................................... 178
Locking Printer Settings - Epson Universal Print Driver - Windows .................................................... 180
Epson Universal Print Driver Locked Setting Options .......................................................................... 181
Adding Network Printers - Epson Universal Print Driver - Windows .................................................. 182
Printing with the PostScript (PS3) Printer Software - Windows ............................................................ 185
Selecting Basic Print Settings - PostScript Printer Software - Windows ................................................ 185
Selecting Additional Layout and Print Options - PostScript Printer Software - Windows ...................... 188
Selecting Default Print Settings - PostScript Printer Software - Windows ......................................... 189
Printing with the PostScript (PS3) Printer Software - Mac ................................................................. 189
Selecting Basic Print Settings - PostScript Printer Software - Mac ...................................................... 190
Selecting Page Setup Settings - PostScript Printer Software - Mac ..................................................... 194
Selecting Print Layout Options - PostScript Printer Software - Mac .................................................. 195
Sizing Printed Images - PostScript Printer Software - Mac ................................................................. 196
Managing Color - PostScript Printer Software - Mac ......................................................................... 196
Printing Your Document or Photo - PostScript Printer Software - Mac .............................................. 197
Checking Print Status - PostScript Printer Software - Mac ................................................................. 198
Cancelling Printing Using the Product Control Panel ........................................................................... 199
Scanning .................................................................................................................................................. 200
Starting a Scan ........................................................................................................................................ 200
Starting a Scan Using the Product Control Panel .................................................................................... 200
Scanning to Email .................................................................................................................................. 202
Adding and Assigning Scan Jobs with Document Capture Pro or Document Capture ......................... 205
Scanning to a Memory Device .............................................................................................................. 206
Scanning to the Cloud ............................................................................................................................. 208
Setting Up a WSD Port (Windows 7/Windows Vista) ............................................................................. 211
Control Panel Scanning Options ............................................................................................................ 211
Setting Up and Scanning to a Network Folder or FTP Server ............................................................... 214
Connecting a USB Device ................................................................. 309
Viewing and Printing from the LCD Screen ......................................................... 310
Printing JPEG Photos .................................................................................. 310
  Print Setting Options - JPEG Mode ......................................................... 311
Printing TIFF and PDF Files ........................................................................ 313
  Print Setting Options - TIFF Mode ......................................................... 314
  Print Setting Options - PDF Mode ......................................................... 315
Transferring Files on a USB Device .............................................................. 317
  Setting Up File Sharing for File Transfers from Your Computer ................. 317
  Transferring Files from a USB Device ..................................................... 319
Replacing Ink Cartridges and Maintenance Boxes ...................................... 320
  Check Cartridge and Maintenance Box Status ........................................ 320
  Checking Ink Status on the LCD Screen ................................................ 320
  Checking Ink and Maintenance Box Status with Windows ....................... 322
  Checking Cartridge and Maintenance Box Status - Mac ......................... 325
Purchase Epson Ink Cartridges and Maintenance Box ................................ 327
  Ink Cartridge and Maintenance Box Part Numbers .................................. 327
Removing and Installing Ink Cartridges ....................................................... 328
Replacing the Maintenance Box ................................................................. 330
Replacing the Optional Staple Cartridge ....................................................... 331
Adjusting Print Quality ............................................................................... 335
  Print Head Maintenance .......................................................................... 335
    Checking the Nozzles Using the Product Control Panel ......................... 335
    Cleaning the Print Head Using the Product Control Panel ..................... 339
Cleaning and Transporting Your Product .................................................... 341
  Cleaning Your Product ............................................................................ 341
  Cleaning the Automatic Document Feeder ................................................ 341
  Cleaning the Paper Rollers ...................................................................... 343
  Cleaning the Optional Bridge Unit .......................................................... 346
  Cleaning the Optional Finisher Unit ........................................................ 348
  Moving or Transporting Your Product ..................................................... 349
# Solving Problems

- Viewing the Help Screen .......................................................... 350
- Product Status Messages .......................................................... 350
- Job Status Error Codes ............................................................ 353
- Running a Product Check ......................................................... 358
- Resetting Control Panel Defaults ............................................ 360
- Solving Setup Problems .......................................................... 361
  - Product Does Not Turn On or Off ....................................... 362
  - Noise After Ink Installation .................................................. 362
  - Software Installation Problems ............................................ 362
- Solving Network Problems ...................................................... 363
  - Product Cannot Connect to a Wireless Router or Access Point ........................................ 363
  - Network Software Cannot Find Product on a Network ................................................... 365
  - Product Does Not Appear in Mac Printer Window ......................................................... 366
  - Cannot Print Over a Network .................................................. 366
  - Cannot Scan Over a Network .................................................. 368
- Solving Copying Problems ....................................................... 369
  - Product Cannot Copy ............................................................ 369
  - Product Makes Noise, But Nothing Copies ............................ 370
  - Product Makes Noise When It Sits for a While ........................ 370
  - Originals Do Not Feed From the Automatic Document Feeder ........................................ 370
- Solving Copy Quality Problems ................................................ 371
  - Copies Have Incorrect or Faint Colors .................................. 371
  - Position, Size, or Margins of Copies are Incorrect .......................... 371
- Solving Paper Problems .......................................................... 372
  - Paper Feeding Problems ....................................................... 372
  - Paper Jam Problems ............................................................ 373
  - Paper Ejection Problems ....................................................... 373
- Solving Problems Printing from a Computer ............................ 373
  - Nothing Prints .................................................................... 374
  - Product Icon Does Not Appear in Windows Taskbar ............... 374
  - Printing is Slow ................................................................... 375
- Solving PostScript Printing Problems ....................................... 377
Nothing Prints Using the PostScript Printing Software ................................................................. 377
Documents Print Incorrectly Using the PostScript Printing Software ........................................... 377
Accessing Printer Properties - PostScript - Windows ................................................................. 378
Solving Page Layout and Content Problems .................................................................................... 378
  Inverted Image ............................................................................................................................. 379
  Too Many Copies Print ................................................................................................................ 379
  Blank Pages Print ........................................................................................................................ 379
  Incorrect Margins on Printout ...................................................................................................... 380
  Incorrect Characters Print .......................................................................................................... 380
  Incorrect Image Size or Position ................................................................................................. 381
  Slanted Printout .......................................................................................................................... 381
Solving Print Quality Problems ......................................................................................................... 382
  White or Dark Lines in Printout .................................................................................................... 382
  Blurry or Smeared Printout .......................................................................................................... 383
  Faint Printout or Printout Has Gaps ............................................................................................ 384
  Grainy Printout ............................................................................................................................ 385
  Incorrect Colors ........................................................................................................................... 386
Solving Scanning Problems ............................................................................................................. 386
  Scanning Software Does Not Operate Correctly ...................................................................... 387
  Cannot Start Epson Scan 2 ......................................................................................................... 387
Solving Scanned Image Quality Problems ....................................................................................... 388
  Image Consists of a Few Dots Only ............................................................................................ 388
  Line of Dots Appears in All Scanned Images ............................................................................ 389
  Straight Lines in an Image Appear Crooked ............................................................................ 389
  Image is Distorted or Blurry ........................................................................................................ 390
  Image Colors are Patchy at the Edges ..................................................................................... 390
  Image is Too Dark ....................................................................................................................... 390
  Back of Original Image Appears in Scanned Image ................................................................. 390
  Ripple Patterns Appear in an Image ......................................................................................... 391
  Scanned Image Colors Do Not Match Original Colors ............................................................ 391
  Scanned Image Edges are Cropped ............................................................................................ 392
Solving Faxing Problems .................................................................................................................. 392
  Cannot Send or Receive Faxes .................................................................................................. 392
Cannot Receive Faxes with a Telephone Connected to Your Product ........................................ 394
Fax Memory Full Error Appears................................................................................................... 394
Sent Fax Quality is Poor .............................................................................................................. 395
Sent Fax is Received in an Incorrect Size ................................................................................... 396
Received Fax Quality is Poor ...................................................................................................... 396
Received Fax is Not Printed ........................................................................................................ 396
Solving USB Device Problems ......................................................................................................... 397
Cannot View or Print from a USB Device..................................................................................... 397
Cannot Save Files on a USB Device ........................................................................................... 397
Cannot Transfer Files To or From a USB Device......................................................................... 398
Uninstall Your Product Software....................................................................................................... 398
Uninstalling Product Software - Windows .................................................................................... 398
Uninstalling Product Software - Mac............................................................................................ 399
Where to Get Help ........................................................................................................................... 400

Technical Specifications ........................................................................................................................ 402
Windows System Requirements ...................................................................................................... 402
Mac System Requirements .............................................................................................................. 403
Paper Specifications ........................................................................................................................ 404
Printable Area Specifications ........................................................................................................... 405
Scanning Specifications ................................................................................................................... 406
Automatic Document Feeder (ADF) Specifications ........................................................................ 407
Fax Specifications (WF-C17590/WF-C20590/WF-M20590F) .......................................................... 407
Ink Cartridge Specifications ............................................................................................................ 408
Dimension Specifications .................................................................................................................. 409
Electrical Specifications ................................................................................................................... 410
Environmental Specifications ........................................................................................................... 411
Interface Specifications .................................................................................................................... 411
External USB Device Specifications ............................................................................................... 412
Network Interface Specifications .................................................................................................... 412
Safety and Approvals Specifications ............................................................................................... 413

Notices ..................................................................................................................................................... 415
Important Safety Instructions ........................................................................................................ 415
General Product Safety Instructions ............................................................................................... 415
Note: The WF-M20590 is a monochrome product and does not include a fax function. The sections of this guide that refer to faxing or color printing do not apply to this product.

Note: The WF-M20590F is a monochrome product. The sections of this guide that refer to color printing do not apply to this product.


For a printable PDF copy of this guide, click here.
Product Basics

See these sections to learn about the basic features of your product.

Note: This product contains an encrypted hard drive that is used for storing large and/or authenticated print, copy, and scan jobs. You may erase data stored on the encrypted hard drive by following the steps outlined in the Administrator’s Guide. It is recommended that data is erased before disposing or giving away the product.

Note: Your product may differ from the images in this guide, but the instructions are the same unless otherwise noted.

Note: Printing software instructions in this manual are intended for use with the standard Epson printer software. For more information on using the Printer Command Language (PCL) or PostScript (PS3) printer software, please see the appropriate sections.

Product Parts Locations
Optional Accessories and Replacement Parts
Using the Control Panel
Checking the Circuit Breaker
Checking for Software Updates
Epson Connect Solutions for Smartphones, Tablets, and More
Using Google Cloud Print
Android Printing Using the Epson Print Enabler
Using Fire OS Printing
Using Windows 10 Mobile Printing
Using Epson Print and Scan App with Windows Tablets
Printing and Scanning with NFC from Your Android Device

Product Parts Locations
See these sections to identify the parts on your product.

Product Parts - Front
Product Parts - Inside
Product Parts - Back
Certain parts are labeled with a letter and number code. If you encounter any paper jams or errors, you can use these codes to locate and correct the problem when a message appears on the LCD screen.

1  Paper clip holder
2  Control panel
3  ADF cover (F)
4  Automatic Document Feeder (ADF)
5 ADF edge guide
6 ADF input tray
7 ADF output tray
8 Facedown paper eject tray (K)
9 Multi-purpose (MP) tray (B)
10 Cover (J)
11 Cover (E)
12 Paper cassette 4 (C4)
13 Paper cassette 3 (C3)
14 Paper cassette 2 (C2)
15 Paper cassette 1 (C1)
16 Front cover (L)
17 Ink cartridge cover (A)
18 External USB port

Parent topic: Product Parts Locations
Product Parts - Inside

Certain parts are labeled with a letter and number code. If you encounter any paper jams or errors, you can use these codes to locate and correct the problem when a message appears on the LCD screen.

1  Document cover
2  Scanner glass
3  Multi-purpose (MP) tray edge guide
1  Ink cartridge cover (A)
2  Front cover (L)
3  Cleaner tool storage (can be used to clean scanner glass)

4  Multi-purpose (MP) tray (B)
5  Paper cassette edge guides
6  Faceup paper eject tray (G)
4 Ink cartridges (WF-C17590/WF-C20590: Cyan/Magenta/Yellow/Black x2; WF-M20590/WF-M20590F: Black x2)
5 Maintenance box
6 Maintenance box cover (H)
7 Duplexing unit (D1)

Parent topic: Product Parts Locations
Product Parts - Back

1. **USB port**
2. **LAN port**
3. **EXT. port (WF-C17590/WF-C20590/WF-M20590F)**
4. **Line port (WF-C17590/WF-C20590/WF-M20590F)**
5 Circuit breaker cover (may not appear on all products)
6 AC inlet

Note: If you are using a USB connection, you must insert the cable in the correct orientation.

Optional Accessories and Replacement Parts

You can purchase genuine Epson accessories at epson.com (U.S. sales), epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase accessories from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

<table>
<thead>
<tr>
<th>Option or part</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replacement maintenance box</td>
<td>T6713</td>
</tr>
<tr>
<td>Paper cassette lock</td>
<td>C12C933231</td>
</tr>
<tr>
<td>Staple cartridge</td>
<td>C13S210061</td>
</tr>
<tr>
<td>Finisher*</td>
<td>C12C933261</td>
</tr>
<tr>
<td>High-capacity input tray*</td>
<td>C12C933331</td>
</tr>
</tbody>
</table>

* Must be installed by an Epson authorized reseller or technician.

Parent topic: Product Parts Locations

Parent topic: Product Basics
Using the Control Panel

See these sections to learn about the control panel and select control panel settings.

- Control Panel Buttons and Lights
- Changing the LCD Screen Language
- Selecting the Date and Time
- Selecting Your Country or Region (WF-C17590/WF-C20590/WF-M20590F)
- Adjusting Control Panel Sounds
- Adjusting the Screen Brightness
- Changing the Operation Time Out Setting
- Using Power Saving Settings
- Entering Characters on the LCD Screen
- Setting a Password and Locking the Control Panel
- Setting User Feature Restrictions (Access Control)
- Preventing PC Connection via USB
- Using Presets
- Checking the Print Counter

Parent topic: Product Basics

Control Panel Buttons and Lights
1. ⚡ power button
2. 🏡 home button
3. LCD touchscreen
4. NFC (Near Field Communication) tag
5. 📱 data light
6. ⚠ error light
7. 📞 fax reception light (WF-C17590/WF-C20590/WF-M20590F)
8. ⚤ power light

**Note:** If the LCD screen is dark, press the screen to wake the product from sleep mode.

### Status Icon Information

**Parent topic:** Using the Control Panel

#### Status Icon Information

Your product displays status icons on the LCD screen for certain product status conditions. Press the 📱 or 📦 icon to view or change the current network settings.

<table>
<thead>
<tr>
<th>Icons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📱 or 📦 Job/Status</td>
<td>Displays the Job Status, Printer Status, and Consumeables/Others screens.</td>
</tr>
<tr>
<td>🖍️</td>
<td>No Ethernet connection.</td>
</tr>
<tr>
<td>🖍️</td>
<td>An Ethernet connection is established.</td>
</tr>
<tr>
<td>🖍️</td>
<td>No Wi-Fi connection.</td>
</tr>
<tr>
<td>🖍️</td>
<td>A Wi-Fi network error has occurred or the product is searching for a connection.</td>
</tr>
<tr>
<td>🖍️</td>
<td>A Wi-Fi connection is established. The number of bars indicates the connection's signal strength.</td>
</tr>
<tr>
<td>🖍️</td>
<td>No Wi-Fi Direct connection.</td>
</tr>
<tr>
<td>🖍️</td>
<td>A Wi-Fi Direct connection is established.</td>
</tr>
<tr>
<td>Icons</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>![Mute icon]</td>
<td>The Mute setting is enabled. The product does not make any sound when you press buttons or select icons on the control panel. Select this icon to change the setting.</td>
</tr>
<tr>
<td>![Quiet Mode icon]</td>
<td>Quiet Mode is enabled. Noise is reduced during printing, but the print speed may be reduced. Select this icon to change the setting.</td>
</tr>
<tr>
<td>![Quiet Mode Off icon]</td>
<td>Quiet Mode is disabled. Select this icon to change the setting.</td>
</tr>
<tr>
<td>![Sleep Mode icon]</td>
<td>Enables sleep mode and turns off the LCD screen.</td>
</tr>
<tr>
<td>![Help icon]</td>
<td>Displays the help screen with how-to and troubleshooting topics.</td>
</tr>
<tr>
<td>![Fax Data Information icon]</td>
<td>Displays the <strong>Fax Data Information</strong> screen (WF-C17590/WF-C20590WF-M20590F).</td>
</tr>
<tr>
<td>![Job Interruption icon]</td>
<td>Enters job interruption mode. Select again to turn this mode off.</td>
</tr>
<tr>
<td>![Paper Setting icon]</td>
<td>Displays the <strong>Paper Setting</strong> screen.</td>
</tr>
<tr>
<td>![Additional Information icon]</td>
<td>Displays additional information or instructions, such as loading paper or placing a document.</td>
</tr>
<tr>
<td>![Setting Changed icon]</td>
<td>The indicated setting has changed.</td>
</tr>
<tr>
<td>![Warning icon]</td>
<td>There is a problem with the indicated setting. Select the icon to resolve the problem.</td>
</tr>
<tr>
<td>![Restricted Access icon]</td>
<td>Access to the product's functions are restricted to authorized users. Select the icon to log in using a user name and password. Contact your administrator if you do not know the login information.</td>
</tr>
<tr>
<td>![Restricted Access with User icon]</td>
<td>Access to the product's functions are restricted to authorized users and a user is currently logged in. Select the icon to log out of the current user account.</td>
</tr>
</tbody>
</table>

**Parent topic:** [Control Panel Buttons and Lights](#)

### Changing the LCD Screen Language

You can change the language used on the LCD screen.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the **home** button, if necessary.

---

26
2. Select **Settings**.
3. Select **General Settings**.
   You see the **Basic Settings** screen:

4. Select **Language**.
5. Select a language.
6. Press the home button to exit.

**Parent topic:** Using the Control Panel

### Selecting the Date and Time

Before using your product, select the current date, time, and daylight saving phase in your area, and choose your preferred date and time format.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
   
   You see the **Basic Settings** screen:

![Basic Settings screen](image)

4. Select **Date/Time Settings**.
You see a screen like this:

5. Select **Daylight Saving Time**.
6. Select the setting that applies to your area:
   - **Winter**: it is winter or your region does not use Daylight Saving Time (DST)
   - **Summer**: it is spring or summer and your region uses Daylight Saving Time (DST)

   **Note**: If your region uses Daylight Saving Time (DST), you must change this setting to match the season. When you change from **Winter** to **Summer**, your product automatically sets its clock ahead one hour. When you change from **Summer** to **Winter**, it sets its clock back one hour.

7. Select **Date/Time**.
8. Select the date format you want to use.
9. Use the on-screen keyboard to enter the current date.
10. Select the time format you want to use.
11. Use the on-screen keyboard to enter the current time.
12. Press the \( \text{🏠} \) home button to exit.
Selecting Your Country or Region (WF-C17590/WF-C20590/WF-M20590F)

Before using your product, select the country or region in which you are using it.

**Note:** If you change the country or region, your fax settings return to their defaults and you must select them again. This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
   You see the **Basic Settings** screen:

4. Select **Country/Region**.
5. Scroll up or down, if necessary, and select your country or region.
   You see a confirmation screen.
6. If the setting is correct, select Yes. (If not, select No and retry.)
7. Press the home button to exit.

Parent topic: Using the Control Panel

Adjusting Control Panel Sounds
You can adjust the sound level heard when you press buttons on the control panel.

Note: This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
4. Select Sound.
5. Select the desired sound level.
6. Press OK to save your selection.
5. Select **Normal Mode** or **Quiet Mode**.

   **Note**: You can also select the 🎧 icon on the Home screen to switch between Normal Mode and Quiet Mode.

6. Press 🎧 to decrease or 🔊 to increase the sound level for the displayed functions.

7. When you finish, select **OK**.

8. Press the 🎧 home button to exit.

   **Note**: You can also select a **Sound Type** for various product functions.

**Parent topic**: Using the Control Panel

## Adjusting the Screen Brightness

You can adjust the brightness of the LCD screen.

1. Press the 🎧 home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
You see the **Basic Settings** screen:

![Basic Settings screen](image)

4. Select **LCD Brightness**.
5. Select the – or + icons to decrease or increase the brightness.
6. When you finish, select **OK**.
7. Press the home button to exit.

**Parent topic:** Using the Control Panel

## Changing the Operation Time Out Setting

The Operation Time Out setting causes the LCD screen to return to the Home screen after a few minutes of inactivity. This feature is enabled by default, but you can turn it off.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
   You see the **Basic Settings** screen:

4. Select **Operation Time Out**.
You see this screen:

5. Select the **Operation Time Out** field to turn the setting on or off.

   **Note:** If the setting is turned on and printing is paused from the computer or the control panel, printing resumes automatically if no operations are performed for the specified amount of time.

6. If the setting is turned on, do one of the following:
   - Select the + or – icon to decrease or increase the number of minutes or seconds before the LCD screen returns to the Home screen.
   - Select the number of minutes or seconds field, enter a number using the on-screen keyboard, and select **OK**.

7. When you finish, select **OK**.

8. Press the home button to exit.

**Parent topic:** Using the Control Panel
Using Power Saving Settings

Your product enters sleep mode automatically and turns off the LCD screen if it is not used for a period of time. You can make the time period shorter and select other options to save energy and resources.

Changing the Sleep Timer Settings
Changing the Power Off Timer Settings
Parent topic: Using the Control Panel

Changing the Sleep Timer Settings

You can adjust the time period before your product enters sleep mode and turns off the LCD screen.

Note: This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.

You see the Basic Settings screen:
4. Select **Sleep Timer**.
   You see a screen like this:

![Settings Screen](image)

5. Do one of the following:
   - Select the – or + icon to decrease or increase the number of minutes before the product enters sleep mode.
   - Select the number of minutes field, enter a number using the on-screen keyboard, and select **OK**.

6. When you finish, select **OK**.

7. Select **Wake from Sleep**.

8. Select **Wake with LCD Screen Touch**.

9. Do one of the following:
   - Select **On** to wake the printer from sleep mode by tapping the LCD touchscreen or by pressing the ⚪️ power button.
   - Select **Off** to only wake the printer from sleep mode by pressing the ⚪️ power button. This prevents unintentional operations due to objects bumping the LCD touchscreen.

10. Press the ⬆️ home button to exit.
Changing the Power Off Timer Settings

You can have the product turn off automatically if it is not used for a specified period of time.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.

You see the **Basic Settings** screen:

4. Select **Power Off Timer**.
5. Select a time period between **30 minutes** and **12h** (12 hours).
6. Press the home button to exit.

**Parent topic:** Using Power Saving Settings
Entering Characters on the LCD Screen

Follow these guidelines to enter characters on the LCD screen for passwords and other settings.

- To move the cursor, select the left or right arrows.
- To change the case of letters, select Shift.
- To delete the previous character, select Back Space.
- To enter a space, select Space.

Parent topic: Using the Control Panel

Setting a Password and Locking the Control Panel

You can set an administrator password to lock the following settings and prevent them from being changed:

- Network settings
- Web Service settings
- Scan settings
- System Administration settings
- Fax settings (WF-C17590/WF-C20590/WF-M20590F)
- Web Config settings
- EpsonNet Config settings

**Note:** For more information on administration settings, see the *Administrator's Guide*.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
4. Select **System Administration**.
   
   You see a screen like this:

   ![Settings Menu](image)

5. Select **Security Settings**.
6. Select **Admin Settings**.
7. Select **Admin Password**.
8. Select **Register**.
You see a screen like this:

9. Use the on-screen keyboard to enter a password and select OK.
10. Enter your password again to confirm.

   **Note:** Keep a copy of your password in a safe place.

11. Select OK.
12. Select the Lock Setting field to turn the setting on.
   
   A prompt appears reminding you that settings are now locked, and the screen returns to General Settings.

When the control panel is locked, you must log in as an administrator and enter the password to access any of the locked settings.

   **Note:** If you forget your password, contact Epson for assistance.

**Parent topic:** Using the Control Panel
Setting User Feature Restrictions (Access Control)

Using Web Config Access Control Settings, you can restrict product features for individual users to prevent misuse of the product. Restricted features require the user to enter an ID and password on the product control panel.

After you set up feature restrictions, you must enable them using the product control panel.

Note: For more information on administration settings, see the Administrator’s Guide.

1. Press the home button, if necessary.
2. Select Settings.
4. Select System Administration.

You see a screen like this:
5. Select **Security Settings**.

6. Select **Access Control**.

   You see a screen like this:

   ![Access Control Screen](image)

7. Select **Access Control** to turn the setting on.

8. If you want to allow users to print from generic drivers or use WSD scanning, select the **Accept Unknown User Jobs** field to turn the setting on.

9. Press the home button to exit.

**Parent topic:** Using the Control Panel

**Related tasks**

- Setting a Password and Locking the Control Panel

**Preventing PC Connection via USB**

You can disable access to your product from a USB-connected computer to protect the security of confidential scanned documents.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
4. Select **Printer Settings**.
   You see a screen like this:

5. Scroll down and select **PC Connection via USB**.
6. Select **Disable**.
7. You need to restart the product to activate this function. Select **Yes** or **No**.

**Parent topic:** Using the Control Panel

### Using Presets

You can save frequently used copy, fax (WF-C17590/WF-C20590/WF-M20590F), and scan settings as presets. This lets you easily reuse them whenever necessary.

**Note:** Presets can be locked by an administrator. If you cannot access or change presets, contact your administrator for assistance.
1. Press the home button, if necessary.
2. Select **Presets**.
   
   You see a screen like this:

   ![Presets screen](image)

3. Select **Add New**.

   **Note:** You can save up to 50 presets.

4. Select the function for which you want to set up a preset, such as **Copy**.
You see a screen like this:

5. Select the settings you want to save and select **Save**.
6. Select the **Name** field.
7. Use the on-screen keyboard to enter a name for the preset and select **OK**.
8. When you finish, select **OK**.

When you copy, fax (WF-C17590/WF-C20590/WF-M20590F), or scan, you can use the preset by selecting **Presets** and selecting your preset name from the list.

**Parent topic:** Using the Control Panel

**Related tasks**

Entering Characters on the LCD Screen

**Checking the Print Counter**

You can check the total number of prints, black-and-white prints, and color prints that have been printed.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **Print Counter**.
You see a screen like this:

![Print Sheet Screen]

4. Select **Print Sheet** if you want to print out the counter results.
5. Press the home button to exit.

**Parent topic:** Using the Control Panel

### Checking the Circuit Breaker

If a short circuit occurs within the product, the power supply shuts off automatically to prevent electric shocks and fires. To prevent a short circuit, you should check the circuit breaker about once a month.

**Note:** Not all products have a circuit breaker. If you do not see a circuit breaker on the back of your product, this section does not apply.

**Caution:** If the circuit breaker switch on your product operates differently than described below, contact Epson support or an authorized Epson service provider. Do not use the product or a short circuit may occur.

1. Turn off the product, but do not unplug the power cable.
2. Flip open the circuit breaker cover on the back of the product below the power cord.
3. Press the test button with a fine-tipped object, such as a ballpoint pen.
The circuit breaker switch automatically moves to the position between **ON** and **OFF**. Make sure that the indicator is yellow.

4. Move the switch down to the **OFF** position.

5. Move the switch up to the **ON** position.
Checking for Software Updates

It's a good idea to check Epson's support website occasionally for free updates to your product software. Visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

- **Windows**: Your printer software automatically checks for updates. You can also manually update the software by selecting **Software Update** here:
  - Accessing the Windows Desktop and right-clicking the icon for your product in the right side of the Windows taskbar, or clicking the up arrow and right-clicking.
  - On the **Maintenance** tab in the printer settings window
You can also update the software by selecting **EPSON Software Updater** in the **EPSON** or Epson **Software** program group, accessible by the **Start** button, or on the **Start** or **Apps** screens, depending on your version of Windows.

- **OS X**: You can manually update the software by opening the **Applications > Epson Software** folder and selecting **EPSON Software Updater**.

- **macOS 10.12.x, 10.13.x, 10.14.x, or 10.15.x**: You can manually update the software by opening the **App Store**, selecting **Updates**, searching for a software update option for Epson Software, and selecting **Update**.

Parent topic: Product Basics

Epson Connect Solutions for Smartphones, Tablets, and More

Use your smartphone, tablet, or computer to print and scan documents, photos, emails, and web pages from your home, office, or even across the globe.

**Note**: If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Print from anywhere with these Epson Connect solutions:

- Epson Email Print
- Epson iPrint Mobile App
- Epson Remote Print
Scan and send a file as an email or upload it to an online service directly from your Epson product with Epson Scan to Cloud or the Epson iPrint Mobile App.

**Setting Up Epson Connect Services**

- Using Epson Email Print
- Using the Epson iPrint Mobile App
- Using Epson Remote Print
- Using Epson Scan to Cloud

**Parent topic:** Product Basics

### Setting Up Epson Connect Services

If you did not activate your product's email address for use with Epson Connect when you set up your product, you can activate it using the product control panel.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
4. Select **Web Service Settings**.
5. Select **Epson Connect Services**
You see a screen like this:

6. Select Register.
7. Follow the instructions on the screen to activate your product's email address.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Using Epson Email Print

With Epson Email Print, you can print from any device that can send email, such as your smartphone, tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a PDF, Microsoft Office document, or photo to an email and send it to your product. Both the email and the attachments will print automatically.

1. Connect your product to your network. See the link below.
2. If you did not already set up Email Print when you installed your product software, see the link below to use your product control panel to activate your unique email address. Or visit epson.com/connect (U.S), epson.ca/connect (Canada), or epsonconnect.com (Caribbean) to learn more about Email Print, create your Epson Connect account, and register your product to the Epson Connect service.
3. Now you are ready to send and print emails to your product's Email Print address.
Note: Go to epsonconnect.com and log into your Epson Connect account to personalize your product's email, adjust print settings, and set up other Epson Connect services.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi or Wired Networking

Using the Epson iPrint Mobile App
Use this free Apple and Android app to print and scan with networked Epson products. Epson iPrint lets you print PDFs, Microsoft Office documents, photos, and web pages over a wireless network. You can scan and save a file on your device, send it as an email, or upload it to an online service such as Box, Dropbox, Evernote, or Google Drive.

1. Connect your product to your wireless network. See the link below.
2. Visit epson.com/connect (U.S), epson.ca/connect (Canada), or epson.com.jm/connect (Caribbean) to learn more about Epson iPrint and check the compatibility of your mobile device.
3. Download Epson iPrint from the Apple App Store or Google Play.
4. Connect your mobile device to the same wireless network as your product.
5. Open Epson iPrint and select your Epson product.

Now you are ready to print or scan with your mobile device and your Epson product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi or Wired Networking

Using Epson Remote Print
With Epson Remote Print software, you can print from your laptop or desktop computer to an Epson Email-enabled product anywhere in the world.

1. Connect your Epson product to your wireless network. See the link below.
2. If you did not already set up an Epson Connect account when you installed your product software, visit epsonconnect.com to create your account and register your product to the Epson Connect service.

Note: Make a note of your product's email address.
3. Visit epsonconnect.com to learn more about Remote Print and how to download the Remote Print Driver software.
4. Download and install the Remote Print software.
5. Enter the email address and optional access key of your Epson product during Remote Print setup.
6. Now you are ready to print remotely. Select the print command in your laptop or desktop computer application and choose the Remote Print option for your Epson product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi or Wired Networking

Using Epson Scan to Cloud

The Epson Scan to Cloud service allows you to scan and send a file as an email or upload it to an online service directly from your Epson product. Register an email address or online services such as Box, DropBox, Evernote, or Google Drive with your Epson Connect account.

1. Connect your Epson product to your network. See the link below.
2. If you did not already set up an Epson Connect account when you installed your product software, visit epsonconnect.com to create your account and register your product to the Epson Connect service.

   Note: Make a note of your product's email address and password.

3. Visit epsonconnect.com to sign into your account with the email address and password you selected.
4. Select your product, select Scan to Cloud, and select Destination List.
5. Click Add, then follow the instructions on the screen to create your destination list.
6. Now you are ready to use Scan to Cloud. Select the setting for scanning to Scan to Cloud on your Epson product control panel.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi or Wired Networking
Using Google Cloud Print

With a Google Account, you can print from your Apple or Android device to your Epson product. You can also print from Chromebooks and the Google Chrome browser without drivers or cables.

1. Connect your Epson product to your wireless network. See the link below.
2. Note your product's IP address by checking your network status. See the link below.
3. Connect your computer or your mobile device to the same wireless network as your Epson product.
4. Enter your product's IP address into the address bar of a web browser.
5. Select the **Google Cloud Print Services** option.

   **Note:** If you don't see the **Google Cloud Print Services** option, turn your product off and back on. If the option still doesn't appear, select the **Firmware Update** option and follow the on-screen instructions to update your product.

6. Click **Register**.
7. Select the checkbox to agree to the Usage Advisory and click **Next**.
8. Click **OK** to launch the sign-in page.

   A separate browser window opens.
9. Enter your Google Account username and password and click **Sign in**, or, if you don't have an account, click **Sign up for a new Google Account** and follow the on-screen instructions.
10. Click **Finish printer registration** to complete setup and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook, computer, Apple or Android device with Internet access. Visit **Epson Support for Google Cloud Print** (U.S) or **Epson Support for Google Cloud Print** (Canada) for more information on using Google Cloud Print, or the **Google Cloud Print** website for a list of supported apps.

---

**Setting Up Google Cloud Print on a Chromebook**

**Parent topic:** Product Basics

**Related topics**

Wi-Fi or Wired Networking

---

**Setting Up Google Cloud Print on a Chromebook**

With a Google Account, you can print from a Chromebook without drivers or cables.

1. Connect your Epson product to your wireless network. See the link below.
2. Turn on your Chromebook and connect it to the same wireless network as your product.

   **Note:** See your Chromebook's documentation for details on connecting to a network.

3. Do one of the following:
   • Click **Add to Cloud Print** in the notification that appears in the corner of your Chromebook screen.

      **Note:** If you do not see a notification, check to see if a number appears in the status area at the lower-right corner of the screen. Click this number to open the notifications menu, then click **Add to Cloud Print**.

   • Open a web browser and enter `chrome://devices` in the address bar. Skip to step 5.
   • If you see a registration confirmation screen instead, click **Register**.

4. Click **Add Device**.

5. Click the **Register** button that appears next to your product.

6. Click **Register** on the confirmation screen. Your product's LCD screen displays a confirmation message.

7. Select **OK** or press the **OK** button on your product to confirm the Google Cloud Print connection and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook, iPhone, or Android phone with Internet access. Visit Epson Support for Google Cloud Print (U.S) or Epson Support for Google Cloud Print (Canada) for more information on using Google Cloud Print, or the Google Cloud Print website for a list of supported apps.

**Parent topic:** Using Google Cloud Print

**Related topics**

Wi-Fi or Wired Networking

### Android Printing Using the Epson Print Enabler

You can wirelessly print your documents, emails, photos, and web pages right from your Android phone or tablet (Android v4.4 or later). With a few taps, your Android device will discover your nearby Epson product and print.

1. Connect your Epson product to your wireless network. See the link below.

2. On your Android device, download the Epson Print Enabler plug-in from Google Play.
3. Go to **Settings** on your Android device, select **Printing**, and enable the Epson plug-in, if necessary.
4. Connect your Android device to the same wireless network as your product.
5. Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu icon and print whatever is on the screen.

    **Note:** If you do not see your product, tap **All Printers** and select your product.

**Parent topic:** Product Basics

**Related topics**

Wi-Fi or Wired Networking

### Using Fire OS Printing

You can wirelessly print from Amazon Fire tablets and phones to your nearby networked Epson product. There is no software to download, no drivers to install, and no cables to connect. With just a few taps in Email, Calendar, Contacts, and WPS Office, you can send whatever is on the screen to an Epson product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Amazon device to the same wireless network as your product.
3. Now you are ready to print. From your Amazon application, tap the print option and select your product to print whatever is on the screen.

    **Note:** If you see a message telling you that a plug-in is required, tap **OK** and tap **Download**. If your Amazon Fire product uses Fire OS 5 and above, your device automatically uses the built-in Mopria Print Service app to print.

**Parent topic:** Product Basics

**Related topics**

Wi-Fi or Wired Networking

### Using Windows 10 Mobile Printing

You can wirelessly print from Windows 10 Mobile tablets and phones to your nearby networked Epson product. There is no software to download, no drivers to install, and no cables to connect. Look for the print option in your Windows 10 application to send whatever is on the screen to an Epson product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Windows 10 Mobile device to the same wireless network as your product.
3. Now you are ready to print. From your Windows 10 application, tap the print option and select your product to print whatever is on the screen.

Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking

Using Epson Print and Scan App with Windows Tablets
You can use this free app to print photos and scan from your Windows (Windows 8 or higher) Surface RT or Pro tablet with networked Epson products. The Epson Print and Scan app allows you to scan and capture images right to your tablet or to Microsoft OneDrive.

Note: The Epson Print and Scan app does not support Windows 10 Mobile printing and does not supply scanning functions for products without scanners.

1. Connect your Epson product to your wireless network. See the link below.
2. Download the Epson Print and Scan app from the Microsoft Windows Store.
3. Connect your Windows tablet to the same wireless network as your product.
4. Open the Epson Print and Scan app and select your Epson product.
   Now you are ready to print photos or scan.

Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking

Printing and Scanning with NFC from Your Android Device
You can easily connect your Android 4.0 or later device to your product using NFC (Near Field Communication). Once connected, you can print and scan using Epson iPrint.

1. Make sure Epson iPrint is installed on your Android device.
2. Make sure Simple AP mode or Wi-Fi Direct is enabled on your product and that you are using the default Wi-Fi Direct password.

Note: NFC printing and scanning will not work if you changed the default Wi-Fi Direct password.
3. Do one of the following:
   • If you are going to print, make sure paper is loaded in the product.
   • If you are going to scan, place your original on the product for scanning.
4. Touch the NFC antenna of your Android device to the NFC tag on your product.

   **Note:** The location of your mobile device's NFC antenna varies. See your mobile device documentation for details.

Epson iPrint opens on your device.

   **Note:** If you do not have Epson iPrint installed, the app store page for the Epson iPrint app opens on your device. Install Epson iPrint and repeat this step.

5. Touch the NFC antenna of your Android device to the product NFC tag on your product again.
   The product and Android device connect.

   **Note:** If the Android device and product disconnect, try to print or scan a document. The Android device and product should reconnect automatically.

6. If you are going to print, open the file you want to print in Epson iPrint.
7. Touch the NFC antenna of your Android device to the NFC tag on your product to start printing or scanning.

**Parent topic:** Product Basics
Related tasks

Using the Epson iPrint Mobile App
Wi-Fi or Wired Networking

See these sections to use your product on a Wi-Fi or wired network.

Note: Your product may differ from the images in this guide, but the instructions are the same unless otherwise noted.

Network Security Recommendations
Wi-Fi Infrastructure Mode Setup
Wi-Fi Direct Mode Setup
Wi-Fi Protected Setup (WPS)
Printing a Network Status Sheet
Printing a Network Connection Report
Configuring Email Server Settings
Changing or Updating Network Connections

Network Security Recommendations

To help deter unauthorized access to your product over a network, you should protect your network environment using appropriate security measures.

Security measures such as these can help deter threats such as loss of user data, use of telephone and fax lines, and other intrusions:

• Enable security on your wireless LAN

  Enable the appropriate security on the wireless LAN you plan to use with your product. Network security such as a network password can deter interception of traffic over the wireless LAN. Your router may already have a default password enabled by your Internet service provider (ISP). See your ISP and router documentation for instructions on how to change the default password and better secure your network.

• Connect your product only to a network protected by a firewall

  Connecting your product directly to the Internet may leave it vulnerable to security threats. Instead, connect it to a router or other network connection protected by a firewall. Your router may already have a firewall set up by your Internet service provider; check with your ISP for confirmation. For best results, set up and use a private IP address for your network connection.

• Change the default administrator password on your product
If your product has an option to set an administrator password, change the default administrator password to deter access by unauthorized users to personal data stored on your product, such as IDs, passwords, and contact lists.

Parent topic: Wi-Fi or Wired Networking

Wi-Fi Infrastructure Mode Setup

You can set up your product to communicate with your computer using a wireless router or access point. The wireless router or access point can be connected to your computer over a wireless or wired network.

1. Epson product
2. Wireless router or access point
3. Computer with a wireless interface
4. Computer
5. Internet
6. Ethernet cable (used only for wired connection to the wireless router or access point)
Selecting Wireless Network Settings from the Control Panel

Parent topic: Wi-Fi or Wired Networking

Selecting Wireless Network Settings from the Control Panel

You can select or change wireless network settings using your product control panel.

To install your product on a wireless network, install the necessary software by downloading it from the Epson website. The installer program guides you through network setup.

**Note:** Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is not responsible for backing up or recovering data and settings during or after the warranty period. We recommend that you make your own backup or print out your fax and network data and settings.

1. Press the home button, if necessary.
2. Select the icon.
   You see a screen like this:

![Screen showing network connection settings]

3. Select **Router**.
4. Select **Start Setup**.
5. Select **Wi-Fi Setup**.
6. Select **Wi-Fi Setup Wizard**.
7. Select the name of your wireless network or select **Enter Manually** to enter the name manually. Use the on-screen keyboard to enter your network name.
8. Select the **Enter Password** field and enter your wireless password using the on-screen keyboard.

   ![On-screen keyboard](image)

   **Note:** The network name and password are case sensitive. Be sure to correctly enter uppercase and lowercase letters, and numeric or special characters.

   • To move the cursor, press the left or right arrows.
   • To change the case of letters, select **Shift**.
   • To delete the previous character, select **Back Space**.
   • To enter a space, select **Space**.
9. Select **OK** when you finish entering your password.
10. Confirm the displayed network settings and select **Start Setup** to save them.
11. If you want to print a network setup report, select **Print Check Report**. (Otherwise, select **OK**.)

12. Press the home button to exit.

You see the icon on the LCD screen and should be able to connect to your product directly from your computer or device, and then print. If you are printing from a computer, make sure you installed the network software from the Epson website.

**Note:** If you don’t see the icon, you may have selected the wrong network name or entered the password incorrectly. Repeat these steps to try again.

**Parent topic:** Wi-Fi Infrastructure Mode Setup

**Related references**
- Status Icon Information

**Related tasks**
- Setting a Password and Locking the Control Panel
- Entering Characters on the LCD Screen

---

**Wi-Fi Direct Mode Setup**

You can set up your product to communicate directly with your computer or another device without requiring a wireless router or access point. In Wi-Fi Direct Mode, the product itself acts as a network access point for up to 4 devices.

1. Epson product
Enabling Wi-Fi Direct Mode

You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or other devices without a wireless router or access point.

1. Press the home button, if necessary.

2. Select the icon.

You see a screen like this:

3. Select **Wi-Fi Direct**.

4. Select **Start Setup**.

5. Select **Start Setup** again.
You see a screen like this:

![Wi-Fi Direct screen on a device](image)

6. Use your computer or wireless device to select the Wi-Fi network name (SSID) displayed on the LCD screen, then enter the password shown.

7. Press the home button to exit.

You see the icon on the LCD screen and should be able to connect to your product directly from your computer or device, and then print. If you are printing from a computer, make sure you installed the network software from the Epson website.

**Note:** If you don’t see the icon on the LCD screen, you may have selected the wrong network name or entered the password incorrectly. Repeat these steps to try again.

**Parent topic:** Wi-Fi Direct Mode Setup

**Related references**
- Status Icon Information

**Related tasks**
- Entering Characters on the LCD Screen
Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your product to the network using Wi-Fi Protected Setup (WPS).

**Note:** To check if your router is WPS-enabled, look for a button labeled WPS on your router or access point. If there is no hardware button, there may be a virtual WPS button in the software for the device. Check your network product documentation for details.

**Using WPS to Connect to a Network**

**Parent topic:** Wi-Fi or Wired Networking

**Using WPS to Connect to a Network**

If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to connect your product to the network.

1. Press the home button, if necessary.
2. Select the icon.

You see a screen like this:
3. Select **Router**.
4. Select **Start Setup**.
5. Select **Wi-Fi Setup**.
6. Select **Push Button Setup (WPS)**.
7. Follow the instructions on the LCD screen to complete WPS setup.
8. Press the 🏡 home button to exit.

You see the 🌐 icon on the LCD screen and should be able to connect to your product directly from your computer or device, and then print. If you are printing from a computer, make sure you installed the network software from the Epson website.

**Note:** If you don’t see the 🌐 icon, repeat these steps to try again.

**Parent topic:** Wi-Fi Protected Setup (WPS)

## Printing a Network Status Sheet

You can print a network status sheet to help you determine the causes of any problems you may have using your product on a network.

Before you begin, make sure paper is loaded in a cassette.

1. Press the 🏡 home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
4. Select **Network Settings**.
You see a screen like this:

![Network Settings Screen](image.png)

5. Select **Network Status**.
6. Select **Print Status Sheet**.
7. Select **Print**.

Examine the settings shown on the network status sheet to diagnose any problems you have.

**Parent topic:** Wi-Fi or Wired Networking

### Printing a Network Connection Report

You can print a network connection report to view solutions to any problems you may have using your product on a network.

1. Press the → home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
4. Select **Network Settings**.
You see a screen like this:

5. Select **Connection Check**.
6. Select **Print Check Report**.
7. Select **Print**.

Examine the error codes and solutions shown on the network connection report.

**Network Connection Report Codes and Messages**

**Parent topic:** Wi-Fi or Wired Networking
Network Connection Report Codes and Messages

Check the error codes and messages on the network connection report to solve problems you may encounter with network connections. The tables here list solutions to problems based on the error codes and messages that may appear on the top of the report.

<table>
<thead>
<tr>
<th>Error code and message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-1</td>
<td>Make sure your router, access point, and/or hub are turned on, and the network cable is securely connected to your device and to your product. If you are trying to set up Wi-Fi, remove the network cable and set up Wi-Fi again. Ethernet and Wi-Fi cannot be connected at the same time.</td>
</tr>
</tbody>
</table>

Note: Error codes and messages listed here may not all apply to your product.
<table>
<thead>
<tr>
<th>Error code and message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-2, E-3, or E-7</td>
<td>Check the following:</td>
</tr>
<tr>
<td></td>
<td>• Make sure your router or access point is turned on, and</td>
</tr>
<tr>
<td></td>
<td>is correctly connected to your computer or network device.</td>
</tr>
<tr>
<td></td>
<td>• Turn off the router or access point, wait about 10 seconds, and turn it on again.</td>
</tr>
<tr>
<td></td>
<td>• Move your product closer to your router or access point,</td>
</tr>
<tr>
<td></td>
<td>and remove any obstacles between them. Also move your product away from devices such as wireless</td>
</tr>
<tr>
<td></td>
<td>phones or microwaves.</td>
</tr>
<tr>
<td></td>
<td>• Confirm that the SSID shown on the network connection report matches the label on your router or</td>
</tr>
<tr>
<td></td>
<td>access point. Also make sure your SSID uses only ASCII characters and symbols, or your product</td>
</tr>
<tr>
<td></td>
<td>cannot display the SSID correctly.</td>
</tr>
<tr>
<td></td>
<td>• If you are trying to connect using the WPS push button method, make sure your router or access</td>
</tr>
<tr>
<td></td>
<td>point supports it.</td>
</tr>
<tr>
<td></td>
<td>• If you are using a network password, check the label on your router or access point to confirm</td>
</tr>
<tr>
<td></td>
<td>that you are using the correct password, or check with your network administrator or router/access</td>
</tr>
<tr>
<td></td>
<td>point documentation.</td>
</tr>
<tr>
<td></td>
<td>• If you are connecting to a smart device that generates an SSID, check the device documentation</td>
</tr>
<tr>
<td></td>
<td>for the SSID and password you should use.</td>
</tr>
<tr>
<td></td>
<td>• If your wireless connection suddenly disconnects, and another smart device was added to the network</td>
</tr>
<tr>
<td></td>
<td>using a WPS push button method or your network was set up using a non-WPS push button method,</td>
</tr>
<tr>
<td></td>
<td>try downloading and installing your product software again.</td>
</tr>
<tr>
<td>Error code and message</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------</td>
</tr>
</tbody>
</table>
| **E-5** Security mode (e.g. WEP, WPA) does not match the current setting of the printer. Confirm security mode. Contact your network administrator for assistance. | If the security on your router or access point is not one of the following types, change the type of security on your router or access point and reset your product's network settings.  
• WEP-64 bit (40 bit)  
• WEP-128 bit (104 bit)  
• WPA PSK (TKIP/AES); also known as WPA Personal  
• WPA2 PSK (TKIP/AES); also known as WPA2 Personal  
• WPA (TKIP/AES)  
• WPA2 (TKIP/AES)  
Also make sure you are connecting to the 2.4GHz band on your network and using the password for that band. |
| **E-6** MAC address of your printer may be filtered. Check whether your router/access point has restrictions such as MAC address filtering. See the documentation of the router/access point or contact your network administrator for assistance. | If your router or access point has MAC address filtering enabled, register your product's MAC address so it is not filtered. Locate the MAC address on the network connection report and check your router or access point documentation for instructions.  
If your router or access point is using shared authentication with WEP security, confirm that you are using the correct authentication key and index.  
If your router or access point limits the number of connected devices, raise the connection limit. See your router or access point documentation for instructions. |
| **E-8** Incorrect IP address is assigned to the printer. Confirm IP address setup of the network device (hub, router, or access point). Contact your network administrator for assistance. | If your product's **Obtain IP Address** setting is set to **Auto**, enable DHCP on your router or access point. If it is set to **Manual**, the IP address may be out of range or on a different network segment; set a valid IP address using your product control panel or the Web Config utility.  
You can also try turning off your product and the router or access point, waiting about 10 seconds, and turning them on again. |
<table>
<thead>
<tr>
<th>Error code and message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-9</td>
<td>Confirm the connection and network setup of the PC or other device. Connection using the EpsonNet Setup is available. Contact your network administrator for assistance. Make sure your computer or network device are turned on. Also make sure that you can access the Internet and other devices on the same network from the devices you are trying to connect to your product. If you still cannot connect to your product, turn off your router or access point, wait about 10 seconds, and turn it on again. Download and install your product software again to reset your network settings.</td>
</tr>
<tr>
<td>E-10</td>
<td>Confirm IP address, subnet mask, and default gateway setup. Connection using the EpsonNet Setup is available. Contact your network administrator for assistance. Make sure other devices on the network are turned on and do the following: • If your product's Obtain IP Address setting is set to Manual, check the IP address, subnet mask, and default gateway addresses on the network connection report to see if they are correct. If not, correct the settings. • If DHCP is enabled, set your product's Obtain IP Address setting to Auto. If you want to use the DHCP-assigned address as a static address, set the Obtain IP Address setting to Manual, enter the product's IP address as listed on the network connection report, and set the subnet mask to 255.255.255.0. If you still cannot connect to your product, turn off your router or access point, wait about 10 seconds, and turn it on again.</td>
</tr>
<tr>
<td>E-11</td>
<td>Setup is incomplete. Confirm default gateway setup. Connection using the EpsonNet Setup is available. Contact your network administrator for assistance. If you set your product's TCP/IP Setup setting to Manual, check that the default gateway address listed on the network connection report is correct. Also turn on the device that is set as the default gateway.</td>
</tr>
<tr>
<td>Error code and message</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>E-12</strong>&lt;br&gt;Confirm the following:&lt;br&gt;-Entered security key/password is correct&lt;br&gt;-Index of the security key/password is set to the first number&lt;br&gt;-IP address, subnet mask, or default gateway setup is correct&lt;br&gt;Contact your network administrator for assistance.</td>
<td>Make sure other devices on the network are turned on and do the following:&lt;br&gt;• Make sure the IP address, subnet mask, and default gateway addresses are correct, if you are entering them manually.&lt;br&gt;• Confirm that the subnet mask and default gateway addresses for other devices are the same.&lt;br&gt;• Make sure the IP address does not conflict with other devices.&lt;br&gt;If you still cannot connect to your product, do the following:&lt;br&gt;• Turn off your router or access point, wait about 10 seconds, and turn it on again.&lt;br&gt;• Download and install your product software again to reset your network settings.&lt;br&gt;• If your router or access point uses WEP security with several registered passwords, make sure that the first registered password is set on your product.</td>
</tr>
<tr>
<td><strong>E-13</strong>&lt;br&gt;Confirm the following:&lt;br&gt;-Entered security key/password is correct&lt;br&gt;-Index of the security key/password is set to the first number&lt;br&gt;-Connection and network setup of the PC or other device is correct&lt;br&gt;Contact your network administrator for assistance.</td>
<td>Make sure your router, access point, and/or hub are turned on. Also make sure the TCP/IP setup on your router, access point, and/or hub is not set manually; this may cause your product's network settings to differ from the manually set up devices.&lt;br&gt;If you still cannot connect to your product, do the following:&lt;br&gt;• Turn off your router or access point, wait about 10 seconds, and turn it on again.&lt;br&gt;• Download and install your product software again to reset your network settings.&lt;br&gt;• If your router or access point uses WEP security with several registered passwords, make sure that the first registered password is set on your product.</td>
</tr>
</tbody>
</table>
Network Environment Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The same SSID may be set on several access points.</td>
<td>Check the settings on your router and other access points to make sure each one uses a different SSID.</td>
</tr>
<tr>
<td>The Wi-Fi environment needs to be improved. Turn the wireless router off and then turn it on. If the connection does not improve, see the documentation for the wireless router.</td>
<td>Move your product closer to your router or access point, and remove any obstacles between them. Then turn off your router or access point, wait about 10 seconds, and turn it back on again. If you still cannot connect to your product, check the documentation that came with your router or access point for solutions.</td>
</tr>
<tr>
<td>*No more devices can be connected. Disconnect one of the connected devices if you want to add another one.</td>
<td>You can connect up to 4 computers or other devices to your product using a Wi-Fi Direct (Simple AP) connection. If you want to add another device, disconnect an existing connected device first.</td>
</tr>
</tbody>
</table>

Parent topic: Printing a Network Connection Report

Configuring Email Server Settings

To use features such as scanning to email or forwarding faxes to email (WF-C17590/WF-C20590/WF-M20590F), you need to configure the email server. You can select settings for the email server using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
4. Select Network Settings.
You see a screen like this:

5. Select **Advanced**.
6. Select **Email Server**.
7. Select **Server Settings**.
You see a screen like this:

8. Select one of the options, then select the settings you want to use. Contact your internet service provider if necessary to confirm the authentication method for the email server.

9. Select Proceed to save your settings.

10. Select Close to exit.

11. Select Connection Check to verify the connection to the email server.

Parent topic: Wi-Fi or Wired Networking

Related tasks
Scanning to Email
Forwarding Received Faxes

Changing or Updating Network Connections

See these sections to change or update how your product connects to a network.

Accessing the Web Config Utility
Changing a USB Connection to a Wi-Fi Connection
Changing a Wi-Fi Connection to a Wired Network Connection
Connecting to a New Wi-Fi Router
Disabling Wi-Fi Features

Parent topic: Wi-Fi or Wired Networking

Accessing the Web Config Utility
You can select your product’s network settings and confirm its operating status using a web browser. You do this by accessing your product’s built-in Web Config utility from a computer or other device that is connected to the same network as your product.

Note: For more information on administration settings, see the Administrator’s Guide.

1. Print a network status sheet.
2. Locate the IP address for your product that is listed on the network status sheet.
3. On a computer or other device connected to the same network as your product, open a web browser.
4. Enter your product’s IP address into the address bar.
   You see the available Web Config utility options.

Parent topic: Changing or Updating Network Connections

Changing a USB Connection to a Wi-Fi Connection
If you have already connected your product to your computer using a USB connection, you can change to a Wi-Fi connection.

1. Disconnect the USB cable from your product.
2. Uninstall your product software.
3. Download and install your product software from the Epson website.

Parent topic: Changing or Updating Network Connections

Changing a Wi-Fi Connection to a Wired Network Connection
If you have already connected your product to your computer wirelessly, you can change to a wired network connection if necessary.

1. Disable your product's Wi-Fi features.
2. Connect one end of an Ethernet network cable to the product's LAN port.
3. Connect the other end to any available LAN port on your router or access point.
4. Uninstall your product software.
5. Download and install your product software from the Epson website.
6. Follow the on-screen instructions to install the software.
7. When you see the Select Your Connection screen, select **Wired network connection**.
8. If you see a Select Setup Option screen, select **Set up printer for the first time**.
9. Continue following the rest of the on-screen instructions.

**Parent topic:** Changing or Updating Network Connections

**Related tasks**

Disabling Wi-Fi Features

**Connecting to a New Wi-Fi Router**

If you change the wireless router you have been using on your network, you need to update your product's Wi-Fi connection to the new router.

**Note:** If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation for instructions.

1. Do one of the following:
   - **Windows**: Uninstall your product software.
   - **Mac**: Go to the next step.
2. Download and install your product software from the Epson website.

**Parent topic:** Changing or Updating Network Connections

**Related tasks**

Uninstalling Product Software - Windows

**Disabling Wi-Fi Features**

You may need to disable your product's Wi-Fi features if you change your network connection type or need to solve a problem with your network connection.
**Note:** Before disabling Wi-Fi features, make a note of your product's SSID (network name) and password, and any network settings selected for the Epson Connect services you may use.

1. Press the \( \text{home} \) button, if necessary.
2. Select the \([\text{Network}]\) icon.
   
   You see a screen like this:

3. Select **Router**.
4. Select **Start Setup**.
5. Select **Wi-Fi Setup**.
6. Select **Others**.
7. Select **Disable Wi-Fi**.
8. Select **Yes** to disable Wi-Fi.

**Parent topic:** Changing or Updating Network Connections
Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Before enabling Epson Universal Print Driver (PCL) or PostScript printing on your product, make sure you have installed the software from the Epson website.

To download the Epson Universal Print Driver or PostScript drivers, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

Note: Your product may differ from the images in this guide, but the instructions are the same unless otherwise noted.

Installing the Epson Universal Print Driver - Windows
Installing the PostScript (PS3) Printer Software - Windows
Installing the PostScript (PS3) Printer Software - Mac
Selecting PDL (Page Description Language) Settings
Selecting Printer Language and Interface Settings
Printing a PCL or PS3 (PostScript) Status Sheet

Installing the Epson Universal Print Driver - Windows

The Epson Universal Print Driver supports multiple printer languages, such as PCL and ESC/P-R, and can be installed on a Windows computer.

Note: Make sure your product is turned on and connected to the same network as your computer before installing the printer software. Depending on your model, not all printer languages may be supported.

1. To download the EPSON Universal Print Driver file, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.
2. After downloading the installer file, double-click the downloaded file to install the software.
3. Follow the on-screen instructions until you see this screen:

![EPSON Printer Utilities Setup](image)

Detect the printer, and automatically configure the port. Is the printer connected via a network?

- [ ] Yes: Network connection
- [ ] No: USB connection

Set Default of Printer Control Language to PCL6

OK  /bot

4. Select **Yes: Network connection** and click **OK**.

**Note:** Select the **Set Default of Printer Control Language to PCL6** checkbox if you want to set the default printer language to PCL6. Leave this option deselected to set the printer language to ESC/P-R. (You can change this setting later as needed.)
After the software finishes searching for products, you see a screen like this:

5. Do one of the following:
   • If you are installing one product, make sure Add EPSON Universal Print Driver is selected and continue with the next step.
   • If you are installing more than one product, select Add found printers and go to step 9.

Note: You can customize and filter your product search results by clicking Display Settings.
6. Open the **Select a port to connect a printer** menu and select an existing printer port, if necessary. Otherwise, skip this option to create a new port automatically.

7. Select the product you want to install from the Found Printers list.

   **Note:** Deselect the **Set as default printer** checkbox if you do not want the product to be set as your default printer.

8. Click **OK**, then skip the remaining steps.

9. If you are installing more than one product, select the products from the Found Printers list and click **Add to Printer Folder**.
The selected products appear in the lower section of the screen.

10. Select the checkbox next to the product you want to make your default printer, if necessary.
11. Click **OK**.

**Parent topic:** Enabling Epson Universal Print Driver (PCL) or PostScript Printing

### Installing the PostScript (PS3) Printer Software - Windows

If you did not install the standard Epson printer software or Epson Universal Print Driver, you need to install the PostScript (PS3) printer software before you can adjust the print settings and print to your network printer.

**Note:** Make sure your product is turned on and connected to the same network as your computer before installing the printer software.

1. To download the **Drivers and Utilities Combo Package - PS3 PostScript** file, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.
2. After downloading the installer file, double-click the downloaded file to install the software.
3. Click **OK**.
4. Click **Accept**.
5. Click **Install**.
6. Click **Next** and follow the on-screen instructions.

**Parent topic:** Enabling Epson Universal Print Driver (PCL) or PostScript Printing

### Installing the PostScript (PS3) Printer Software - Mac

If you did not install the standard Epson printer software, you need to install the PostScript (PS3) printer software before you can adjust the print settings and print to your network printer.

**Note:** Make sure your product is turned on and connected to the same network as your computer before installing the printer software.

1. To download the **Drivers and Utilities Combo Package - PS3 PostScript** file, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.
2. After downloading the installer file, double-click the downloaded file to install the software.
3. Double-click **EPSON**.
4. Click **Continue** on the next two screens.
5. Click **Agree**.
6. Click **Install**.
7. If necessary, enter the administrator password.
8. Click **Start** and follow the on-screen instructions.

**Parent topic:** Enabling Epson Universal Print Driver (PCL) or PostScript Printing

### Selecting PDL (Page Description Language) Settings

You can select settings for PCL and PostScript printing using the control panel on the product.

**Note:** These settings can be locked by an administrator. If you cannot access these settings, contact your administrator for assistance.

1. Press the ⬆️ home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
4. Select **Printer Settings**.
You see a screen like this:

5. Select **PDL Print Configuration**.
You see a screen like this:

![PDL Print Configuration Options](image)

6. Select one of the options shown above, then select the PDL print configuration options you want to use.

7. Press the home button to exit.

**PDL Print Configuration Options**

**Parent topic:** Enabling Epson Universal Print Driver (PCL) or PostScript Printing

### PDL Print Configuration Options

Select the **PDL Print Configuration** options you want to use for PCL or PostScript printing.

<table>
<thead>
<tr>
<th>PDL Print Configuration option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Common Settings</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Paper Size</strong></td>
<td>Various sizes</td>
<td>Sets the default paper size for PCL or PostScript printing</td>
</tr>
<tr>
<td>PDL Print Configuration option</td>
<td>Available settings</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Various paper types</td>
<td>Sets the default paper type for PCL or PostScript printing</td>
</tr>
<tr>
<td>Orientation</td>
<td><strong>Portrait</strong></td>
<td>Sets the default orientation for PCL or PostScript printing</td>
</tr>
<tr>
<td></td>
<td><strong>Landscape</strong></td>
<td></td>
</tr>
<tr>
<td>Quality</td>
<td><strong>Draft</strong></td>
<td>Sets the quality for PCL or PostScript printing</td>
</tr>
<tr>
<td></td>
<td><strong>Standard</strong></td>
<td></td>
</tr>
<tr>
<td>Ink Save Mode</td>
<td>Off</td>
<td>Saves ink by reducing print density</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Print Order</td>
<td><strong>Last Page on Top</strong></td>
<td>Starts printing from the first page of a file</td>
</tr>
<tr>
<td></td>
<td><strong>First Page on Top</strong></td>
<td>Starts printing from the last page of a file</td>
</tr>
<tr>
<td>Number of Copies</td>
<td>1 to 999</td>
<td>Selects the number of copies to print</td>
</tr>
<tr>
<td>Binding Margin</td>
<td><strong>Left Edge</strong></td>
<td>Specifies the binding edge for double-sided documents</td>
</tr>
<tr>
<td></td>
<td><strong>Top Edge</strong></td>
<td></td>
</tr>
<tr>
<td>Auto Paper Ejection</td>
<td>Off</td>
<td>Ejects paper automatically when printing is stopped during a print job</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>2-Sided Printing</td>
<td>Off</td>
<td>Selects duplex printing</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>PCL Menu</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Font Source</td>
<td><strong>Resident</strong></td>
<td>Uses a font preinstalled on the printer</td>
</tr>
<tr>
<td></td>
<td><strong>Download</strong></td>
<td>Uses a font you have downloaded</td>
</tr>
<tr>
<td>Font Number</td>
<td>1 to 111</td>
<td>Selects the default font number for the default font source</td>
</tr>
<tr>
<td>Pitch</td>
<td>0.44 to 99.99 cpi</td>
<td>Selects the default font pitch if the font is scalable and fixed-pitch (availability depends on font source and number settings)</td>
</tr>
<tr>
<td>PDL Print Configuration option</td>
<td>Available settings</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Height</td>
<td>4.00 to 999.75 pt</td>
<td>Selects the default font height if the font is scalable and proportional (availability depends on font source and number settings)</td>
</tr>
<tr>
<td>Symbol Set</td>
<td>Various</td>
<td>Selects the default symbol set. If the selected font is not available for the selected symbol set, the font source and number are replaced with <strong>IBM-US</strong> (the default setting).</td>
</tr>
<tr>
<td>Form</td>
<td>5 to 128 lines</td>
<td>Sets the number of lines for the selected paper size and orientation. Changes the line spacing (VMI) stored in the printer. Later changes in page size or orientation cause changes in the <strong>Form</strong> value based on the stored VMI.</td>
</tr>
<tr>
<td>CR Function</td>
<td>CR</td>
<td>Selects the line feed command when printing with a driver from a specific operating system</td>
</tr>
<tr>
<td></td>
<td>CR+LF</td>
<td></td>
</tr>
<tr>
<td>LF Function</td>
<td>LF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CR+LF</td>
<td></td>
</tr>
<tr>
<td>Paper Source Assign</td>
<td>4</td>
<td>Makes the paper source select command compatible with HP LaserJet 4</td>
</tr>
<tr>
<td></td>
<td>4K</td>
<td>Makes the paper source select command compatible with HP LaserJet 4000, 5000, and 8000</td>
</tr>
<tr>
<td></td>
<td>5S</td>
<td>Makes the paper source select command compatible with HP LaserJet 5S</td>
</tr>
<tr>
<td>PS3 Menu</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error Sheet</td>
<td>Off</td>
<td>Prints a sheet showing the status when errors occur during PostScript or PDF printing</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Coloration</td>
<td>Color</td>
<td>Selects the color mode for PostScript printing</td>
</tr>
<tr>
<td></td>
<td>Mono</td>
<td></td>
</tr>
</tbody>
</table>
### PDL Print Configuration

<table>
<thead>
<tr>
<th>Option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary</td>
<td>Off</td>
<td>Enable when printing files that contain binary images (available when the product is connected to the network). Allows you to print binary images even if the driver is set to ASCII.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>PDF Page Size</td>
<td>Various sizes</td>
<td>Selects the paper size when printing a PDF file. If Auto is selected, the paper size is determined based on the size of the first page.</td>
</tr>
</tbody>
</table>

Parent topic: Selecting PDL (Page Description Language) Settings

### Selecting Printer Language and Interface Settings

You can select printer language and interface settings using the control panel on the product.

**Note:** These settings can be locked by an administrator. If you cannot access these settings, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
4. Select Printer Settings.
You see a screen like this:

5. Select **Printing Language**.
6. Select the printing language and interface options for your connection type.
7. Press the home button to exit.

**Printing Language and Interface Options**

**Parent topic:** Enabling Epson Universal Print Driver (PCL) or PostScript Printing

**Printing Language and Interface Options**

Select the printing language and interface options you want to use.
<table>
<thead>
<tr>
<th>Option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing Language</td>
<td>Auto</td>
<td>Select the language for the USB or network interface</td>
</tr>
<tr>
<td></td>
<td>PCL, PS3, PDF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ESC/Page</td>
<td></td>
</tr>
<tr>
<td>PC Connection via USB</td>
<td>Enable</td>
<td>Select whether to allow USB communication with the product</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td></td>
</tr>
<tr>
<td>USB I/F Timeout Setting</td>
<td>0.5 to 300 seconds</td>
<td>Specify the length of time before ending USB communication from a computer using the PCL or PostScript driver. This setting is necessary to avoid endless USB communication.</td>
</tr>
</tbody>
</table>

Parent topic: Selecting Printer Language and Interface Settings

Printing a PCL or PS3 (PostScript) Status Sheet

You can print a PCL or PS3 (PostScript) status sheet to confirm the current font information.

1. Press the 🏡 home button, if necessary.
2. Select Settings.
You see a screen like this:

![Screen](image)

3. Select **Printer Status/Print**.
4. Select **Print Status Sheet**.
5. Select **PS3 Font List** or **PCL Font List**.
6. Select **Print** to print the status sheet.

**Parent topic:** Enabling Epson Universal Print Driver (PCL) or PostScript Printing
Loading Paper

Before you print, load paper for the type of printing you will do.

Note: Load only plain paper when printing with the PCL or PostScript (PS3) printer software.

Note: Your product may differ from the images in this guide, but the instructions are the same unless otherwise noted.

Loading Paper in the Cassettes and MP Tray
Using the Optional Paper Cassette Lock
Paper Loading Capacity
Compatible Epson Papers
Paper or Media Type Settings - Printing Software
Selecting the Paper Settings for Each Source - Control Panel
Selecting Default Paper Settings - Administrator

Loading Paper in the Cassettes and MP Tray

You can load paper up to this size in the paper cassettes and MP tray: 13 × 19 inches (330 × 483 mm).

You can view instructions on how to load paper in the cassettes or MP tray on the control panel.

1. Select the icon on the LCD screen.
2. Select **Load Paper** under the How To options.
You see this screen:

3. Select one of the options.
You see this screen:

4. Select **How To**.
You see this screen:

5. Select the ▶ icon to scroll through the paper loading instructions.
6. If necessary, select the ✯ icon and select the size and type of paper you loaded on the LCD screen.

   **Note:** If the Paper Size Auto Detect setting is enabled, your product will automatically detect the size of the paper you loaded.

Always follow these paper loading guidelines:

- Load only the recommended number of sheets.
- Load paper short edge first, no matter which way your document faces.
- Load the printable side facedown.
- Load letterhead or pre-printed paper top edge first.
- Do not load paper above the arrow mark inside the edge guides.
- Check the paper package for any additional loading instructions.
Caution: Do not use the following papers. Using these papers may cause paper jams, smears on the printout, or damage to the printer.

- Papers that are wavy or damp
- Papers that have not dried after printing on one side
- Papers that are wadded or curled
- Papers that are torn, cut, or folded
- Papers that are too thick or thin
- Preprinted papers printed by other inkjet printers, thermal transfer printers, page printers, or copiers
- Papers that are perforated
- Papers that have stickers
- Papers held together with tape, staples, or paper clips
- Envelopes with adhesive surfaces or windows
- Pre-punched papers

Parent topic: Loading Paper

Related references
Paper Loading Capacity
Paper Specifications

Using the Optional Paper Cassette Lock

You can use the optional paper cassette lock to keep a paper cassette locked. Make sure you keep the key in a safe place.

You can purchase genuine Epson accessories at epson.com (U.S. sales), epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase accessories from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.
1. Insert the paper cassette lock into the cassette handle.

![Diagram of paper cassette lock insertion]

2. Press the button on the paper cassette lock to pop out the key.

![Diagram of key popping out]

**Note:** To unlock the paper cassette, insert the key all the way into the lock and pull out the lock.

**Parent topic:** Loading Paper

**Related references**
- Optional Accessories and Replacement Parts

**Paper Loading Capacity**

**Standard paper**
<table>
<thead>
<tr>
<th>Paper type</th>
<th>Loading capacity</th>
<th>MP tray</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plain paper</td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm])</td>
<td>13 × 19 inches</td>
</tr>
<tr>
<td></td>
<td>11 × 17 inches [279 × 432 mm]</td>
<td>(330 × 483 mm)</td>
</tr>
<tr>
<td>Letterhead paper</td>
<td>B4 (13.9 × 9.84 inches [353 × 250 mm])</td>
<td>12 × 18 inches</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 × 14 inches [216 × 356 mm])</td>
<td>(305 × 457 mm)</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>B6 (5 × 7.2 inches [128 × 182 mm])</td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 × 11.7 inches [210 × 297 mm])</td>
<td>A6 (4.1 × 5.8 inches [105 × 148 mm])</td>
</tr>
<tr>
<td></td>
<td>B5 (7.2 × 10.1 inches [182 × 257 mm])</td>
<td>User-defined</td>
</tr>
<tr>
<td></td>
<td>Executive (7.25 × 10.5 inches [184 × 267 mm])</td>
<td>Up to the arrow mark</td>
</tr>
<tr>
<td></td>
<td>A5 (5.8 × 8.2 inches [148 × 210 mm])</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Half Letter (5.5 × 8.5 inches [140 × 216 mm])</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User-defined</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Up to the arrow mark</td>
<td></td>
</tr>
<tr>
<td>Recycled paper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Colored paper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pre-printed paper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thick paper (25 to 42 lb [91 to 160 g/m²])</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
</tr>
<tr>
<td></td>
<td>450 sheets</td>
<td>80 sheets</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper type</td>
<td>Loading capacity</td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td>Paper cassettes</td>
<td>MP tray</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>—</td>
<td>13 × 19 inches</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(330 × 483 mm)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11 × 17 inches</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(279 × 432 mm)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Legal (8.5 × 14 inches [216 × 356 mm])</td>
</tr>
<tr>
<td></td>
<td></td>
<td>20 sheets</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>—</td>
<td>13 × 19 inches</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(330 × 483 mm)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm])</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11 × 14 inches</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(279 × 356 mm)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8 × 10 inches</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(203 × 254 mm)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>20 sheets</td>
</tr>
<tr>
<td>Envelopes</td>
<td>—</td>
<td>10 envelopes</td>
</tr>
</tbody>
</table>

**Thick paper**
Paper weight | MP tray
---|---
Thick paper (43 to 90 lb [161 to 350 g/m²]) | 13 × 19 inches (330 × 483 mm)
| 12 × 18 inches (305 × 457 mm)
| A3 (11.7 × 16.5 inches [297 × 420 mm])
| 11 × 17 inches (279 × 432 mm)
| B4 (13.9 × 9.84 inches [353 × 250 mm])
| Legal (8.5 × 14 inches [216 × 356 mm])
| Letter (8.5 × 11 inches [216 × 279 mm])
| A4 (8.3 × 11.7 inches [210 × 297 mm])
| B5 (7.2 × 10.1 inches [182 × 257 mm])
| Executive (7.25 × 10.5 inches [184 × 267 mm])
| A5 (5.8 × 8.2 inches [148 × 210 mm])
| Half Letter (5.5 × 8.5 inches [140 × 216 mm])
| B6 (5 × 7.2 inches [128 × 182 mm])
| A6 (4.1 × 5.8 inches [105 × 148 mm])
| User-defined
| Up to the arrow mark (or 30 sheets)

Parent topic: **Loading Paper**

### Compatible Epson Papers

You can purchase genuine Epson ink and paper at [epson.com](http://epson.com) (U.S. sales), [epson.ca](http://epson.ca) (Canadian sales), or [epson.com.jm](http://epson.com.jm) (Caribbean sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Bright White Paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041586</td>
<td>500</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-----------------------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041062</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 × 14 inches [216 × 356 mm])</td>
<td>S041067</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>11 × 17 inches (279 × 432 mm)</td>
<td>S041070</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S041069-L</td>
<td>100</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041257</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042180</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>11 × 14 inches (279 × 356 mm)</td>
<td>S041468</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm])</td>
<td>S041260</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S041263</td>
<td>50</td>
</tr>
</tbody>
</table>

Parent topic: Loading Paper

Paper or Media Type Settings - Printing Software

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this paper Type or Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper 16 to 20 lb (60 to 75 g/m²)</td>
<td>Plain Paper 1</td>
</tr>
<tr>
<td>Plain paper 21 to 24 lb (76 to 90 g/m²)</td>
<td>Plain Paper 2</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td>High quality plain paper</td>
</tr>
<tr>
<td>Letterhead paper</td>
<td>Letterhead</td>
</tr>
<tr>
<td>Recycled paper</td>
<td>Recycled</td>
</tr>
<tr>
<td>Colored paper</td>
<td>Color</td>
</tr>
<tr>
<td>Pre-printed paper</td>
<td>Preprinted</td>
</tr>
</tbody>
</table>
For this paper | Select this paper Type or Media Type setting
--- | ---
Envelopes | Envelope
Epson Presentation Paper Matte | Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte | Premium Presentation Paper Matte
Thick paper between 25 to 28 lb (91 to 105 g/m²) | Thick Paper 1
Thick paper between 29 to 36 lb (106 to 135 g/m²) | Thick Paper 2
Thick paper between 37 to 42 lb (136 to 160 g/m²) | Thick Paper 3
Thick paper between 43 to 66 lb (161 to 250 g/m²) | Thick Paper 4
Thick paper between 67 to 90 lb (251 to 350 g/m²) | Extra Thick Paper

**Note:** The settings listed here are available only when printing from your computer; they do not apply to your product’s control panel settings.

**Parent topic:** Loading Paper

**Selecting the Paper Settings for Each Source - Control Panel**

You can change the default paper size and paper type for each source using the control panel on the product.

1. Select the 📜 icon.
You see a screen like this:

2. Select the paper source you want to select settings for.
You see a screen like this:

3. Select **Paper Size**.
4. Select the paper size you loaded.
5. Select **Paper Type**.
6. Select the paper type for the paper you loaded.
7. To automatically detect the size of paper loaded in the paper source, select the **Paper Size Auto Detect** field to turn this setting on.
8. Select another paper source to change or press the home button to exit.

**Paper Type Settings - Control Panel**

Select a **Paper Type** setting that matches the paper you loaded.
<table>
<thead>
<tr>
<th>Paper type loaded</th>
<th>Paper Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper 16 to 20 lb (60 to 75 g/m²)</td>
<td>Plain Paper 1</td>
</tr>
<tr>
<td>Plain paper 21 to 24 lb (76 to 90 g/m²)</td>
<td>Plain Paper 2</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td>High Quality Plain Paper</td>
</tr>
<tr>
<td>Letterhead paper</td>
<td>Letterhead</td>
</tr>
<tr>
<td>Recycled paper</td>
<td>Recycled</td>
</tr>
<tr>
<td>Colored paper</td>
<td>Color</td>
</tr>
<tr>
<td>Pre-printed paper</td>
<td>Preprinted</td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Prem. Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Thick paper between 25 to 28 lb (91 to 105 g/m²)</td>
<td>Thick Paper 1</td>
</tr>
<tr>
<td>Thick paper between 29 to 36 lb (106 to 135 g/m²)</td>
<td>Thick Paper 2</td>
</tr>
<tr>
<td>Thick paper between 37 to 42 lb (136 to 160 g/m²)</td>
<td>Thick Paper 3</td>
</tr>
<tr>
<td>Thick paper between 43 to 66 lb (161 to 250 g/m²)</td>
<td>Thick Paper 4</td>
</tr>
<tr>
<td>Thick paper between 67 to 90 lb (251 to 350 g/m²)</td>
<td>Extra Thick Paper</td>
</tr>
</tbody>
</table>

**Parent topic:** Selecting the Paper Settings for Each Source - Control Panel

**Selecting Default Paper Settings - Administrator**

As an administrator, you can adjust default paper settings that apply to all print jobs sent to the product.

**Note:** These settings can be locked by an administrator. If you cannot access these settings, contact your administrator for assistance.

Selecting the Default Printer Settings  
Selecting the Universal Print Settings

**Parent topic:** Loading Paper
Selecting the Default Printer Settings

You can change default printer settings using the control panel on the product.

**Note**: These settings can be locked by an administrator. If you cannot access these settings, contact your administrator for assistance.

1. Press the \( \uparrow \) home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
4. Select **Printer Settings**.
   
   You see a screen like this:

   ![Settings Screen](image)

5. Select **Paper Source Settings**.
6. Select the Paper Source Settings options you want to use, then return to the previous screen.
7. Select one of these options for the **Auto Error Solver** setting:
   - Select **On** to display a warning and print single-sided when a 2-sided printing error occurs, or to print only what the printer could process when a full memory error occurs.
   - Select **Off** to display an error message and stop printing if an error occurs.

8. Press the home button to exit.

### Paper Source Settings Options

**Paper Source Settings Options**

Select the paper source options you want to use for your print jobs.

<table>
<thead>
<tr>
<th>Paper Source Settings option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Setting</td>
<td>Various</td>
<td>Select the paper size and type for each paper source.</td>
</tr>
<tr>
<td>MP Tray Priority</td>
<td>On</td>
<td>Select <strong>On</strong> to give printing priority to paper loaded in the MP tray.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>A4/Letter Auto Switching</td>
<td>On</td>
<td>Select <strong>On</strong> to switch the selected paper size to match the loaded paper (Letter or A4) if the wrong size is selected.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Auto Select Settings</td>
<td>Copy</td>
<td>Select <strong>On</strong> for any of these settings to automatically print on paper from any source containing paper that matches your paper settings.</td>
</tr>
<tr>
<td></td>
<td>Fax (WF-C17590/WF-C20590/WF-M20590F)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Other</td>
<td></td>
</tr>
<tr>
<td>Error Notice</td>
<td>Paper Size Notice</td>
<td>Select <strong>On</strong> for either of these settings to display an error message when the selected paper type or size does not match the loaded paper.</td>
</tr>
<tr>
<td></td>
<td>Paper Type Notice</td>
<td></td>
</tr>
<tr>
<td>Paper Setup Auto Display</td>
<td>On</td>
<td>Select <strong>On</strong> to automatically display a menu that lets you select the paper size and type when you load paper in the product.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>User-Defined Paper Size List</td>
<td>20 settings</td>
<td>Enter a user-defined paper size setting.</td>
</tr>
</tbody>
</table>
Selecting the Universal Print Settings

You can change the default universal print settings using the control panel on the product.

**Note:** These settings can be locked by an administrator. If you cannot access these settings, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
4. Select **Printer Settings**.

You see this screen:

5. Select **Universal Print Settings**.
6. Adjust the settings as necessary.
7. Press the home button to exit.
Universal Print Settings Options

Parent topic: Selecting Default Paper Settings - Administrator

Universal Print Settings Options

Select the universal print setting options you want to use for your print jobs.

<table>
<thead>
<tr>
<th>Universal Print Settings option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Offset</td>
<td>—</td>
<td>Adjust the top or left margin.</td>
</tr>
<tr>
<td>Left Offset</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Top Offset in Back</td>
<td>—</td>
<td>Adjust the top or left margin of the back page when printing double-sided.</td>
</tr>
<tr>
<td>Left Offset in Back</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Skip Blank Page</td>
<td>On</td>
<td>Select On to skip printing of blank pages automatically.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Rotate Sort</td>
<td>On</td>
<td>Select On to rotate each copy when printing multiple copies.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Insert Sheets per User</td>
<td>On</td>
<td>Select On to insert a blank sheet between copies or print jobs sent to the printer from the printer driver. Select the paper source you want the sheets to come from.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>

Parent topic: Selecting the Universal Print Settings
Placing Originals on the Product

Follow the instructions here to place your original documents or photos on the product.

Caution: Do not place anything on top of your product or use its cover as a writing surface to avoid damaging it.

Note: Your product may differ from the images in this guide, but the instructions are the same unless otherwise noted.

Placing Originals on the Scanner Glass
Placing Originals in the Automatic Document Feeder

Placing Originals on the Scanner Glass

You can place originals up to this size on the scanner glass: A3 (11.7 × 16.5 inches [297 × 420 mm]).

Note: When originals are placed in the ADF and on the scanner glass, priority is given to the originals in the ADF.
1. Open the document cover.
2. Place your original facedown on the scanner glass with the top facing into the corner. Slide the original to the edges of the indicated corner.

![Diagram of placing original on scanner glass]

**Note:** You can place multiple originals on the scanner glass. Just make sure they are at least 0.8 inch (20 mm) away from each other.

**Note:** The edges of your original may be cropped by 0.06 inch (1.5 mm) from the edge of the scanner glass.

3. Close the document cover gently to keep your original in place.

**Caution:** Do not push down on the document cover or scanner glass or you may damage the product.

**Parent topic:** Placing Originals on the Product

**Related topics**

- Copying
- Scanning
Faxing

Placing Originals in the Automatic Document Feeder

You can place single- or multi-page original documents in the Automatic Document Feeder (ADF). You can also use the ADF to scan both sides of a 2-sided document. Make sure the originals meet the Automatic Document Feeder specifications before loading them.

Caution: Make sure your originals are not creased or folded, and do not contain holes, staples, tape, or other materials that could obstruct the feeder.

Caution: Do not place photographs or valuable artwork in the ADF. Place fragile or valuable originals on the scanner glass to avoid wrinkling or damaging them.

Note: When originals are placed in the ADF and on the scanner glass, priority is given to the originals in the ADF.

1. Slide the ADF edge guides outward.
2. Fan your stack of originals and tap them gently on a flat surface to even the edges.

3. Insert the originals into the ADF faceup and short edge first. The ADF tray rises.

The ADF icon on the Copy, Scan, and Fax (WF-C17590/WF-C20590/WF-M20590F) screens lights up.

**Note:** The ADF should automatically detect the size of your original. If the document size isn't automatically detected, you need to manually select it.
4. Slide the ADF edge guides against the originals, but not too tightly.

Parent topic: Placing Originals on the Product
Related topics
Copying
Scanning
Faxing
Copying

See the information here to copy documents or photos using your product.

**Note:** Copies may not be exactly the same size as your originals.

**Note:** Your product may differ from the images in this guide, but the instructions are the same unless otherwise noted.

Copying Documents or Photos

Copying Options

**Copying Documents or Photos**

You can copy documents or photos onto various sizes and types of paper, including Epson special papers.

1. Place your original document or photo on the scanner glass, or place multi-page documents in the ADF.
2. Load the paper you want to print on.
3. Press the home button, if necessary.
4. Select **Copy**.
You see a screen like this:

![Copy screen](image)

5. To print more than one copy, press a number key on the product's control panel, or select **Copies** and use the on-screen keyboard to enter the number of copies.

6. Change any of the displayed settings as necessary.

7. Select **Advanced** to view and change additional copy settings, if necessary.

8. Select **Preview** to preview your copy on the LCD screen.

9. Select **Presets** to save your copy settings.

   **Note:** Presets can be locked by an administrator. If you can't access or change this setting, contact your administrator for assistance.

10. When you are ready to copy, press the **Copy** icon.

   **Note:** To cancel printing, select **Cancel** on the LCD screen, then select **Cancel** again to confirm.

Parent topic: **Copying**
Related references
Copying Options
Related tasks
Using Presets
Related topics
Placing Originals on the Product
Loading Paper

Copying Options
Select the copying options you want to use for your copies.

Note: Not all options or settings may be available, depending on other copying settings.

Basic Settings

<table>
<thead>
<tr>
<th>Copying option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>—</td>
<td>Copies the document in the detected color of the original.</td>
</tr>
<tr>
<td>B&amp;W</td>
<td>—</td>
<td>Copies the document in black and white.</td>
</tr>
<tr>
<td>Color</td>
<td>—</td>
<td>Copies the document in color.</td>
</tr>
<tr>
<td>Density</td>
<td>Varying levels</td>
<td>Adjusts the lightness or darkness of copies.</td>
</tr>
<tr>
<td>Paper Setting</td>
<td>Various sources</td>
<td>Select the paper source that you want to use. If you select <strong>Auto</strong>, paper is fed automatically depending on the paper settings you selected for the paper sources.</td>
</tr>
<tr>
<td>Reduce/Enlarge</td>
<td>Auto</td>
<td>Automatically sizes the image to fit the paper size you selected.</td>
</tr>
<tr>
<td>Reduce to Fit Paper</td>
<td></td>
<td>Automatically decreases the size of the image by the percentage you select.</td>
</tr>
<tr>
<td>100%</td>
<td></td>
<td>Copies the original at its full size.</td>
</tr>
<tr>
<td>Minimum</td>
<td></td>
<td>Copies the original at the minimum size (25%).</td>
</tr>
<tr>
<td>Maximum</td>
<td></td>
<td>Copies the original at the maximum size (400%).</td>
</tr>
<tr>
<td>50%-&gt;200%</td>
<td>and other conversions</td>
<td>Automatically converts from one size to another.</td>
</tr>
<tr>
<td>Copying option</td>
<td>Available settings</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Original Size</strong></td>
<td>Various sizes</td>
<td>Select the document size of your original.</td>
</tr>
<tr>
<td><strong>2-Sided</strong></td>
<td>1&gt;1-Sided</td>
<td>Select to make 2-sided copies. When you select 1&gt;2-Sided or 2&gt;1-Sided, you can select the orientation and binding edge for your originals or copies.</td>
</tr>
<tr>
<td></td>
<td>2&gt;2-Sided</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1&gt;2-Sided</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2&gt;1-Sided</td>
<td></td>
</tr>
<tr>
<td><strong>Multi-Page</strong></td>
<td>Single Page</td>
<td>Copies each page of the original onto an individual sheet.</td>
</tr>
<tr>
<td></td>
<td>2-up</td>
<td>Copies multiple page documents onto one sheet. Scroll down and select the document orientation and layout order settings as necessary.</td>
</tr>
<tr>
<td></td>
<td>4-up</td>
<td></td>
</tr>
<tr>
<td><strong>Finishing</strong></td>
<td>Collate (Page Order)</td>
<td>Select to print multiple copies of a multi-page document in ordered sets.</td>
</tr>
<tr>
<td></td>
<td>Group (Same Pages)</td>
<td>Select to print multiple copies of a multi-page document in unordered groups.</td>
</tr>
<tr>
<td></td>
<td>Eject Paper</td>
<td>Select Rotate Sort to print alternate paper orientations and paper sources (make sure the Paper Setting is set to Auto for this option). Select Shift Sort* to eject offset printouts for each set of copies.</td>
</tr>
<tr>
<td></td>
<td>Staple*</td>
<td>Select the staple location.</td>
</tr>
</tbody>
</table>

* Displayed when the optional finisher unit is installed.

Advanced settings
<table>
<thead>
<tr>
<th>Copying option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Type</td>
<td>Text&lt;br&gt;Text &amp; Image&lt;br&gt;Photo&lt;br&gt;Text &amp; Image(Best)</td>
<td>Specifies the document type of your originals and adjusts the quality of your copies.</td>
</tr>
<tr>
<td>Mixed Size Originals</td>
<td>Off&lt;br&gt;On</td>
<td>Select On to copy originals of varying sizes in their original sizes.</td>
</tr>
<tr>
<td>Orientation (Original)</td>
<td>Up Direction&lt;br&gt;Left Direction</td>
<td>Specifies the orientation of your originals.</td>
</tr>
<tr>
<td>Book&gt;2Pages</td>
<td>Off&lt;br&gt;On</td>
<td>Select On to copy two pages of a book onto separate sheets of paper. You can also choose the Scan Order.</td>
</tr>
<tr>
<td>Continuous Scanning</td>
<td>Off&lt;br&gt;On</td>
<td>Select On to scan a large quantity of originals placed in the ADF as one job.</td>
</tr>
<tr>
<td>Image Quality</td>
<td>Various settings</td>
<td>Select advanced quality settings such as Saturation and Sharpness.</td>
</tr>
<tr>
<td>Binding Margin</td>
<td>Off&lt;br&gt;On</td>
<td>Select On to adjust the margin and orientation of the pages when copying a book. You can also select the Binding Position and Orientation.</td>
</tr>
<tr>
<td>Reduce to Fit Paper</td>
<td>Off&lt;br&gt;On</td>
<td>Select On to automatically decrease the image by the percentage you select.</td>
</tr>
<tr>
<td>Remove Shadow</td>
<td>Off&lt;br&gt;On</td>
<td>Select On to erase the shadows that appear in the center of a document when copying a book or that appear around a document when copying thick paper.</td>
</tr>
<tr>
<td>Remove Punch Holes</td>
<td>Off&lt;br&gt;On</td>
<td>Select On to erase the binding holes on a document. You can also select the Erasing Position and Orientation.</td>
</tr>
<tr>
<td>ID Card Copy</td>
<td>Off&lt;br&gt;On</td>
<td>Select On to copy both sides of an ID card onto one side of a sheet of paper. You can also select the Orientation.</td>
</tr>
<tr>
<td>Output Tray</td>
<td>Various settings</td>
<td>Select the output tray for your copies.</td>
</tr>
<tr>
<td>Copying option</td>
<td>Available settings</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Page Numbering</td>
<td>Page Numbering</td>
<td>Select On to print page numbers on your copies.</td>
</tr>
<tr>
<td>Format</td>
<td></td>
<td>Selects the page numbering format.</td>
</tr>
<tr>
<td>Stamp Position</td>
<td></td>
<td>Selects where the page number is placed on each copy.</td>
</tr>
<tr>
<td>Change Numbering</td>
<td></td>
<td>Specifies on which page numbering begins.</td>
</tr>
<tr>
<td>Size</td>
<td></td>
<td>Adjusts the font size of the page numbers.</td>
</tr>
<tr>
<td>Background</td>
<td></td>
<td>Adjusts the background color of the page number.</td>
</tr>
</tbody>
</table>

Parent topic: Copying
Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software from the Epson website.

**Note:** If you have an Internet connection, it is a good idea to check for updates to your product software on Epson’s support website. If you see a Software Update screen, select **Enable automatic checking** and click **OK**. The update scans your system to see if you have the latest product software. Follow the on-screen instructions.

**Note:** Your product may differ from the images in this guide, but the instructions are the same unless otherwise noted.

- Printing with the Standard Epson Printer Software - Windows
- Printing with the Epson Standard Printer Software - Mac
- Printing with the Epson Universal Print Driver - Windows
- Printing with the PostScript (PS3) Printer Software - Windows
- Printing with the PostScript (PS3) Printer Software - Mac
- Cancelling Printing Using the Product Control Panel

**Printing with the Standard Epson Printer Software - Windows**

You can print with the standard Epson printer software using any Windows printing program, as described in these sections.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

- Synchronizing Printer Settings for Optional Units - Windows
- Selecting Basic Print Settings - Windows
- Selecting Double-sided Printing Settings - Windows
- Selecting Finishing Options - Windows
- Selecting Additional Print Options - Windows
- Selecting a Printing Preset - Windows
- Selecting Extended Settings - Windows
Synchronizing Printer Settings for Optional Units - Windows

You must sync the printer driver before you can use any optional equipment installed on the product.

1. Do one of the following:
   - **Windows 10**: Click 📑 and select 📑 (Settings) > Devices > Printers & scanners. Select your product and select Manage > Printer properties.
   - **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click your product and select Printer properties.
   - **Windows 7**: Click 📑 and select Devices and Printers. Right-click your product and select Printer properties.
   - **Windows Vista**: Click 📑 and select Control Panel. Click Printer under Hardware and Sound, then right-click your product and select Properties.
   - **Windows XP**: Click Start and select Printers and Faxes. Right-click your product and select Properties.

2. Click the Optional Settings tab.
You see this window:

3. Make sure **Acquire from Printer** is selected and click **Get**.
   The product’s settings and other information appears in the Current Printer Information area.

4. If you want to select specific options to sync, select **Manual Settings** and click **Settings**. Select the options you want to sync and click **OK**.

5. Click **OK**.

**Parent topic:** Printing with the Standard Epson Printer Software - Windows

**Selecting Basic Print Settings - Windows**

Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

   Note: You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

   Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

![Printer Settings Window]

4. For the Paper Source setting, select where you loaded the paper you want to print on. Select Auto Select to automatically select the paper source in the Paper Setting menu on the product.

5. Select the size of your document or photo as the Document Size setting, and the size of your paper as the Output Paper setting.
   - To change the size of your printed document or photo, select the Reduce/Enlarge Document checkbox.
   - Select the Fit to Page option to size your image to fit the paper you loaded.
   - Select the Center checkbox if you want to center your image on the paper.
• Select the **Zoom to** option to reduce or enlarge your document or photo by a specific percentage. Select the percentage in the % dropdown.

6. Select the orientation of your document.

**Note:** If you are printing an envelope, select **Landscape**.

7. Select the type of paper you loaded as the **Paper Type** setting. Select **Auto Select** to automatically select the paper type in the **Paper Setting** menu on the product.

**Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

8. Select the **Quality** setting that matches the print quality you want to use.

9. Select a Color option:
   • To print a color document or photo, select the **Color** setting.
   • To print text and graphics in black or shades of gray, select the **Black/Grayscale** setting.

10. To print on both sides of the paper, select a **2-Sided Printing** option and click **Settings** to select printing options.

11. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select one of the **Multi-Page** options and click **Page Order** to select the printing options.

12. To print multiple copies and arrange their print order, select the **Copies, Reverse Order**, and **Collated** options.

13. To preview your job before printing, select **Print Preview**.

14. To save your print job as a project that can be modified and combined with other print jobs, select **Job Arranger Lite**.

**Paper Source Options - Windows**
**Print Quality Options - Windows**
**Multi-Page Printing Options - Windows**

**Parent topic:** Printing with the Standard Epson Printer Software - Windows

**Related references**
**Paper or Media Type Settings - Printing Software**

**Related tasks**
**Printing Your Document or Photo - Windows**
Entering a User ID and Password for Printing
Selecting Double-sided Printing Settings - Windows

Paper Source Options - Windows
You can select any of the available options in the Paper Source menu to print on the paper loaded in that source.

Auto Select
Automatically selects the paper source based on the selected paper size.

MP Tray
Selects the paper in the MP tray as the paper source.

Paper Cassette 1
Selects the paper in cassette 1 as the paper source.

Paper Cassette 2
Selects the paper in cassette 2 as the paper source.

Paper Cassette 3
Selects the paper in cassette 3 as the paper source.

Paper Cassette 4
Selects the paper in cassette 4 as the paper source.

High Capacity Tray
Selects the optional high capacity tray as the paper source if it is connected to the printer.

Set separately for each paper
Set a different paper source for the first paper and subsequent papers.

Parent topic: Selecting Basic Print Settings - Windows

Print Quality Options - Windows
You can select any of the available Quality options to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type and border setting you have chosen.

Standard
For everyday text and image printing.

High
For photos and graphics with high print quality.

Parent topic: Selecting Basic Print Settings - Windows

Multi-Page Printing Options - Windows
You can select any of the available options in the Multi-Page menu to set up your multi-page print job.
2-Up and 4-Up
Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and border options.

2×1 Poster, 2×2 Poster, 3×3 Poster, 4×4 Poster
Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main tab.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen or if you are accessing the product over a network.

1. Select one of the following options for 2-Sided Printing:
   - Auto (Long-edge binding) to print your double-sided print job by automatically flipping the paper on the long edge.
   - Auto (Short-edge binding) to print your double-sided print job by automatically flipping the paper on the short edge.

2. Click the Settings button.
You see this window:

3. Select the double-sided printing options you want to use.
4. Click OK to return to the Main tab.
5. Print a test copy of your double-sided document to test the selected settings.
6. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options - Windows

Parent topic: Printing with the Standard Epson Printer Software - Windows

Related tasks
Selecting Basic Print Settings - Windows

Double-sided Printing Options - Windows

You can select any of the available options on the Binding Settings window to set up your double-sided print job.

Binding Edge Options
Select a setting that orients double-sided print binding in the desired direction.

Binding Margin Options
Select options that define a wider margin to allow for binding.

Start Page
Selects whether printing starts on the front or back page.

Create Folded Booklet Options
Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows
Selecting Finishing Options - Windows
You can select a variety of finishing options for your document or photo on the Finishing tab.

1. To store print jobs in the product's memory, select one of the Job Type options:
   - Select Normal Print to print jobs without storing them.
   - Select Confidential Print to add a password to a print job.

   **Note:** Confidential jobs are stored in the product's memory without being printed. To print the job, enter the password for the confidential job on the product's control panel. Confidential print jobs are cleared from the product's memory after printing. If the product is turned off or restarted before the confidential job is printed, the job is cleared from the product's memory.

   - When printing multiple copies, select Verify Job to print one copy to verify content and settings. You can then continue printing from the product control panel.
   - Select Re-Print Job to store a print job in the product's memory. You can then print from the product control panel.

2. Select the Paper Source and Output Tray options you want to use.
3. Select **Separator Sheet** if you want to print a blank sheet of paper in between copies or print jobs.

   **Note:** You can also adjust this setting from the control panel using the **Insert Sheets per User** option.

4. Select one of the following **Sort** options:
   
   - Select **Rotate Sort** to stack printouts alternately in landscape and portrait orientations. The **Paper Source** and **Output Tray** settings must be set to **Auto Select**.
   - Select **Shift Sort** to offset each set of copies. The **Output Tray** setting must be set to **Finisher Tray**.

   **Note:** This option is available only when the optional finisher unit is installed.

5. Select a **Staple** option to choose the staple location on the document.

   **Note:** This option is available only when the optional finisher unit is installed.

6. When printing documents of mixed sizes, select **Specify Orientation**. Click **Settings** to select orientation and binding margin options.

   **Note:** This option is available only when the optional finisher unit is installed.

---

**Finishing Options - Windows**

**Parent topic:** Printing with the Standard Epson Printer Software - Windows

**Related references**

Universal Print Settings Options

---

You can select any of the Finishing options to customize your print. Some options may be pre-selected or unavailable, depending on other settings you have chosen.

**Job Type**

Select whether to store a print job in the product's memory.

**Paper Source**

Select the paper cassette or tray to use.

**Output Tray**

Select where printed jobs are output.
Sort
Select how to sort print jobs with multiple copies.

Staple
Select the staple location for printed documents.

Note: The Staple option is available only when the optional finisher unit is installed.

Parent topic: Selecting Finishing Options - Windows

Selecting Additional Print Options - Windows

You can select a variety of additional printing options for your document or photo on the More Options tab.

1. Select one of the following Color Correction options:
   * Select Automatic to automatically adjust the sharpness, brightness, contrast, and color saturation for your image.
   * Select Custom and click the Advanced button to manually adjust the color correction settings or turn off color management in your printer software.
   * Select Image Options to access additional settings for improving printed images.
2. To add the following features, click the **Watermark Features** button:
   - **Watermark**: adds a visible watermark to your printout
   - **Header/Footer**: adds information such as the date and time to the top or bottom of your printout

   **Note:** Click the **Settings** button to customize the text and location of the header or footer.

3. Select **Rotate 180°** to print the image rotated 180° from its original orientation.

   - Custom Color Correction Options - Windows
   - Header/Footer Settings - Windows
   - Image Options and Additional Settings - Windows

   **Parent topic:** Printing with the Standard Epson Printer Software - Windows

   **Related tasks**
   - Printing Your Document or Photo - Windows
Custom Color Correction Options - Windows

You can select any of the available options in the Color Correction window to customize the image colors for your print job.

Color Controls
Lets you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and Density, and individual color tones. Depending on the selected color mode, you can also adjust the midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.
ICM
Lets you manage color using installed color printing profiles.

No Color Adjustment
Turns off color management in your printer software so you can manage color using only your application software.

Parent topic: Selecting Additional Print Options - Windows

Header/Footer Settings - Windows
You can select any of the Header/Footer Settings options to add headers or footers when you print. The items are available to print at the top or bottom of your pages, in either the left, right, or center of the page.

Note: These settings are not saved with your document.

![Header/Footer Settings](image)

You can select to print the following information:

- User Name
- Computer Name
- Date
- Date/Time
- Document Name
- Collate Number (copy number)

Note: The user name, computer name, date, and time come from the Windows Control Panel on your computer.
You can select any of the Image Options and Additional Settings to customize your print. Some options may be pre-selected or unavailable, depending on other settings you have chosen.

**Image Options**

- **Emphasize Text**
  Adjusts the weight of printed text to increase readability.

- **Emphasize Thin Lines**
  Adjusts the weight of printed lines to increase visibility.

- **Edge Smoothing**
  Smooths jagged edges in low-resolution images such as screen captures or images from the Web.

- **Fix Red-Eye**
  Reduces or removes red-eye in photos.

- **Print Text in Black**
  Prints colored text in black.

- **For Color Text**
  Prints colored text on a background pattern or underlined.

- **For Color Graphs and Images**
  Prints colored graphics and images with overlay patterns.

- **For Color Text, Graphs, and Images**
  Prints colored text, graphics, and images with overlay patterns.

- **Enhancement Options**
  Specifies Color Universal Print enhancement settings for text, graphics, and images.

**Additional Settings Options**

- **Rotate 180°**
  Prints the image rotated 180° from its original orientation.

Parent topic: Selecting Additional Print Options - Windows
Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.

   You see the available Printing Presets on the left:

   ![Printing Presets](image)

2. Place your cursor over one of the Printing Presets to view its list of settings.
3. Click on a preset to change its settings, or use any of the available options on the screen to control your printing presets.
4. To choose a preset for printing, select it.
5. Click OK.

Parent topic: Printing with the Standard Epson Printer Software - Windows

Selecting Extended Settings - Windows

You can select additional settings that apply to all the print jobs you send to your product.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
2. Select Printer Settings.
3. Click the Maintenance tab.
You see the maintenance options:

4. Click the **Extended Settings** button.
You see this window:
5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.
7. Click OK to close the printer software window.

Extended Settings - Windows

Parent topic: Printing with the Standard Epson Printer Software - Windows

Extended Settings - Windows

You can select from these settings on the Extended Settings window.

**Print Mode**

Selects how print jobs are processed by the computer's or product's memory.

**TrueType Font**

Lets you select how you want to print TrueType fonts.

**Panel Settings**

Prioritizes settings from the product control panel or the printer driver software.

**Skip Blank Page**

Ensures that your product does not print pages that contain no text or images.

**Offset Settings**

Lets you make fine-tune adjustments to the print position of data on your printout.

**Print Density**

Sets the level of ink coverage for double-sided printing.

**Automatically change to monochrome mode**

Select to print automatically in monochrome instead of color.

**Optimize Finishing**

Reduces paper misalignment to improve stapling and stacking printouts. Print speed is decreased.

**Note:** Displayed when the optional finisher unit is installed.

**Thick Paper and Envelopes**

Select an option to prevent ink from smearing when you print on envelopes or other thick paper.

**Always Spool RAW Datatype**

Increases print speed and may solve other printing problems.

**Print as Bitmap**

Increases print speed when printing is extremely slow or the print head stops during printing, and other settings do not help.
Refine screening pattern
Prints graphics with a finer screening pattern.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Barcode mode
Reduces bleeding when printing barcodes on plain paper, letterhead paper, recycled paper, preprinted paper, envelopes, and thick paper.

Detect Canceled Printing
Displays a message on the computer screen when a print job is canceled from the product control panel.

Always Use the Driver's Color Setting
Prioritizes color settings from the printer driver software.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows

Once you have selected your print settings, you are ready to save your settings and print.

1. Click OK to save your settings.
You see your application’s Print window, such as this one:

![Print window image]

2. Click OK or Print to start printing.

Parent topic: Printing with the Standard Epson Printer Software - Windows

Locking Printer Settings - Windows

Windows administrators can lock access to some printer settings to prevent unauthorized changes.

1. Do one of the following:

- **Windows 10**: Click and select (Settings) > Devices > Printers & scanners. Select your product name and select Manage > Printer properties.

- **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click your product and select Printer properties.

- **Windows 7**: Click and select Devices and Printers. Right-click your product and select Printer properties.
• **Windows Vista**: Click and select **Control Panel**. Click **Printer** under **Hardware and Sound**, then right-click your product and select **Properties**.

• **Windows XP**: Click **Start** and select **Printers and Faxes**. Right-click your product and select **Properties**.

2. Click the **Optional Settings** tab.

**Note**: You can prevent access to the **Optional Settings** tab by changing the user or group permissions in the **Security** tab.

3. Click **Driver Settings**.

You see this window:

![Driver Settings window](image)

4. Select the checkbox for each setting you want to lock. To lock all print settings, select **All Document Settings**.

5. Under **Advanced Settings**, select the setting option you want to use for each locked setting.

6. Click **OK**.
Locked Setting Options

Parent topic: Printing with the Standard Epson Printer Software - Windows

Locked Setting Options

Select the options you want to use for any locked print settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anti-Copy Pattern</td>
<td>Various data items</td>
<td>Lets you select the data to use for the pattern or prohibit anti-copy patterns</td>
</tr>
<tr>
<td></td>
<td>Add/Delete</td>
<td>Lets you add or delete a customized anti-copy pattern</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Lets you select the arrangement, size, and other settings for the custom anti-copy pattern</td>
</tr>
<tr>
<td>Watermark</td>
<td>Various text watermarks</td>
<td>Lets you select the text for the watermark or prohibit watermarks</td>
</tr>
<tr>
<td></td>
<td>Add/Delete</td>
<td>Lets you add or delete a customized text or image-based watermark</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Lets you select the size, position, and other watermark settings</td>
</tr>
<tr>
<td>Header/Footer</td>
<td>Off</td>
<td>Prohibits headers or footers</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Allows headers and footers</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Lets you select the text and position for printing headers and footers</td>
</tr>
<tr>
<td>Job Type</td>
<td>—</td>
<td>Lets you select the Enable Normal Print Only checkbox so only the Normal Print option is available</td>
</tr>
<tr>
<td>Color</td>
<td>Color</td>
<td>Allows color printing</td>
</tr>
<tr>
<td></td>
<td>Grayscale</td>
<td>Allows printing in black or shades of gray only</td>
</tr>
<tr>
<td>2-sided printing</td>
<td>Off</td>
<td>Allows printing on one side of the paper only</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Allows printing on both sides of the paper</td>
</tr>
<tr>
<td>Multi-Page</td>
<td>Off</td>
<td>Prohibits multi-page settings</td>
</tr>
<tr>
<td></td>
<td>2-Up</td>
<td>Allows printing of 2 pages on one sheet of paper</td>
</tr>
<tr>
<td></td>
<td>4-Up</td>
<td>Allows printing of 4 pages on one sheet of paper</td>
</tr>
</tbody>
</table>
Entering a User ID and Password for Printing

If you enabled Access Control on the product, you must enter a user ID and password in the printer driver to be able to print.

**Note:** If you do not know the user ID or password, contact your administrator for assistance.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click . Select **Printer Settings** and click the **Maintenance** tab.

2. Click the **Printer and Option Information** button.
3. Select the **Save Access Control Settings** checkbox.
4. Click the **Settings** button.
5. Enter your user name and password.
6. Click **OK**.

**Parent topic:** [Printing with the Standard Epson Printer Software - Windows](#)
Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that program session. If you want to change the print settings you use in all your Windows programs, you can select new default print settings.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.
2. Select **Printer Settings**.
   You see the printer settings window:

![Printer Settings Window]

3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click **OK**.

These settings are now the defaults selected for printing. You can still change them as needed for printing in any program session.

Changing the Language of the Printer Software Screens

**Parent topic:** Printing with the Standard Epson Printer Software - Windows

Changing the Language of the Printer Software Screens

You can change the language used on the Windows printer software screens.
1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.

2. Select **Printer Settings**.
   You see the printer settings window.

3. Click the **Maintenance** tab.
   You see the maintenance options:

   ![Printer Settings Window](image)

   4. Select the language you want to use as the **Language** setting.

   5. Click **OK** to close the printer software window.

   The printer software screens appear in the language you selected the next time you access them.

   **Parent topic:** Selecting Default Print Settings - Windows

**Changing Automatic Update Options**

Your printer software for Windows automatically checks for updates to the product software. You can change how often the software checks for updates or disable this feature.
1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.

2. Select **Software Update Settings**.
   You see this window:

   ![Software Update Settings window](image)

3. Do one of the following:
   - To change how often the software checks for updates, select a setting in the **Check every** menu.
   - To disable the automatic update feature, select the **Never** option.

4. Click **OK** to exit.

   **Note:** If you choose to disable the automatic update feature, you can check for updates manually.

**Parent topic:** Printing with the Standard Epson Printer Software - Windows

**Related tasks**

- Checking for Software Updates

**Printing with the Epson Standard Printer Software - Mac**

You can print with your product using any Mac printing program, as described in these sections.

   **Note:** If you have an Internet connection, it is a good idea to check for updates to your product software on Epson’s support website.
Selecting Basic Print Settings - Mac
Selecting Page Setup Settings - Mac
Selecting Print Layout Options - Mac
Managing Color - Mac
Selecting Finishing Options - Mac
Selecting Paper Configuration Settings - Mac
Selecting Double-sided Printing Settings - Mac
Selecting Printing Preferences - Mac
Printing Your Document or Photo - Mac

Parent topic: Printing from a Computer

Selecting Basic Print Settings - Mac

Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

   Note: You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. Select your product as the Printer setting.

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the print window.
You see the expanded printer settings window for your product:

![Expanded Printer Settings Window]

**Note:** The print window may look different, depending on the Mac OS version and the application you are using.

5. Select the **Copies** and **Pages** settings as necessary.

**Note:** If you do not see these settings in the print window, check for them in your application before printing.
6. Select the page setup options: **Paper Size** and **Orientation**.

   **Note:** If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting **Page Setup** from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image above for the Preview application.

8. Select **Print Settings** or **Printer Features** from the pop-up menu.
You see these settings:

![Print Settings](image)

9. Select the **Paper Source** you wish to print from.
10. Select the type of paper you loaded as the **Media Type** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

11. Select the **Print Quality** setting you want to use.
12. Select any of the available print options.

Paper Source Options - Mac
Print Quality Options - Mac

**Parent topic:** Printing with the Epson Standard Printer Software - Mac

**Related references**
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Page Setup Settings - Mac

Paper Source Options - Mac
You can select any of the available options in the Paper Source menu to print on the paper loaded in that source.

Auto Select
Automatically selects the paper source based on the selected paper size.

MP Tray
Selects the paper in the MP tray as the paper source.

Cassette 1
Selects the paper in cassette 1 as the paper source.

Cassette 2
Selects the paper in cassette 2 as the paper source.

Cassette 3
Selects the paper in cassette 3 as the paper source.

Cassette 4
Selects the paper in cassette 4 as the paper source.

High Capacity Tray
Selects the optional high capacity tray as the paper source if it is connected to the printer.

Parent topic: Selecting Basic Print Settings - Mac

Print Quality Options - Mac
You can select any of the available Print Quality options to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type setting you have chosen.

Normal
For everyday text and image printing.

Fine
For text and graphics with good quality and print speed.

Parent topic: Selecting Basic Print Settings - Mac
Selecting Page Setup Settings - Mac

Depending on your application, you may be able to select the paper size and orientation settings from the print window.

Note: If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting.
2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the icon.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the pop-up menu and selecting a scaling option.

Parent topic: Printing with the Epson Standard Printer Software - Mac
Selecting Print Layout Options - Mac

You can select a variety of layout options for your document or photo by selecting Layout from the pop-up menu on the print window.

- To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.
- To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
- To print on both sides of each page, select a setting from the Two-Sided pop-up menu.
- To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.

Parent topic: Printing with the Epson Standard Printer Software - Mac

Managing Color - Mac

You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout or turn off color management in your printer software.

1. Select Color Matching from the pop-up menu in the print window.
2. Select one of the available options.

3. Select **Color Options** from the pop-up menu in the print window.

![Color Options Menu]

**Note:** The available settings on the Color Options menu depend on the option you selected on the Color Matching menu.

4. Select one of the available options.

**Color Matching and Color Options - Mac**

**Parent topic:** Printing with the Epson Standard Printer Software - Mac

**Color Matching and Color Options - Mac**

You can select these settings on the **Color Matching** and **Color Options** menus.

**Color Matching Settings**

**EPSON Color Controls**

- Lets you manage color using controls in your printer software or turn off color management.

**ColorSync**

- Prints using standard color profiles for your product and paper to help match image colors. You can customize the conversion method and filter settings on the ColorSync pop-up menu in the print window.
Color Options Settings

Manual Settings
Let you select manual color adjustments. Click the arrow next to Advanced Settings and select settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-eye in photos. Depending on the selected color mode, you can also adjust the midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your application software.

Note: An ICC profile is required if color management is turned off.

Parent topic: Managing Color - Mac

Selecting Finishing Options - Mac
You can choose finishing options by selecting Finishing from the pop-up menu on the print window.
1. Select the **Output Tray** you want to output your print jobs to.
2. If you are printing multiple copies, select a **Sort** option.
3. To select a staple location for printed documents, select a **Staple** option.

   **Note:** The **Staple** option is available only when the optional finisher unit is installed.

---

**Finishing Options - Mac**

**Parent topic:** Printing with the Epson Standard Printer Software - Mac

---

**Finishing Options - Mac**

You can select any of the available options in the **Finishing** pop-up menu.

**Output Tray**

Select where printed jobs are output.

**Sort**

Select how to sort print jobs with multiple copies.

**Staple**

Select the staple location for printed documents.

**Note:** The **Staple** option is available only when the optional finisher unit is installed.

**Parent topic:** Selecting Finishing Options - Mac
Selecting Paper Configuration Settings - Mac

You can adjust the print density of printed documents by selecting Paper Configuration from the pop-up menu on the print window.

![Paper Configuration settings](image)

Parent topic: Printing with the Epson Standard Printer Software - Mac

Selecting Double-sided Printing Settings - Mac

You can print on both sides of the paper by selecting Two-sided Printing Settings from the pop-up menu on the print window.

![Two-sided Printing settings](image)

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen or if you are accessing the product over a network. This screen may be different, depending on the Mac OS version you are using.

1. Select one of the Two-sided Printing options.
2. Print a test copy of your double-sided document to test the selected settings.
3. Follow any instructions displayed on the screen during printing.

Parent topic: Printing with the Epson Standard Printer Software - Mac

Double-sided Printing Options and Adjustments - Mac

You can select any of the available options in the Two-sided Printing Settings pop-up menu to set up your double-sided print job.

Long-Edge binding
Orients double-sided printed pages to be bound on the long edge of the paper.

Short-Edge binding
Orients double-sided printed pages to be bound on the short edge of the paper.

Parent topic: Selecting Double-sided Printing Settings - Mac

Selecting Printing Preferences - Mac

You can select printing preferences that apply to all the print jobs you send to your product.

1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies.
3. Select Driver or Options.
You see a screen like this:

![Printing Preferences - Mac](image)

4. Select any of the available printing preferences.
5. Click OK.

**Printing Preferences - Mac**

**Parent topic:** Printing with the Epson Standard Printer Software - Mac

**Printing Preferences - Mac**

You can select these settings on the **Options** or **Driver** tab.

**Thick Paper and Envelopes**

Prevents ink from smearing when you print on envelopes or other thick paper.

**Skip Blank Page**

Ensures that your product does not print pages that contain no text or images.

**Warning Notifications**

Lets you choose whether or not to receive warning notifications from the printer software for various operating conditions.
Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you experience issues when using a shared printing pool.

Optional Output Trays
Select an output tray option if the optional finisher unit is installed.

Optional Paper Sources
Select an optional paper source option if the optional high-capacity input tray is installed.

Parent topic: Selecting Printing Preferences - Mac

Printing Your Document or Photo - Mac
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Checking Print Status - Mac
Parent topic: Printing with the Epson Standard Printer Software - Mac
Checking Print Status - Mac
During printing, you can view the progress of your print job, control printing, and check ink status.

1. Click the printer icon when it appears in the Dock.
   You see the print status window:

![Print Status Window](image)

2. Select the following options as necessary for your Mac OS version:
   - To cancel printing, click the print job and click or **Delete**.
   - To pause a print job, click the print job and click or **Hold**. To resume a print job, click the paused print job and click or **Resume**.
   - To pause printing for all queued print jobs, click **Pause** or **Pause Printer**.
   - To display other printer information, click **Settings** or **Supply Levels**.

Parent topic: Printing Your Document or Photo - Mac

Printing with the Epson Universal Print Driver - Windows
You can print with the Epson Universal Print Driver using any Windows printing program, as described in these sections.

- Synchronizing Printer Settings - Epson Universal Print Driver - Windows
- Selecting Basic Print Settings - Epson Universal Print Driver - Windows
- Selecting Additional Layout and Print Options - Epson Universal Print Driver - Windows
Synchronizing Printer Settings - Epson Universal Print Driver - Windows

You may need to synchronize the printer driver with the product if the printer driver does not detect the correct information or settings from the product.

**Note:** You must sync the printer driver before you can use any optional equipment installed on the product.

1. Do one of the following:
   - **Windows 10:** Click and select (Settings) > Devices > Printers & scanners. Select EPSON Universal Print Driver and select Manage > Printer properties.
   - **Windows 8.x:** Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.
   - **Windows 7:** Click and select Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.
   - **Windows Vista:** Click and select Control Panel. Click Printer under Hardware and Sound, then right-click EPSON Universal Print Driver and select Properties.
   - **Windows XP:** Click Start and select Printers and Faxes. Right-click EPSON Universal Print Driver and select Properties.

2. Click the Optional Settings tab.
You see a window like this:

3. Make sure **Acquire from Printer** is selected and click **Get**.

   **Note**: Select the **Only Optional Information** checkbox if you only want to enable any optional equipment installed on the product.

   The product's settings and other information appears in the Current Printer Information area.

4. Click **OK**.

**Parent topic**: Printing with the Epson Universal Print Driver - Windows

**Selecting Basic Print Settings - Epson Universal Print Driver - Windows**

Select the basic settings for the document or photo you want to print.
**Note:** The names of settings on the universal print driver screens may vary slightly, depending on the version of the print driver you have installed.

1. Open a photo or document for printing.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the **Print** option in the **File** menu, or another command. See your application's help utility for details.

3. If necessary, select **EPSON Universal Print Driver** as the printer you want to use.

   **Note:** You may also need to select **Properties** or **Preferences** to view your print settings.

You see the **Main** tab of your printer settings window:
Note: For more information about a setting, right-click it and select Help.

4. For the Paper Source setting, select where you loaded the paper you want to print on.
5. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.

6. Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.

7. Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list for details.

8. Select the Quality setting that matches the print quality you want to use.
9. Select a Color option:
   - To print a color document or photo, select the Color setting.
   - To print text and graphics in black or shades of gray, select the Grayscale setting.
10. To print on both sides of the paper, select one of the 2-Sided Printing settings.
11. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select one of the settings in the Multi-Page menu and select the printing options you want.
12. To print multiple copies and arrange their print order, select the Copies options.
13. To preview your job before printing, select Print Preview.
14. To save your print job as a project that can be modified and combined with other print jobs, select Job Arranger Lite.

Parent topic: Printing with the Epson Universal Print Driver - Windows

Related references
Paper or Media Type Settings - Printing Software
Paper Source Options - Windows
Print Quality Options - Windows
Multi-Page Printing Options - Windows
Selecting Additional Layout and Print Options - Epson Universal Print Driver - Windows

You can select a variety of additional layout and printing options for your document or photo on the More Options tab.

![Epson Universal Print Driver Preferences]

**Note:** For more information about a setting, right-click it and select Help.

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document checkbox and select one of these sizing options:
   - Select the **Fit to Page** option to size your image to fit the paper you loaded. Select the size of your document or photo as the **Document Size** setting, and the size of your paper as the **Output Paper** setting. If you want to center your image on the paper, select the **Center** option.
   - Select the **Zoom to** option to reduce or enlarge your document or photo by a specific percentage. Select the percentage in the % menu.
2. Select one of the following Color Correction options:
   - Select **Automatic** to automatically adjust the sharpness, brightness, contrast, and color saturation for your image.
   - Select **Custom** and click the **Advanced** button to manually adjust the color correction settings or turn off color management in your printer software.
   - Select **Image Options** to access additional settings for improving printed images.

3. To add the following features, click the **Watermark Features** button:
   - **Watermark**: adds a visible watermark to your printout.
     
     **Note**: Click the **Add/Delete** button to create your own watermark, and click the **Settings** button to customize the watermark.

   - **Header/Footer**: adds information such as the date and time to the top or bottom of your printout.
     
     **Note**: Click the **Settings** button to customize the text and location of the header or footer.

4. To add a password to your print job, select the **Confidential Job** checkbox, then enter a password. Confidential jobs are stored in the product's memory without being printed. To print the job, enter the password for the confidential job on the product's control panel.

   **Note**: Confidential print jobs are cleared from the product's memory after printing.

5. Select any of the Additional Settings options to customize your print.

**Parent topic**: Printing with the Epson Universal Print Driver - Windows

**Related references**

- Custom Color Correction Options - Windows
- Header/Footer Settings - Windows
- Image Options and Additional Settings - Windows
Selecting Maintenance Options - Epson Universal Print Driver - Windows

You can select maintenance and other optional settings on the **Maintenance** tab.

![Epson Universal Print Driver Preferences window](image)

**Note:** For more information about a setting, right-click it and select **Help**.

- **Nozzle Check** lets you print a nozzle check pattern to check for clogged nozzles.
- **Head Cleaning** lets you clean the print head.
- **Network printer search** lets you search for and connect to a product on the network.
- **Job Arranger Lite** lets you save your print job as a project that can be modified and combined with other print jobs.
- **Extended Settings** lets you change a variety of print settings.
- **Print Queue** displays all the print jobs in queue. You can also cancel or restart print jobs.
- **Printer and Option Information** displays information on the printer settings and any optional equipment installed.
- **Language** lets you change the language of the printer software screens.

**Extended Settings - Epson Universal Print Driver - Windows**

**Parent topic:** Printing with the Epson Universal Print Driver - Windows

**Extended Settings - Epson Universal Print Driver - Windows**

You can select from these settings on the Extended Settings window.

![Extended Settings window](image)

**Printer Control Language**

- Lets you select the printer control language.

**Graphics Mode**

- Lets you select the mode by which to output PDL commands to the product.

**TrueType Font**

- Lets you select how you want to print TrueType fonts.

**Offset Settings**

- Lets you make fine-tune adjustments to the print position of data on your printout.

**Skip Blank Page**

- Ensures that your product does not print pages that contain no text or images.
Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and other settings do not help.

Refine screening pattern
Prints graphics with a finer screening pattern.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Uses the collate settings specified in the application
Prints using the collate setting in your application.

Page Rendering Mode
Increases print speed when printing is extremely slow.

Collate Using Printer Driver
Prints and collates multi-page documents using the printer driver. Deselect this checkbox to use the product to collate your print jobs instead. (This setting is automatically enabled if there is not enough memory on the product to collate your print job.)

Output 1 page documents facedown in 2-Sided mode
Outputs single-sided pages in a 2-sided print job facedown instead of faceup.

Output documents for filing
Outputs all landscape, portrait, 1-sided, and 2-sided documents in the same orientation for easier filing.

Always Use the Driver's Color Setting
Prints using the color setting in the printer driver, rather than the setting in your application.

Parent topic: Selecting Maintenance Options - Epson Universal Print Driver - Windows

Selecting Default Print Settings - Epson Universal Print Driver - Windows
When you change your print settings in a program, the changes apply only while you are printing in that program session. If you want to change the print settings you use in all your Windows programs, you can select new default print settings.

1. Do one of the following:
   - Windows 10: Click (Settings) > Devices > Printers & scanners. Select EPSON Universal Print Driver and select Manage > Printing Preferences.
• **Windows 8.x:** Navigate to the **Apps** screen and select **Control Panel > Hardware and Sound > Devices and Printers.** Right-click **EPSON Universal Print Driver** and select **Print Preferences.**

• **Windows 7:** Click and select **Devices and Printers.** Right-click **EPSON Universal Print Driver** and select **Printing Preferences.**

• **Windows Vista:** Click and select **Control Panel.** Click **Printer** under **Hardware and Sound,** right-click **EPSON Universal Print Driver,** and select **Printing Preferences.**

• **Windows XP:** Click **Start** and select **Printers and Faxes.** Right-click **EPSON Universal Print Driver** and select **Printing Preferences.**

You see the printer settings window:

![Printer Settings Window](image)

**Note:** For more information about a setting, right-click it and select **Help.**

2. Select the print settings you want to use as defaults in all your Windows programs.
3. Click **OK**.
These settings are now the defaults selected for printing. You can still change them as needed for printing in any program session.

**Parent topic:** Printing with the Epson Universal Print Driver - Windows

### Locking Printer Settings - Epson Universal Print Driver - Windows

Administrators can lock some printer settings to prevent unauthorized changes.

1. Do one of the following:
   - **Windows 10:** Click  and select  (Settings) > Devices > Printers & scanners. Select **EPSON Universal Print Driver** and select **Manage > Printer properties**.
   - **Windows 8.x:** Navigate to the **Apps** screen and select **Control Panel > Hardware and Sound > Devices and Printers**. Right-click **EPSON Universal Print Driver** and select **Printer properties**.
   - **Windows 7:** Click  and select **Devices and Printers**. Right-click **EPSON Universal Print Driver** and select **Printer properties**.
   - **Windows Vista:** Click  and select **Control Panel**. Click **Printer** under **Hardware and Sound**, then right-click **EPSON Universal Print Driver** and select **Properties**.
   - **Windows XP:** Click **Start** and select **Printers and Faxes**. Right-click **EPSON Universal Print Driver** and select **Properties**.

2. Click the **Optional Settings** tab.

3. Click **Driver Settings**.
You see this window:

4. Select the checkbox for the settings you want to lock. To lock all print settings, select **All Document Settings**.
5. Under **Advanced Settings**, select the setting option you want to use for each locked setting.
6. Click **OK**.

**Epson Universal Print Driver Locked Setting Options**

**Parent topic**: Printing with the Epson Universal Print Driver - Windows

**Epson Universal Print Driver Locked Setting Options**
Select the options you want to use for any locked print settings.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Watermark</td>
<td>Various text watermarks</td>
<td>Lets you select the text for the watermark or prohibit watermarks</td>
</tr>
<tr>
<td></td>
<td>Add/Delete</td>
<td>Lets you add or delete a customized text or image-based watermark</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Lets you select the size, position, and other watermark settings</td>
</tr>
<tr>
<td>Header/Footer</td>
<td>Off</td>
<td>Prohibits headers or footers</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Allows headers and footers</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Lets you select the text and position for printing headers and footers</td>
</tr>
<tr>
<td>Color</td>
<td>Color</td>
<td>Allows color printing</td>
</tr>
<tr>
<td></td>
<td>Grayscale</td>
<td>Allows printing in black or shades of gray only</td>
</tr>
<tr>
<td>2-sided printing</td>
<td>Off</td>
<td>Allows printing on only one side of the paper</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Allows printing on both sides of the paper</td>
</tr>
<tr>
<td>Multi-Page</td>
<td>Off</td>
<td>Prohibits multi-page settings</td>
</tr>
<tr>
<td></td>
<td>2-Up</td>
<td>Allows printing of 2 pages on one sheet of paper</td>
</tr>
<tr>
<td></td>
<td>4-Up</td>
<td>Allows printing of 4 pages on one sheet of paper</td>
</tr>
</tbody>
</table>

Parent topic: Locking Printer Settings - Epson Universal Print Driver - Windows

Adding Network Printers - Epson Universal Print Driver - Windows

You can use the Epson Universal Print Driver to find and add network printers.

1. Do one of the following:
   - **Windows 10**: Click 📱 and select 📜 (Settings) > Devices > Printers & scanners. Select EPSON Universal Print Driver and select Manage > Printer properties.
   - **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.
   - **Windows 7**: Click 📱 and select Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.
• **Windows Vista:** Click and select **Control Panel**. Click **Printer** under **Hardware and Sound**, then right-click **EPSON Universal Print Driver** and select **Properties**.

• **Windows XP:** Click **Start** and select **Printers and Faxes**. Right-click **EPSON Universal Print Driver** and select **Properties**.

2. Click the **Optional Settings** tab.

You see this window:

![EPSON Universal Print Driver Properties window](image)

3. Click **Network printer search**.

4. When you see the search results, select **Add found printers**.
You see a screen like this:

5. Select the printer or printers you want to add.
6. Click **Add to Printer Folder**.
   The selected printer or printers appear in the lower section of the screen.
7. Select the checkbox next to the product you want to make your default printer, if necessary.
8. Click **OK**.

Parent topic: Printing with the Epson Universal Print Driver - Windows
Printing with the PostScript (PS3) Printer Software - Windows

You can print with the PostScript (PS3) printer software using any Windows printing program, as described in these sections.

Note: The PostScript printer software supports products that are connected via Ethernet. If your product is connected via USB, you will need to install the standard Epson printer software. To download the standard Epson printer software, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

Selecting Basic Print Settings - PostScript Printer Software - Windows
Selecting Additional Layout and Print Options - PostScript Printer Software - Windows
Selecting Default Print Settings - PostScript Printer Software - Windows

Parent topic: Printing from a Computer

Selecting Basic Print Settings - PostScript Printer Software - Windows

Select the basic settings for the document or photo you want to print.

The PostScript printer software supports plain paper printing on these paper and envelope sizes:

- A4 (8.3 × 11.7 inches [210 × 297 mm])
- Letter (8.5 × 11 inches [216 × 279 mm])
- No. 10 (4.1 × 9.5 inches [105 × 241 mm])

1. Open a photo or document for printing.
2. Select the print command in your application.

   Note: You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use, and then click the Preferences button.
You see the Layout tab of your printer settings window:

4. Select the orientation of your document.
5. To print on both sides of the paper, select one of the Print on Both Sides settings.
6. To change the printing order of the pages, select one of the Page Order settings.
7. To print multiple pages on one sheet of paper, adjust the Pages per Sheet setting.
8. To create a folded booklet out of your photo or document, select the Booklet option.
9. Click the Paper/Quality tab.
You see this window:

10. Select the **Paper Source** that matches where you loaded the paper you want to print on.
11. Select one of the **Plain** options as the **Media** setting.
12. Select one of the following as the **Color** setting:
   - To print a color document or photo, select the **Color** setting.
   - To print text and graphics in black only, select the **Black & White** setting.

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Related references
- Paper or Media Type Settings - Printing Software
- Paper Source Options - Windows
Selecting Additional Layout and Print Options - PostScript Printer Software - Windows

You can select a variety of additional layout and printing options for your document or photo by clicking the Advanced button.

1. Select the size of the paper you loaded as the Paper Size setting.
2. To use the Windows Image Color Management system, set the ICM Method setting to one of the ICM Handling options and select the ICM Intent setting you want to use.
3. Adjust the Scaling setting to reduce or enlarge your document or photo by a specific percentage.
4. Select the TrueType Font setting to determine font substitutes.
5. Enable the Advanced Printing Features setting to allow detailed settings for printing features.
6. Adjust the Pages Per Sheet Layout setting to change the order of multiple pages on a single sheet of paper when you have adjusted the Pages Per Sheet setting on the Layout tab.
7. Adjust the **Booklet Binding Edge** setting to change the orientation of your printed booklet.

8. Expand the PostScript Options heading to access the advanced PostScript printer software features.

9. Select any of the remaining **Printer Features** options to customize your printouts.

Parent topic: **Printing with the PostScript (PS3) Printer Software - Windows**

### Selecting Default Print Settings - PostScript Printer Software - Windows

When you change your print settings in a program, the changes apply only while you are printing in that program session. If you want to change the print settings you use in all your Windows programs, you can select new default print settings.

1. Do one of the following:
   - **Windows 10:** Click 📑 and select 🔄 (Settings) > Devices > Printers & scanners. Select your product name and select Manage > Printing preferences.
   - **Windows 8.x:** Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click your product name and select Print Preferences.
   - **Windows 7:** Click 📑 and select Devices and Printers. Right-click your product name and select Printing Preferences.
   - **Windows Vista:** Click 📑 and select Control Panel. Click Printer under Hardware and Sound, right-click your product name, and select Printing Preferences.
   - **Windows XP:** Click Start and select Printers and Faxes. Right-click your product name and select Printing Preferences.

   You see the printer settings window:

2. Select the print settings you want to use as defaults in all your Windows programs.

3. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for printing in any program session.

Parent topic: **Printing with the PostScript (PS3) Printer Software - Windows**

### Printing with the PostScript (PS3) Printer Software - Mac

You can print with the PostScript (PS3) printer software using any Mac printing program, as described in these sections.
Note: The PostScript printer software supports products that are connected via Ethernet. If your product is connected via USB, you will need to install the standard Epson printer software. To download the standard Epson printer software, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

Selecting Basic Print Settings - PostScript Printer Software - Mac
Selecting Page Setup Settings - PostScript Printer Software - Mac
Selecting Print Layout Options - PostScript Printer Software - Mac
Sizing Printed Images - PostScript Printer Software - Mac
Managing Color - PostScript Printer Software - Mac
Printing Your Document or Photo - PostScript Printer Software - Mac

Parent topic: Printing from a Computer

Selecting Basic Print Settings - PostScript Printer Software - Mac

Select the basic settings for the document or photo you want to print.

The PostScript printer software supports plain paper printing on these paper and envelope sizes:

- A4 (8.3 × 11.7 inches [210 × 297 mm])
- Letter (8.5 × 11 inches [216 × 279 mm])
- No. 10 (4.1 × 9.5 inches [105 × 241 mm])

1. Open a photo or document for printing.
2. Select the print command in your application.
3. Select your product as the Printer setting.

   Note: You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the print window.
You see the expanded printer settings window for your product:

![Printer Settings Window]

**Note:** The print window may look different, depending on the Mac OS version and the application you are using.

5. Select the **Two-Sided**, **Copies**, and **Pages** settings as necessary.

**Note:** If you do not see these settings in the print window, check for them in your application before printing.
6. Select the page setup options: **Paper Size** and **Orientation**.

   **Note:** If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting **Page Setup** from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image above for the Preview application.

8. Select **Paper Feed** from the pop-up menu.

   ![Paper Feed settings]

   You see these settings:

   ![Paper Feed settings](image)

9. Select **All Pages From** or **First Page From** and select the paper source you want to print from.
10. Select **Printer Features** from the pop-up menu.

![Printer Features menu]

You see these settings:

![MediaType settings]

11. Select a **MediaType** setting.
12. Select **Color** from the Feature Sets pop-up menu.
You see these settings:

![Printer Features](image)

13. Select a **Color Mode** option:
   - To print a color document or photo, select the **Color** setting.
   - To print text and graphics in black only, select the **Monochrome** setting.

14. Select any of the available print options.

**Parent topic:** Printing with the PostScript (PS3) Printer Software - Mac

**Related tasks**
- Selecting Page Setup Settings - PostScript Printer Software - Mac
- Selecting Print Layout Options - PostScript Printer Software - Mac
- Printing Your Document or Photo - PostScript Printer Software - Mac

**Selecting Page Setup Settings - PostScript Printer Software - Mac**

Depending on your application, you may be able to select the paper size and orientation settings from the print window.

![Paper Size](image)

**Note:** If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting **Page Setup** from the File menu.
1. Select the size of the paper you loaded as the **Paper Size** setting. You can also select a custom setting to create a custom paper size.

2. Select the orientation of your document or photo as shown in the print window.

   **Note**: You can reduce or enlarge the size of the printed image by selecting **Paper Handling** from the pop-up menu and selecting a scaling option.

**Parent topic**: Printing with the PostScript (PS3) Printer Software - Mac

**Related tasks**

- [Selecting Basic Print Settings - PostScript Printer Software - Mac](#)
- [Selecting Print Layout Options - PostScript Printer Software - Mac](#)

**Selecting Print Layout Options - PostScript Printer Software - Mac**

You can select a variety of layout options for your document or photo by selecting **Layout** from the pop-up menu on the print window.

![Layout settings](image)

- To print multiple pages on one sheet of paper, select the number of pages in the **Pages per Sheet** pop-up menu. To arrange the print order of the pages, select a **Layout Direction** setting.
- To print borders around each page on the sheet, select a line setting from the **Border** pop-up menu.
- To print on both sides of the page, select one of the **Two-Sided** settings.
• To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.

Parent topic: Printing with the PostScript (PS3) Printer Software - Mac

Sizing Printed Images - PostScript Printer Software - Mac

You can adjust the size of the image as you print it by selecting Paper Handling from the pop-up menu on the Print window.

- To print only selected pages in a multi-page document, select an option from the Pages to Print pop-up menu.
- To adjust the order in which pages are printed, select an option from the Page Order pop-up menu.
- To scale the image to fit on a specific paper size, select the Scale to fit paper size checkbox and select a paper size from the Destination Paper Size pop-up menu.

Parent topic: Printing with the PostScript (PS3) Printer Software - Mac

Managing Color - PostScript Printer Software - Mac

You can adjust the Color Matching settings to fine-tune the colors in your printout.
1. Select **Color Matching** from the pop-up menu in the print window.

2. Do one of the following:
   - To print using standard color profiles for your product and paper to help match image colors, select **ColorSync**. Select one of the available **Profile** options to change the active color profile.
   - To use the product's default color matching, select **In printer**.

**Parent topic:** Printing with the PostScript (PS3) Printer Software - Mac

**Printing Your Document or Photo - PostScript Printer Software - Mac**

Once you have selected your print settings, you are ready to print.
Click **Print** at the bottom of the print window.

![Print Settings](image)

**Checking Print Status - PostScript Printer Software - Mac**

**Parent topic:** Printing with the PostScript (PS3) Printer Software - Mac

**Checking Print Status - PostScript Printer Software - Mac**

During printing, you can view the progress of your print job, control printing, and check ink status.

1. Click the printer icon when it appears in the Dock.

198
You see the print status window:

2. Select the following options as necessary for your Mac OS version:

   • To cancel printing, click the print job and click or **Delete**.
   • To pause a print job, click the print job and click or **Hold**. To resume a print job, click the paused print job and click or **Resume**.
   • To pause printing for all queued print jobs, click **Pause** or **Pause Printer**.
   • To display other printer information, click **Settings** or **Supply Levels**.

**Parent topic:** Printing Your Document or Photo - PostScript Printer Software - Mac

### Cancelling Printing Using the Product Control Panel

If you need to cancel printing, select **Cancel** on the LCD screen, then select **Cancel** again to confirm.

**Parent topic:** Printing from a Computer
**Scanning**

You can scan your originals and save them as digital files.

**Note:** Your product may differ from the images in this guide, but the instructions are the same unless otherwise noted.

- Starting a Scan
- Scanning with Document Capture Pro or Document Capture
- Scanning in Epson Scan 2
- Scanning Special Projects
- Entering a User ID and Password for Scanning

**Starting a Scan**

After placing your originals on your product for scanning, start scanning using one of these methods.

**Note:** You can also scan using Document Capture Pro (Windows) or Document Capture (Mac).

- Starting a Scan Using the Product Control Panel
- Setting Up and Scanning to a Network Folder or FTP Server
- Starting a Scan Using the Epson Scan 2 Icon
- Starting a Scan from a Scanning Program
- Starting a Scan from a Smart Device

**Parent topic:** Scanning

**Related tasks**

- Scanning with Document Capture Pro or Document Capture

**Related topics**

- Placing Originals on the Product

**Starting a Scan Using the Product Control Panel**

You can scan an image to a variety of destinations using your product's control panel.
1. Make sure you installed the product software and connected the product to your computer or network.

   **Note:** Restart your computer after installing the product software to enable scanning from the control panel.

2. Place your original on the product for scanning.

   **Note:** To scan a double-sided or multi-page document, place your originals in the ADF.

3. Press the home button, if necessary.

4. Select **Scan**.

   You see a screen like this:

   ![Scan Options Screen](image)

5. Select one of the following **Scan to** options:
   - **Network Folder/FTP** saves your scan file to a specified folder on a network.
   - **Email** lets you send scanned files through a pre-configured email server.
• **Document Capture Pro** lets you scan over a network using your saved job settings in Document Capture Pro or Document Capture.

**Note:** You cannot use this option to scan an image to Document Capture or Document Capture Pro when your product is connected to your computer's USB port.

• **Memory Device** saves your scan file on a USB device and lets you select the file format, quality, and other settings.

• **Cloud** sends your scanned files to a destination that you have registered with Epson Connect.

• **Computer (WSD)** lets you manage network scanning in Windows 10, Windows 8.x, Windows 7, or Windows Vista (English only). To use this feature, you must first set up a WSD (Web Services for Devices) port on your Windows 7 or Windows Vista computer (the port is set up automatically on Windows 10 and Windows 8.x).

6. Follow the instructions in the links below to complete your scan.

  Scanning to Email
  Adding and Assigning Scan Jobs with Document Capture Pro or Document Capture
  Scanning to a Memory Device
  Scanning to the Cloud
  Setting Up a WSD Port (Windows 7/Windows Vista)
  Control Panel Scanning Options

**Parent topic:** Starting a Scan

**Related tasks**

- Using Epson Scan to Cloud
- Using Presets
- Entering Characters on the LCD Screen

**Related topics**

- Placing Originals on the Product
- Scanning to Email

**Scanning to Email**

You can scan an original and email the scanned file using your product's control panel. You need to have a preconfigured email server before you can scan to email. You can enter email addresses directly on the product's control panel or select them from the **Recipient** tab. Make sure the date and time are set correctly so the time stamps on your emails are accurate.

**Note:** You can also use the Scan to Document Capture Pro function to scan and email the scanned file.
1. Place your original on the product for scanning.
   
   **Note:** To scan a double-sided or multi-page document, place all of the pages in the ADF.

2. Press the home button, if necessary.
3. Select **Scan**.
   
   You see a screen like this:

![Scan screen](image)

4. Select **Email**.
You see a screen like this:

5. Do one of the following:
   - Select an email address from any of the displayed frequent contacts.
   - Select the Recipient tab and choose one or more contacts.
   - Select Keyboard to use the on-screen keyboard to enter the email address for the recipient(s) and select OK.

6. Select Scan Settings.
7. Select File Format to choose the file format for your scan.
8. Scroll down to change the Subject and File Name, if necessary.
9. Select any additional scan settings as necessary.
10. Select Presets to save your scan settings.

   Note: Presets can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.
11. Select Send.
Your product scans your original and emails the scanned file.

**Parent topic:** [Starting a Scan Using the Product Control Panel](#)

**Adding and Assigning Scan Jobs with Document Capture Pro or Document Capture**

You can view, change, or add available default scan settings when you scan using the Document Capture Pro option on the product control panel. You do this by accessing the scan jobs in the Document Capture Pro (Windows) or Document Capture (Mac) program.

1. Start Document Capture Pro or Document Capture on a computer connected to the product.
2. Click the Manage Job icon from the toolbar at the top of the window.
   You see a window showing the current scan job list.
3. If you want to add a scan job, click Add or the + icon, enter a name for the new job, select settings as necessary, and click OK.
   You can now use the new scan job when you scan with Document Capture Pro or Document Capture.

   **Note:** See the Help information in Document Capture Pro or Document Capture for details.
4. If you want to assign scan jobs to the selection list on the product control panel, do one of the following:
   - **Windows:** Click Event Settings.
   - **Mac:** Click the gear icon at the bottom of the window, then click Event Settings.
5. Select the jobs that you want to assign to any of the pull-down menus.

You can now use the added scan jobs when you scan from the product control panel.

6. Click **OK**, then click **OK** again.

**Parent topic:** Starting a Scan Using the Product Control Panel

**Related topics**

Placing Originals on the Product

Scanning to a Memory Device

You can scan an original and save the scanned image to an external USB device connected to your product.

1. Insert an external USB device into the product's USB port.
2. Place your original on the product for scanning.

   **Note:** To scan a double-sided or multi-page document, place all of the pages in the ADF.

3. Press the home button, if necessary.
4. Select **Scan**.
   
   You see a screen like this:

![Scan screen](image)

5. Select **Memory Device**.
You see a screen like this:

6. Select options as necessary.
7. Select **Presets** to save your scan settings.

   **Note:** Presets can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

8. Select the **Save** icon.
   
   Your product scans your original and saves the scanned file to a memory device.

**Parent topic:** Starting a Scan Using the Product Control Panel

**Related topics**

Placing Originals on the Product

**Scanning to the Cloud**

You can use the control panel to send your scanned files to a destination that you have registered with Epson Connect.
Note: Make sure to set up your product using Epson Connect before using this feature.

1. Place your original on the product for scanning.
   
   **Note:** To scan a double-sided or multi-page document, place all of the pages in the ADF.

2. Press the \( \text{\textbullet} \) home button, if necessary.
3. Select **Scan**.
   
   You see a screen like this:

4. Select **Cloud**.
5. Press the + icon and select a cloud destination.
6. Select options as necessary.
7. Select Presets to save your scan settings.

   **Note:** Presets can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

8. Press the Upload icon.

   Your product scans your original and saves the scanned file to the selected destination.

**Parent topic:** Starting a Scan Using the Product Control Panel

**Related topics**

Placing Originals on the Product
Setting Up a WSD Port (Windows 7/Windows Vista)

You can scan to a networked Windows computer using WSD (Web Services for Devices). You must first set up a WSD port on your Windows 7 or Windows Vista system (the port is set up automatically on Windows 10 and Windows 8.x).

Before you set up a WSD port, make sure you installed your product software, and connected your product and computer to the same network.

1. Turn on your product.
2. Print a network status sheet so you can identify the network name and model name for your product on the network.
3. Click or Start and select Computer.
4. On the left side of the window, select Network.
5. Locate your product on the Network screen, right-click it, and select Install.
6. When you see the User Account Control screen, click Continue.

    Note: If you see an Uninstall screen, click Uninstall and repeat these steps as necessary.

7. When you see the message Your device is ready to use in the Windows taskbar, click the message.
8. On the Driver Software Installation screen, make sure your product is listed as Ready to use. Then click Close.
9. Do one of the following:
   - Windows 7: Click 🌐 and select Devices and Printers.
   - Windows Vista: Click Start and select Control Panel > Hardware and Sound > Printers.
10. Make sure that an icon appears for your product's name on the network.

When you use WSD, select your product name to scan over the network.

Parent topic: Starting a Scan Using the Product Control Panel

Related tasks

Printing a Network Status Sheet

Control Panel Scanning Options

Select the options you want to use for scanning.
Note: Not all options or settings may be available, depending on the Scan to option selected.

<table>
<thead>
<tr>
<th>Scan Settings</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit Location</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Communication Mode</strong></td>
<td></td>
<td>Select <strong>Network Folder (SMB)</strong> or <strong>FTP</strong></td>
</tr>
<tr>
<td><strong>Location</strong></td>
<td>Enter a folder path in which to save scanned images</td>
<td></td>
</tr>
<tr>
<td><strong>User Name</strong></td>
<td>Enter a user name for the selected folder path</td>
<td></td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Enter a password for the selected folder path</td>
<td></td>
</tr>
<tr>
<td><strong>Connection Mode</strong></td>
<td>Select the connection mode</td>
<td></td>
</tr>
<tr>
<td><strong>Port Number</strong></td>
<td>Enter a port number</td>
<td></td>
</tr>
<tr>
<td><strong>Recipient</strong></td>
<td>—</td>
<td>Select an email address or folder path to send or save scanned images</td>
</tr>
<tr>
<td><strong>B&amp;W</strong></td>
<td>—</td>
<td>Select to scan images in black and white</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>—</td>
<td>Select to scan images in color</td>
</tr>
<tr>
<td><strong>File Format</strong></td>
<td><strong>JPEG</strong></td>
<td>Select for photos. You can also select the Compression Ratio.</td>
</tr>
<tr>
<td></td>
<td><strong>PDF</strong></td>
<td>Select for documents. You can also select the Compression Ratio and PDF Settings.</td>
</tr>
<tr>
<td></td>
<td><strong>TIFF (Single Page)</strong></td>
<td>Select for scanned files that you can print from a device. Multi Page TIFF documents are scanned in black and white.</td>
</tr>
<tr>
<td></td>
<td><strong>TIFF (Multi Page)</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td><strong>200dpi</strong></td>
<td>Select for documents</td>
</tr>
<tr>
<td></td>
<td><strong>300dpi</strong></td>
<td>Select for photos</td>
</tr>
<tr>
<td></td>
<td><strong>600dpi</strong></td>
<td>Select for highest quality printing</td>
</tr>
<tr>
<td><strong>2-Sided</strong></td>
<td><strong>1-Sided</strong></td>
<td>Lets you scan 2-sided originals placed in the ADF. If you select 2-Sided, you can also select the Orientation (Original) and the Binding (Original).</td>
</tr>
<tr>
<td></td>
<td><strong>2-Sided</strong></td>
<td></td>
</tr>
<tr>
<td>Scan Settings</td>
<td>Available options</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Scan Area</td>
<td>Auto Detect</td>
<td>Select to automatically adjust the scan area</td>
</tr>
<tr>
<td></td>
<td>Various sizes</td>
<td>Select the page size for documents</td>
</tr>
<tr>
<td></td>
<td>Max Area</td>
<td>Select for most photos</td>
</tr>
<tr>
<td>Original Type</td>
<td>Text</td>
<td>Specify the type of original you are scanning</td>
</tr>
<tr>
<td></td>
<td>Text &amp; Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Photo</td>
<td></td>
</tr>
<tr>
<td>Mixed Size Originals</td>
<td>Off</td>
<td>Select <strong>On</strong> to scan originals of varying sizes in their original sizes</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Density</td>
<td>Varying levels</td>
<td>Adjust the lightness or darkness of scanned images.</td>
</tr>
<tr>
<td>Remove Background</td>
<td>Auto</td>
<td>Detect the background colors of the originals and remove or lighten them automatically</td>
</tr>
<tr>
<td></td>
<td>Varying levels</td>
<td>Adjust the darkness of the background of scanned images</td>
</tr>
<tr>
<td>Remove Shadow</td>
<td>Off</td>
<td>Erase the shadows that appear in the center of a document when copying a book or the shadows that appear around a document when copying thick paper</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Remove Punch Holes</td>
<td>Off</td>
<td>Erase the binding holes on a document</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>ADF Continuous Scan</td>
<td>Off</td>
<td>Select <strong>On</strong> to scan a large number of originals placed in the ADF as one scanning job</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Subject</td>
<td>—</td>
<td>Enter a subject for your email</td>
</tr>
<tr>
<td>Attached File Max Size</td>
<td>Various sizes</td>
<td>Select the maximum file size that can be attached to an email</td>
</tr>
<tr>
<td>File Name</td>
<td>—</td>
<td>Enter a prefix, the date, and the time to the file name for your scanned file</td>
</tr>
</tbody>
</table>

**Parent topic:** Starting a Scan Using the Product Control Panel
Setting Up and Scanning to a Network Folder or FTP Server

Before you can scan to a network folder on your computer or on an FTP server, you need to create a shared folder and optionally register its location to your product's contact list. Select the links below as necessary to create and register the folder, and to scan to it over the network.

Creating a Shared Network Folder

Registering Contacts for Network Folder or FTP Scanning - Web Config
Registering Contacts for Email, Network, or FTP Scanning - Control Panel
Scanning to a Network Folder or FTP Server

Parent topic: Starting a Scan

Creating a Shared Network Folder

You can create a shared network folder on your computer or an FTP site and register its location to your product's Contacts list.

Note: If you are creating a shared network folder on a Mac, see your Mac documentation for instructions on creating the folder. The instructions here are for Windows.

First make sure you connected your product and computer to the same network.

Note: If you are running a Home version of the Windows operating system, you cannot create a shared folder on your Windows desktop or in the Documents or Pictures folder unless you have created a Home Group Configuration for sharing. You can, however, create a shared folder in the root of the C: drive on your system.

If you want to scan to a folder on an FTP server, contact the FTP server administrator for the server address and authentication access to a shared folder on the server.

1. If you are scanning to a network folder on your computer, do one of the following to check the format of your computer name:

   - Windows 10 or Windows 8.x: Hold down the Windows key on your keyboard and press the X key. Select System from the list that appears. Check the Computer Name or Device Name listed for your computer on the System window.

   - Windows 7: Click 🎈, right-click Computer, and select Properties. Check the Computer Name listed for your computer on the System window.

Note: The settings in these steps may vary, depending on your version of Windows. See Windows Help for details on your operating system.
2. If the computer's name uses any characters that are not alphanumeric (letters or numbers), do one of the following to change the computer's name:
   • **Windows 10 or 8.x**: Select **Rename this PC** and follow the on-screen prompts.
   • **Windows 7**: Select **Change Settings**, change the computer's name, and click **OK**. (See Windows Help for instructions, if necessary.)

   **Note:** You need to be logged into Windows as an administrator to change the computer's name. After changing the name, restart your computer.


4. Create a folder on the Windows desktop with a folder name of 12 characters or less; otherwise, your product may not be able to access the folder.

   **Note:** You need to be logged into Windows as an administrator to access the desktop folder and the document folder under each User folder.

5. Right-click the folder you created and select **Properties**.

6. On the **General** tab, deselect the **Read-only** checkbox to allow users to access the folder over the network.

7. Select the **Sharing** tab and click the **Advanced Sharing** button.

   **Note:** You need to be logged into Windows as an administrator to select the **Advanced Sharing** button.

8. On the Advanced Sharing screen, select the **Share this folder** checkbox.

9. Click the **Permissions** button and select the following on the Share Permissions tab:
   • Select **Everyone** under Group or user names.
   • Select the checkbox in the **Allow** column for the **Change** setting.

10. Click **OK** to save the settings, then click **OK** again to close the Advanced Sharing window.

11. Select the **Security** tab and check that the Group or user names list at the top includes the current computer user and the administrators who can now access the folder.

12. Select the **Sharing** tab again and write down the **Network Path** listed under Network File and Folder Sharing at the top. This is the path you will register to your product contacts list so you can select it for network scanning.
13. Click **OK** or **Close**.

Now you can register the folder path to your product contacts list.

**Parent topic:** Setting Up and Scanning to a Network Folder or FTP Server

### Registering Contacts for Network Folder or FTP Scanning - Web Config

You can register a list of contacts for scanning to a network folder or FTP server using Web Config and your computer's internet browser.

Before you begin, print a network status sheet and locate the IP address for your product on the sheet.

**Note:** These instructions use Internet Explorer as an example browser.

1. Start Internet Explorer on a computer that is using the same network as your product.
2. Type your product's IP address into the address bar and press **Enter**.
3. Click **Continue to this website (not recommended)**.
4. Click **Contacts**.
5. Select the number you want to use for the contact you are adding and click **Edit**.
6. Select **Network Folder (SMB)** or **FTP** as the **Type** setting.
7. Enter the following information for the contact:
   - **Name**: The name to display in your product's contact list.
   - **Index Word**: Enter a word to identify this entry when searching for it (up to 30 characters). This field is optional.
   - **Assign to Frequent Use**: If you want to identify the contact as a frequently used address, select **On**. This makes it quicker to select the contact when you scan.
   - **Save to**: The network path to the shared folder.
     - **SMB**: host_name\folder
     - **FTP**: host_name/folder_name
   - **User Name** and **Password**: Enter only if you have set up a password on your computer.
   - **Connection Mode**: For FTP locations, select **Passive Mode** if there is a firewall between the product and FTP server.
   - **Port Number**: For FTP locations, enter the port number.
8. Click **Apply**.  
   After a moment, you see a message telling you that contact registration is complete.


**Parent topic:** Setting Up and Scanning to a Network Folder or FTP Server

**Related tasks**

- Printing a Network Status Sheet

### Registering Contacts for Email, Network, or FTP Scanning - Control Panel

You can create a list of contacts for scanning to email or to a network folder or FTP.

**Note:** Contacts can be locked by an administrator. If you cannot access or change contacts, contact your administrator for assistance. You can create up to 2,000 contacts and contact groups combined (including fax contacts).

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **Contacts Manager**.
4. Select **Add/Edit/Delete**.
You see a screen like this:

5. Select **Add New**.
6. Select **Add Contact**.
7. Do one of the following:
   - To create a contact for scanning to fax, select **Fax** (WF-C17590/WF-C20590/WF-M20590F).
   - To create a contact for scanning to email, select **Email**.
   - To create a location for scanning to a network folder or FTP, select **Network Folder/FTP**.
8. Select the number you want to use for the contact you are adding.
9. Select the **Name** field. Use the on-screen keyboard to enter the contact name (up to 30 characters) and select **OK**.
10. Select the **Index Word** field. Use the on-screen keyboard to enter a word to use when searching for an entry (up to 30 characters) and select **OK**. (This field is optional.)
11. Do one of the following:
   - For a fax contact (WF-C17590/WF-C20590/WF-M20590F), select the **Fax Number** field. Use the displayed keyboard to enter the fax number and select **OK**.
Select any other fax settings as necessary.

- For an email contact, select the Email Address field. Use the on-screen keyboard to enter the address and select OK.
- For a network folder or FTP location, select the Communication Mode field and select Network Folder (SMB) or FTP. Then select the Location field, use the on-screen keyboard to enter the location, and select OK. Enter other information if necessary.

Enter the folder path name for the Location setting in one of the following formats depending on the Communication Mode setting you selected:

- SMB: \host name\folder
- FTP: ftp://host name/folder name

12. Select OK.

**Note:** If you need to edit or delete scanning contacts, the procedures are the same as for fax contacts.

**Parent topic:** Setting Up and Scanning to a Network Folder or FTP Server

**Related tasks**

- Entering Characters on the LCD Screen

**Related topics**

- Setting Up Contacts Using the Product Control Panel

**Scanning to a Network Folder or FTP Server**

You can scan an image and save it to a network folder using your product’s control panel. You can either enter the folder path directly on the product’s control panel or select a folder from the Destination tab.

**Note:** Make sure the date and time are set correctly before using this feature.

1. Place your original on the product for scanning.

   **Note:** To scan a double-sided or multi-page document, place your originals in the ADF.

2. Press the home button, if necessary.

3. Select Scan.
You see a screen like this:

4. Select **Network Folder/FTP**.
5. Do one of the following:
   • Select the **Destination** tab and choose a saved location.
   • Select **Keyboard**, select the **Communication Mode** field, and select **Network Folder (SMB)** or **FTP**. Then select the **Location** field, enter the folder location, and select **OK**. Enter other information as necessary.
   
   Enter the folder path name for the **Location** setting in one of the following formats depending on the **Communication Mode** setting you selected:
   • **SMB**: \host name\folder
   • **FTP**: ftp://host name/folder name
   • Select an email address from any displayed frequent contacts.

6. Select **Scan Settings**.
7. Select **File Format** to choose the file format for your scan.
8. Scroll down to select **File Name** and change it if necessary.
9. Select any additional scan settings as necessary.
10. Select **Presets** to save your scan settings.

   **Note:** Presets can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

11. Select ![Save](image)

   Your product scans your original and saves it in the selected location.

**Parent topic:** Setting Up and Scanning to a Network Folder or FTP Server

**Related references**

- [Control Panel Scanning Options](#)

**Related tasks**

- [Selecting the Date and Time](#)
- [Entering Characters on the LCD Screen](#)
- [Registering Contacts for Email, Network, or FTP Scanning - Control Panel](#)

**Related topics**

- [Placing Originals on the Product](#)

**Starting a Scan Using the Epson Scan 2 Icon**

You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned image to a file.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

- **Windows 10:** Click ![EPSON](image) and select **EPSON > Epson Scan 2.**
- **Windows 8.x:** Navigate to the **Apps** screen and select **Epson Scan 2.**
- **Windows (other versions):** Click ![Start](image) or **Start**, and select **All Programs** or **Programs**. Select **EPSON > Epson Scan 2 > Epson Scan 2.**
- **Mac:** Open the **Applications** folder, open the **Epson Software** folder, and select **Epson Scan 2.**
You see an Epson Scan 2 window like this:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanner</td>
<td>EPSON</td>
</tr>
<tr>
<td>Scan Settings</td>
<td>Not Selected</td>
</tr>
<tr>
<td>Document Source</td>
<td>Auto Detect</td>
</tr>
<tr>
<td>Scanning Side</td>
<td>Single-Sided</td>
</tr>
<tr>
<td>Document Size</td>
<td>Auto Detect</td>
</tr>
<tr>
<td>Image Type</td>
<td>Color</td>
</tr>
<tr>
<td>Resolution</td>
<td>200 dpi</td>
</tr>
<tr>
<td>Stitch Images</td>
<td>Off</td>
</tr>
<tr>
<td>Rotate</td>
<td>0°</td>
</tr>
<tr>
<td>Correct Document Skew</td>
<td>Off</td>
</tr>
<tr>
<td>Add or edit pages after scanning</td>
<td>Off</td>
</tr>
<tr>
<td>Skip Blank Pages</td>
<td>Off</td>
</tr>
<tr>
<td>Detect Double Feed</td>
<td>On</td>
</tr>
<tr>
<td>Image Format</td>
<td>Searchable PDF</td>
</tr>
<tr>
<td>File Name</td>
<td>img20170413_10045712.pdf</td>
</tr>
<tr>
<td>Folder</td>
<td>Documents</td>
</tr>
</tbody>
</table>
Starting a Scan from a Scanning Program

You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings, scan, and open the scanned image in the program.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

1. Open your scanning program and select its scanning option. (See your scanning program help for instructions.)
2. Select your product.

**Note:** In certain programs, you may need to select your product as the "source" first. If you see a **Select Source** option, choose it and select your product. With Windows, do not select a **WIA** option for your product; not all scan functions will be available.
You see an Epson Scan 2 window like this:
You can start a scan from a smart device using the Epson iPrint app. You can save the scanned document to your device or a cloud service, e-mail it, or print it.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

**Note:** Your device must be connected to the same wireless network as your Epson product. If you have an NFC-enabled device, you can also scan with the Epson iPrint app by placing the device against the NFC tag on the front of the product.

1. Download the Epson iPrint app from your device’s app store or from Epson’s website.
2. Place your original on the product for scanning.
3. Open the Epson iPrint app and select your product.
4. Select the scan settings and scan your original.
5. Save your scanned image to a file or cloud location.

**Parent topic:** Starting a Scan

**Related tasks**

Using the Epson iPrint Mobile App

**Related topics**

Placing Originals on the Product

---

**Scanning with Document Capture Pro or Document Capture**

When you scan with Document Capture Pro (Windows) or Document Capture (Mac), the program automatically saves your scanned file on your computer in the folder you specify. You can select settings, preview, and change the scanned file settings as necessary.
1. Do one of the following to start Document Capture Pro or Document Capture:
   • **Windows 10**: Click and select **EPSON Software > Document Capture Pro**.
   • **Windows 8.x**: Navigate to the **Apps** screen and select **Document Capture Pro**.
   • **Windows (other versions)**: Click or **Start**, and select **All Programs** or **Programs**. Select **EPSON Software > Document Capture Pro**.
   • **Mac**: Open the **Applications** folder, open the **Epson Software** folder, and select **Document Capture**. Select your product and click **OK**, if necessary.

   You see a window like this:

   ![Document Capture Pro window](image)

2. Click the **Scan icon**.
You see a window like this:

3. If you want to use a scan job that you created instead, select it from the Job list in the Document Capture Pro or Document Capture window, click the Start Job button, and skip the rest of these steps.

4. Select any displayed scan settings you want to use.

   **Note:** See the Help information in Document Capture Pro or Document Capture for details.

5. If you want to select detailed scan settings, do one of the following:
   - **Windows:** Click **Detailed Settings**. Select any displayed scan settings you want to use and click **OK**.
   - **Mac:** If you installed Epson Scan 2, close the Scan Settings window, open the **Scan** menu at the top of the screen and select **Displays the EPSON Scan Setup Screen**. Click the **Scan** icon. Select any displayed scan settings you want to use and click **OK**.
6. Click **Scan**.
   You see a preview of your scan in the Document Capture Pro or Document Capture window.

7. Check the scanned images and edit them as necessary.

8. Click one of the Destination icons to choose where to save your scanned file.

```
Destination icons
```

**Note:** You may need to click the arrow next to the icons in order to see all of them. The available icons may vary, depending on the software version you are using.

9. Select settings as necessary, then click **OK**, **Send**, or **Print** to save the scanned file.

**Parent topic:** Scanning

**Related topics**

**Placing Originals on the Product**

---

### Scanning in Epson Scan 2

Epson Scan 2 gives you access to basic and advanced scanning features. You can scan your document and save the scanned image in various file formats in your operating system's Documents or My Documents folder, or open it in your scanning program. You can preview the scanned image and select or change settings as necessary.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

1. Start Epson Scan 2.
You see this window:
2. Select the **Document Source** setting that matches where you placed your original, or select **Auto Detect** to have Epson Scan 2 automatically detect the source.

3. Select the **Scanning Side** setting if you are scanning from the ADF.

4. Select the **Document Size** setting that matches the size of your original, or select **Auto Detect** to have Epson Scan 2 automatically detect the size. You can select **Customize** to enter a custom size, if necessary.

5. Select the image type of your original and how you want it scanned as the **Image Type** setting.

6. Select the **Resolution** setting you want to use for your scan.

7. Click the **Preview** button.

   Epson Scan 2 previews your original and displays the results in the Epson Scan 2 window.

8. Reinsert your original into the ADF, if necessary.

9. Select any of the additional settings that you want to use on the Main Settings tab.

10. Click the **Advanced Settings** tab and select any settings that you want to use.

11. Select the format in which you want to save your scanned file as the **Image Format** setting. If necessary, select **Options** and select any desired format options.
12. Enter the file name for your scanned file in the **File Name** field. If necessary, select **Settings** to modify the file name settings.

13. Select the location in which you want to save your scanned file as the **Folder** setting. If necessary, select **Select** to create a new folder.

14. Click **Scan**.

   The product scans your original and saves the scanned file in the location you specified.

---

**Additional Scanning Settings - Main Settings Tab**

You can select these additional scanning settings on the Epson Scan 2 Main Settings tab. Not all adjustment settings may be available, depending on other settings you have chosen.

**Stitch Images**

When scanning double-sided originals, lets you lay out images from both sides of the original onto one scanned page.

**Rotate**

Rotates the original image clockwise to the desired angle before scanning it. Select **Auto** to allow your product to automatically rotate the image based on the orientation of the text (may take longer to scan).

**Correct Document Skew**

Corrects skewed originals, image contents, or both.

**Add or edit pages after scanning**

Lets you add, remove, or edit the pages in a scan, including rotating pages and changing the page order.

**Note:** To save multiple pages in a single file, you must select a file format that supports multiple pages such as **PDF** or **Multi-TIFF**. If you select another file format, each scanned image or page is saved as a separate file.
Skip Blank Pages
If the scanner detects marks from the other side of a blank page and adds the marks to the scanned image, adjust this setting to prevent this.

Detect Double Feed
Detects a double-feed paper error in the ADF. If you are scanning an original envelope or plastic card, select Off.

Parent topic: Scanning in Epson Scan 2

Additional Scanning Settings - Advanced Settings Tab
You can select these additional scanning settings on the Epson Scan 2 Advanced Settings tab. Not all adjustment settings may be available, depending on other settings you have chosen.

Remove Background
Removes the background of the originals.

Text Enhancement
Sharpen the appearance of letters in text documents.

Auto Area Segmentation
Makes black and white images clearer and text recognition more accurate by separating the text from the graphics.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in OCR (Optical Character Recognition) programs.

Color Enhance
Enhances the shades of the color you select in the scanned image. This setting is available only if you select Grayscale or Black & White as the Image Type setting.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Gamma
Adjusts the midtone density of the scanned image.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.
Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This option improves results when scanning magazines or newspapers. (The results of descreening do not appear in the preview image, only in your scanned image.)

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with black or white.

Dual Image Output
Scans the original image twice using different output settings (Windows only).

Parent topic: Scanning in Epson Scan 2

Saving Scanned Documents as a Searchable PDF Using Epson Scan 2

You can scan a document and save the text in a searchable PDF. In a searchable PDF, text is recognized using Optical Character Recognition (OCR) and then embedded in the scanned original.

Note: The required Epson Scan 2 OCR Component is installed automatically when you install your product software. If you install your scanner software programs individually, be sure to also install this component if you want to perform OCR.

1. Load your original in the product for scanning.
2. Start Epson Scan 2.
3. Select your scan settings.
4. Click Preview and adjust the area you want to scan, if necessary.
5. If you are using the ADF, reload the ejected original.
6. Select Searchable PDF as the Image Format setting.
7. Select Options from the Image Format list.
You see this window:

8. Select any of the options on the **General** tab.
9. Select the **Text** tab.
10. Make sure the language used in the document text is selected as the **Text Language** setting.
11. Click **OK**.
12. Confirm the **File Name** setting and select a **Folder** setting for your document.
13. Click **Scan**.

The scanned image is saved as a searchable PDF.

**Parent topic:** Scanning in Epson Scan 2

**Related topics**

- Placing Originals on the Product
Image Format Options

You can select different image formats and related options. For details on available options, click the ? icon on the Epson Scan 2 Image Format Options window. Not all image formats have options.

BITMAP (*.bmp)
A standard image file format for most Windows programs.

JPEG (*.jpg)
An image format that lets you highly compress image data. However, the higher the compression, the lower the image quality. (The TIFF format is recommended when you need to modify or retouch your scanned image.)

PNG (*.png)
An image format that does not lose quality during editing.

TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP software.

Multi-TIFF (*.tif)
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images using a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or other programs. You can save multi-page documents in one PDF file.

Searchable PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or other programs. You can save multi-page documents in one PDF file. Recognized text in the scanned document can be searched.

Parent topic: Scanning in Epson Scan 2

Scan Resolution Guidelines

The Resolution setting, measured in dpi (dots per inch), controls the amount of detail captured in your scans. Increasing the resolution raises the amount of detail captured but comes with the following disadvantages:

• Larger file sizes
• It takes longer to scan your originals, send/receive your scans by email or fax, and to print your scans
• The image may become too large to fit on your display or print on paper
If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the resolution from the default resolution set by Epson Scan 2. Follow these guidelines to determine the resolution setting you need:

• You will scan the image at its original size but enlarge it later in an image-editing program.
  Increase the Epson Scan 2 Resolution setting in your scan. Increase the resolution by the same amount you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi (dots per inch) and you will double the image size later, change the Resolution setting to 600 dpi.

• You will scan the image at 100% or a smaller size.
  Select the Epson Scan 2 Resolution setting based on how you will use the scanned image:
  • Email/view on a computer screen/post on the web: 96 to 200 dpi
  • Print/fax/convert to editable text (OCR)/create searchable PDF: 200 to 300 dpi

Parent topic: Scanning in Epson Scan 2

Scanning Special Projects
Your product's scanning software offers various options to help you quickly complete special scan projects.

Scanning to a SharePoint Server or Cloud Service
Scanning Multi-Page Originals as Separate Files

Parent topic: Scanning

Scanning to a SharePoint Server or Cloud Service
You can use Document Capture Pro to upload scanned images to a SharePoint server or a cloud service.

1. Do one of the following to start Document Capture Pro:
   • **Windows 10**: Click 📱 and select **EPSON Software > Document Capture Pro**.
   • **Windows 8.x**: Navigate to the **Apps** screen and select **Document Capture Pro**.
   • **Windows (other versions)**: Click 📱 or **Start**, and select **All Programs** or **Programs**. Select **EPSON Software > Document Capture Pro**.
   • **Mac**: Open the **Applications** folder, open the **Epson Software** folder, and select **Document Capture**. Select your product and click **OK**, if necessary.
You see a window like this:

2. Click the **Scan** icon.
3. Select any displayed scan settings you want to use.
   
   **Note:** See the Help information in Document Capture Pro or Document Capture for details.
4. Click **Scan**.
   
   You see a preview of your scan in the Document Capture Pro or Document Capture window.
5. Click one of the cloud service Destination icons to choose where to save your scanned file.
   
   - Web Folder (WebDAV)
   - Evernote (Windows only)
   - Google Drive
   - SugarSync
• **Microsoft SharePoint server (Windows only)**

**Note:** You may need to click the arrow next to the icons in order to see all of them. The available icons may vary, depending on the software version you are using.

6. Select your Destination settings.

**Note:** The settings may vary, depending on the software version you are using. See the Help information in Document Capture Pro or Document Capture for details.

7. Select any other scan settings as necessary, and click **Send**.

Your originals are scanned and uploaded to the indicated server.

**Note:** You can also create a scan job for uploading scanned images to a SharePoint server or a cloud service. You can use the scan job when you scan with Document Capture Pro or Document Capture or when you scan using the Document Capture Pro option on the product control panel.

**Parent topic:** Scanning Special Projects

### Scanning Multi-Page Originals as Separate Files

You can use Document Capture Pro (Windows only) to scan multi-page originals as separate scanned files. You indicate where you want the new scanned files to start by inserting a blank page or barcode between the pages of your original.

**Note:** The settings may vary, depending on the software version you are using. See the Help information in Document Capture Pro for details.

1. Load a multi-page original with blank pages or barcodes inserted where you want to start a new scanned file.

2. Do one of the following to start Document Capture Pro:
   - **Windows 10:** Click 🖱 and select **EPSON Software > Document Capture Pro**.
   - **Windows 8.x:** Navigate to the **Apps** screen and select **Document Capture Pro**.
   - **Windows (other versions):** Click 📱 or **Start**, and select **All Programs** or **Programs**. Select **EPSON Software > Document Capture Pro**.
You see this window:

3. Click the **Scan** icon.
4. Select any displayed scan settings you want to use.
   
   **Note:** See the Help information in Document Capture Pro for details.

5. Click **Scan**.
   
   You see a preview of your scan in the Document Capture Pro window.

6. Open the **File** menu and select **Batch Save**.
7. Click **File Name Settings**.
8. Select **Apply Job Separation** and click **Separation Settings**.
9. Select the method you used to separate the originals, select a folder name specification and click **OK**.
10. Select any other settings from the File Name settings window as necessary and click **OK**.
11. Select any other settings from the Batch Save window as necessary and click **OK**.
Your originals are saved into separate files as specified.

**Note:** You can also create a scan job for scanning multi-page originals as separate scanned files. You can use the scan job when you scan with Document Capture Pro or when you scan using the Document Capture Pro option on the product control panel.

**Parent topic:** Scanning Special Projects

### Entering a User ID and Password for Scanning

If you enabled Access Control on your product, a user ID and password may be required to scan. You can enter the user ID and password in Epson Scan 2.

**Note:** If you do not know the user ID or password, contact your administrator for assistance.

1. Start Epson Scan 2.
2. Select **Settings** from the **Scanner** drop-down list.
   
   You see this window:

   ![Scanner Settings window](image)

3. Select **Access Control**.
4. Enter your user name and password.
5. Click **OK**.
Parent topic: Scanning
Faxing

See these sections to fax using your product (WF-C17590/WF-C20590/WF-M20590F).

**Note:** This product allows you to store names, telephone numbers, and fax data in its memory even when the power is turned off. Make sure you restore all of the default settings if you give away or dispose of the product. This will erase all of your network settings and fax data.

**Note:** When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product, you can fax using the printer buttons or the utilities included with the standard Epson printer software. To download the standard Epson printer software, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

Connecting a Telephone or Answering Machine
Setting Up Fax Features
Setting Up Contacts and Contact Groups
Sending Faxes
Receiving Faxes
Checking Fax Status and Cancelling Fax Jobs
Printing Fax Reports

**Connecting a Telephone or Answering Machine**

You must connect your product to a telephone wall jack to send or receive faxes. If you want to use the same telephone line to receive calls, you can connect a telephone or answering machine to your product using an additional phone cable.

**Note:** If you do not connect a telephone to your product, make sure **Receive Mode** is set to **Auto**. Otherwise, you cannot receive faxes.
1. Connect a phone cable to your telephone wall jack and to the **LINE** port on your product.

**Note:** If you have a DSL or ISDN connection, you must connect the appropriate DSL filter, or ISDN terminal adapter or router to the wall jack to be able to use the line for faxing or voice calls using your product. Contact your DSL or ISDN provider for the necessary equipment.
DSL connection

1  Telephone wall jack
2  DSL filter
3  DSL modem
ISDN connection

1  ISDN wall jack
2  Terminal adapter or ISDN router
2. If you are connecting a telephone or answering machine to your product using a second phone cable, remove the cap from the **EXT** port on your product.
3. Connect a second phone cable to your telephone or answering machine and to the **EXT** port on your product.

**Note:** If you connect an answering machine and **Receive Mode** is set to **Auto**, set the number of rings before your product answers a call to a number that is higher than your answering machine’s setting for the number of rings.

Any phone or answering machine must be connected to the **EXT** port for your product to detect an incoming fax call when the phone is picked up. Epson cannot guarantee compatibility with VoIP, cable phone systems, or fiberoptic digital services such as FIOS.

**Parent topic:** Faxing

**Related references**

- [Cannot Receive Faxes with a Telephone Connected to Your Product](#)

**Related tasks**

- [Setting the Number of Rings to Answer](#)
- [Receiving Faxes Automatically](#)
Using the Fax Setup Wizard

Setting Up Fax Features

Before faxing with your product, set up your fax header and select the fax features you want to use.

**Note:** If you leave your product unplugged for a long period of time, you may need to reset the date and time settings for faxes.

**Setting Up Basic Fax Features**

Select the line type

Setting the number of rings to answer

**Parent topic:** Faxing

Setting Up Basic Fax Features

See these sections to select the basic settings you need to use the product's fax features.

**Using the Fax Setup Wizard**

Select the line type

Setting the number of rings to answer

**Parent topic:** Setting Up Fax Features

Using the Fax Setup Wizard

You can setup the product's basic fax settings using the Fax Setting Wizard. This wizard is automatically displayed when the product is turned on for the first time. You can also change these settings individually from the Fax Settings menu.

**Note:** These settings can be locked by an administrator. If you cannot access or change these settings, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
4. Select **Fax Settings**.
You see this screen:

5. Select Fax Setting Wizard.
6. Make sure a phone line is connected and select Proceed.
7. Use the on-screen keyboard to enter the sender name for your fax source, such as your name or a business name. You can enter up to 40 characters. Select OK.
8. Use the on-screen keyboard to enter your fax number, up to 20 characters and select OK.

Note: The name and phone number you enter appears in the fax header on the faxes you send.

9. On the Distinctive Ring Setting screen, do one of the following:
   • If you have subscribed to a distinctive ring service from your telephone company, select Proceed. Select the ring pattern to use for incoming faxes. Go to step 12.
   • If you do not have a distinctive ring service, select Skip and go to the next step.

Note: Distinctive ring services allows you to have several phone numbers on one phone line. Each number is assigned a different ring pattern. You can use one number for voice calls and another for
fax calls. Select the ring pattern assigned to fax calls in the Distinctive Ring Setting. If you select a ring pattern other than All, Receive Mode is automatically set to Auto.

10. On the Receive Mode Setting screen, do one of the following:
   - If you have connected an external telephone or answering machine to the product, select Yes and go to the next step.
   - If you did not connect an external telephone or answering machine, select No and go to step 12. (Receive Mode is automatically set to Auto; otherwise you cannot receive faxes.)

11. On the next Receive Mode Setting screen, select Yes to receive faxes automatically or select No to receive faxes manually.

   Note: If you connect an external answering machine and select to receive faxes automatically, make sure the Rings to Answer setting is correct. If you select to receive faxes manually, you need to answer every call and use the product’s control panel or your phone to receive faxes.

12. On the Proceed screen, confirm the displayed settings and select Proceed, or press the back arrow to change the settings.

13. On the Run Check Fax Connection screen, select Start Checking and follow the on-screen instructions to check the fax connection and print a report of the check result. If there are any errors reported, try the solutions on the report and run the check again.

   Note: If the Select Line Type screen appears, select the correct line type. If the Select Dial Tone Detection screen appears, select Disable. However, disabling the dial tone detection function may drop the first digit of a fax number and send the fax to the wrong number.

Parent topic: Setting Up Basic Fax Features

Related tasks
Entering Characters on the LCD Screen

Selecting the Line Type

If you connect the product to a PBX phone system or terminal adapter, you must change the product’s line type. PBX (Private Branch Exchange) is used in office environments where an external access code such as “9” must be dialed to call an outside line. The default Line Type setting is PSTN (Public Switched Telephone Network), which is a standard home phone line.

Note: This setting can be locked by an administrator. If you can’t access or change this setting, contact your administrator for assistance.
1. Press the home button, if necessary.
2. Select Settings.
4. Select Fax Settings.
   You see this screen:

   ![Image of fax settings screen]

5. Select Basic Settings.
6. Select Line Type.
7. Select PBX.
You see this screen:

8. Select **Access Code**.
9. Select **Use**.
10. Select the Access Code field, and use the on-screen keyboard to enter the access code, such as 9. Select **OK**.
11. Press the ⏯️ home button to return to the home screen.

**Parent topic:** Setting Up Basic Fax Features

### Setting the Number of Rings to Answer

If you connect an external answering machine and select to receive faxes automatically, make sure the **Rings to Answer** setting is correct. The number of rings should be higher than the number of rings your answering machine is set to for answering a call.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the ⏯️ home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
4. Select **Fax Settings**.
   
   You see this screen:

![Settings Menu](image)

5. Select **Basic Settings**.
6. Scroll down and select **Rings to Answer**.
You see this screen:

![Settings screen](image)

7. Select the number of rings and select OK. Make sure to select a number higher than the number of rings your answering machine is set to for answering a call.

8. Press the home button to return to the home screen.

**Note:** An answering machine picks up every call faster than the product, but the product can detect fax tones and start receiving faxes. If you answer the phone and hear a fax tone, check that the product has started receiving the fax, then hang up the phone.

**Parent topic:** Setting Up Basic Fax Features

### Selecting Advanced Fax Settings

You can select a variety of advanced fax settings.

**Note:** These settings can be locked by an administrator. If you cannot access or change these setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
4. Select **Fax Settings**.
   
   You see a screen like this:

![Settings screen](image)

5. Select the group of settings you want to change.
   - **User Settings - Fax**
   - **Basic Settings - Fax**
   - **Send Settings - Fax**
   - **Receive Settings - Fax**
   - **Report Settings - Fax**
   - **Security Settings - Fax**

**Parent topic:** Setting Up Fax Features

**User Settings - Fax**

Set options to customize the main fax screen.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Tab</td>
<td>Frequent</td>
<td>Selects the tab that first appears when you select Fax from the home screen</td>
</tr>
<tr>
<td></td>
<td>Recipient</td>
<td></td>
</tr>
<tr>
<td>Quick Operation Button</td>
<td>1 to 4</td>
<td>Sets up to four frequently used fax settings</td>
</tr>
</tbody>
</table>

**Parent topic:** Selecting Advanced Fax Settings

**Basic Settings - Fax**

Set the basic options you want to use for incoming and outgoing faxes.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax Speed</td>
<td>Fast(33,600bps)</td>
<td>Sets the speed at which you send and receive faxes</td>
</tr>
<tr>
<td></td>
<td>Medium(14,400bps)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slow(9,600bps)</td>
<td></td>
</tr>
<tr>
<td>ECM</td>
<td>On</td>
<td>Turns on Error Correction Mode (ECM) to automatically correct errors in sent or received fax data</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Turns off Error Correction Mode (ECM); color faxes cannot be sent or received</td>
</tr>
<tr>
<td>Dial Tone Detection</td>
<td>On</td>
<td>Automatically dials the number you enter for faxing when the product detects a dial tone</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Turns off automatic dial tone detection, which may be necessary if the product is connected to a PBX (Private Branch Exchange) or a TA (Terminal Adapter). However, turning this setting off may cause the product to drop the first digit of a fax number.</td>
</tr>
<tr>
<td>Dial Mode</td>
<td>Tone</td>
<td>Selects a tone dialing system and assigns each number a tone during dialing</td>
</tr>
<tr>
<td></td>
<td>Pulse</td>
<td>Select a pulse dialing system and assign numbers a series of pulses during dialing. You can temporarily switch to <strong>Tone</strong> by pressing * during dialing.</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Line Type</td>
<td>PSTN</td>
<td>Selects a standard phone line (Public Switched Telephone Network)</td>
</tr>
<tr>
<td></td>
<td>PBX</td>
<td>Selects Private Branch Exchange, the type of phone line used in office environments where an access code such as 9 must be used to call an outside line.</td>
</tr>
<tr>
<td>Header</td>
<td>Fax Header</td>
<td>Select to enter the header information and your phone number for inclusion on outgoing faxes</td>
</tr>
<tr>
<td></td>
<td>Your Phone Number</td>
<td>Lets you confirm whether an incoming fax should be printed; a telephone must be connected to the product</td>
</tr>
<tr>
<td>Receive Mode</td>
<td>Manual</td>
<td>Automatically receives and prints faxes</td>
</tr>
<tr>
<td></td>
<td>Auto</td>
<td>Lets you start receiving faxes using your phone instead of using the product control panel (if Receive Mode is set to Auto). When you select On, you must also enter a Start Code.</td>
</tr>
<tr>
<td>Distinctive Ring</td>
<td>All</td>
<td>If you are using a Distinctive Ring Service on your phone line, your telephone company can assign two or more phone numbers to the same line and assign different ring patterns to each. If you use this service, select the number of rings for your fax number so your product can receive faxes on the correct number of rings. Select All for phones lines that do not use this service.</td>
</tr>
<tr>
<td></td>
<td>Single</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Double</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Triple</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Double&amp;Triple</td>
<td></td>
</tr>
<tr>
<td>Rings to Answer</td>
<td>1 to 9</td>
<td>Sets the number of rings before your product receives a fax. If Receive Mode is set to Auto and an answering machine is connected to the product, make sure this setting is set higher than the number of rings your answering machine is set to answer a call.</td>
</tr>
<tr>
<td>Remote Receive</td>
<td>Off</td>
<td>Lets you start receiving faxes using your phone instead of using the product control panel (if Receive Mode is set to Auto). When you select On, you must also enter a Start Code. If you are using a cordless handset with its base connected to the product, you can start receiving the fax by entering the code using the handset.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Start Code</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rejection Fax</td>
<td>Various options</td>
<td>Lets you automatically reject faxes from blocked numbers, with blank headers, or from unrecognized contacts</td>
</tr>
<tr>
<td>Receiving Paper Size</td>
<td>Various options</td>
<td>Selects the paper size for incoming faxes</td>
</tr>
</tbody>
</table>

Parent topic: Selecting Advanced Fax Settings

Related tasks
Selecting the Date and Time
Starting a Scan Using the Product Control Panel

Related topics
Setting Up Contacts and Contact Groups

Send Settings - Fax
Set the send options you want to use for outgoing faxes.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Rotation</td>
<td>Off</td>
<td>Sends an A4 or letter-size document that is placed long edge first into the ADF as an A3-size fax</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Quick Memory Send</td>
<td>Off</td>
<td>Sends the first page of a multi-page document as soon as it finishes scanning. Select this option to decrease the amount of time it takes to fax a document.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Batch Send</td>
<td>Off</td>
<td>Sorts outgoing faxes by recipient in the product's memory, and then sends them as a batch</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Save Failure Data</td>
<td>Off</td>
<td>Saves faxes that failed to be sent in the product’s memory. You can resend the faxes from the product’s Job/Status screen.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
</tbody>
</table>

Parent topic: Selecting Advanced Fax Settings

Receive Settings - Fax
Set the save/forward or print options you want to use for incoming faxes.

Save/Forward Settings
<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unconditional</td>
<td>Save to Inbox</td>
<td>Saves received faxes in printer’s inbox</td>
</tr>
<tr>
<td>Save/Forward</td>
<td>Save to Computer</td>
<td>Converts received faxes to PDFs and saves them on a computer connected to the printer</td>
</tr>
<tr>
<td></td>
<td>Save to Memory</td>
<td>Converts received faxes to PDFs and saves them on an external memory device connected to the printer</td>
</tr>
<tr>
<td></td>
<td>Forward</td>
<td>Forwards received faxes to another fax machine, or converts them to PDFs and forwards them to a shared folder on a network or an email address. Forwarded faxes are deleted from the printer.</td>
</tr>
<tr>
<td></td>
<td>Email Notifications</td>
<td>Sends an email notification after a fax is received, printed, saved, or forwarded</td>
</tr>
<tr>
<td>Conditional</td>
<td>—</td>
<td>Sets up conditions to save, forward, or print received faxes. Select Enable to enable a condition. Select the arrow icon to enter conditions and other settings.</td>
</tr>
<tr>
<td>Save/Forward</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Common Settings</td>
<td>Inbox Settings</td>
<td>Sets up what happens when the fax memory is full, or sets up a password for the inbox</td>
</tr>
<tr>
<td></td>
<td>Forward Settings</td>
<td>Specifies a subject when forwarding a fax to an email address</td>
</tr>
<tr>
<td>Print Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>Auto Reduction</td>
<td>On</td>
<td>Reduces the size of large received faxes to fit on the paper size in the selected paper source</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Prints large incoming faxes at their original size on multiple sheets, if necessary</td>
</tr>
<tr>
<td>Split Page Settings</td>
<td>Delete Print Data</td>
<td>Selects how to split large incoming faxes across multiple sheets when using the Auto Reduction option</td>
</tr>
<tr>
<td></td>
<td>After Split</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Overlap When Split</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Acting Print</td>
<td>On (Split to Pages)</td>
<td>Splits large incoming faxes across multiple sheets</td>
</tr>
<tr>
<td></td>
<td>On (Reduce to Fit)</td>
<td>Reduces the size of large received faxes to fit on the paper size in the selected paper source</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Prints large incoming faxes at their original size on multiple sheets, if necessary</td>
</tr>
<tr>
<td>Auto Rotation</td>
<td>On</td>
<td>If you have loaded A5-size paper, select <strong>On</strong> to rotate landscape-oriented incoming faxes so that they print correctly on the paper</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Add Reception</td>
<td>On</td>
<td>Select <strong>On</strong> to include the date, time, the sender's information, and a page number in the header of your incoming faxes</td>
</tr>
<tr>
<td>Information</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>2-Sided</td>
<td>On</td>
<td>Select <strong>On</strong> to print incoming faxes double sided. You can also select the <strong>Binding Margin</strong>.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Print Start Timing</td>
<td>All Pages Received</td>
<td>Prints incoming faxes after the product receives all of the pages of the document</td>
</tr>
<tr>
<td></td>
<td>First Page Received</td>
<td>Prints incoming faxes as soon as the product receives the first page of the document</td>
</tr>
<tr>
<td>Collation Stack</td>
<td>On</td>
<td>Select <strong>On</strong> to print incoming faxes so that the pages are stacked in the correct page order. (When the product is low on memory, this option may not be available.)</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Print Suspend Time</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Select <strong>On</strong> to set a time period to stop automatic printing of faxes or reports and save received faxes in the product’s memory. (Make sure there is enough free memory before using this function.)</td>
</tr>
<tr>
<td></td>
<td>Time to Stop</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Restart Time</td>
<td></td>
</tr>
<tr>
<td>Quiet Mode</td>
<td>On</td>
<td>Select <strong>On</strong> to reduce noise during printing. (Printing speed may be reduced.)</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>

Parent topic: Selecting Advanced Fax Settings

Report Settings - Fax
Set the options you want for fax reports.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forwarding Report</td>
<td>Print on Error</td>
<td>Prints a report after forwarding a received document only if an error occurs</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td>Prints a report after forwarding a received document</td>
</tr>
<tr>
<td></td>
<td>Do Not Print</td>
<td>Does not print a report after forwarding a received document</td>
</tr>
<tr>
<td>Back Up Error Report</td>
<td>On</td>
<td>Select On to print a report when a backup error for sending faxes occurs</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Fax Log</td>
<td>Off</td>
<td>Does not print a fax log</td>
</tr>
<tr>
<td></td>
<td>On(Every 30)</td>
<td>Prints a fax log after every 30 fax jobs are completed</td>
</tr>
<tr>
<td></td>
<td>On(Time)</td>
<td>Prints a fax log at a specified time. If the number of completed fax jobs exceeds 30, the fax log prints before the specified time.</td>
</tr>
<tr>
<td>Attach Fax Image to Report</td>
<td>Off</td>
<td>Does not include an image on the Transmission Report</td>
</tr>
<tr>
<td></td>
<td>On(Large Image)</td>
<td>Prints a Transmission Report that includes the upper part of the first page of the sent document</td>
</tr>
<tr>
<td></td>
<td>On(Small Image)</td>
<td>Prints a Transmission Report that includes a reduced size of the entire first page of the sent document</td>
</tr>
<tr>
<td>Report Format</td>
<td>Simple</td>
<td>Prints a simple fax report</td>
</tr>
<tr>
<td></td>
<td>Detail</td>
<td>Prints a fax report that includes error codes</td>
</tr>
<tr>
<td>Output Method</td>
<td>Print</td>
<td>Prints fax reports</td>
</tr>
<tr>
<td></td>
<td>Save to Memory Device</td>
<td>Saves fax reports to a memory device</td>
</tr>
<tr>
<td></td>
<td>Forward</td>
<td>Forwards fax reports to a specified destination</td>
</tr>
</tbody>
</table>

Parent topic: Selecting Advanced Fax Settings

Security Settings - Fax

Set the security options you want to use for faxing.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct Dialing Restrictions</td>
<td>Off</td>
<td>Does not restrict dialed fax numbers</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Allows faxing only to numbers stored in the contacts list or history</td>
</tr>
<tr>
<td></td>
<td>Enter Twice</td>
<td>Requires you to enter fax numbers twice to prevent errors</td>
</tr>
<tr>
<td>Confirm Address List</td>
<td>Off</td>
<td>Selects whether or not to display a recipient confirmation screen before a fax is sent</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Backup Data Auto Clear</td>
<td>Off</td>
<td>Select On to automatically erase sent or received fax data from your product's memory</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Clear Backup Data</td>
<td>—</td>
<td>Deletes all sent or received fax data remaining in your product's memory. Clear backup data if you are giving away or disposing of your product.</td>
</tr>
</tbody>
</table>

Parent topic: Selecting Advanced Fax Settings

Setting Up the Fax Utility - Windows

You can set up the FAX Utility for Windows for use with your product.

Note: Before using the FAX Utility for Windows, make sure you have set up the fax features on your product using the product control panel. Also first confirm that you can send and receive faxes using the control panel.

1. Do one of the following:
   - Windows 10: Click and select EPSON Software.
   - Windows 8.x: Navigate to the Apps screen.
   - Windows (other versions): Click or Start > Programs or All Programs > EPSON Software.
2. Select FAX Utility.
The first time you use the FAX Utility, you see this introduction window:

3. **Read about the FAX Utility and click Close at the bottom of the window.**
You see this window:

4. Click **Select Printer** and follow the on-screen instructions to transfer your product's fax settings to the FAX Utility.

   **Note:** For detailed information, click **Help** or **Open Online Help**.

**Parent topic:** Setting Up Fax Features

**Setting Up Fax Features Using the Fax Utility - Mac**

You can set up your fax header and select your fax settings using the FAX Utility for Mac.
1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or Printers & Scanners, select the FAX option for your product, and select Options & Supplies. Select Utility and select Open Printer Utility.

2. Double-click FAX Utility, if necessary.

You see this window:

![FAX Utility window](image)

3. Select your FAX product in the Printer list.

4. Select Fax Settings.

5. Follow the prompts that appear on the screen to enter your fax header information and select your fax settings.

   **Note:** For detailed information, select the FAX Utility ? icon.

**Parent topic:** Setting Up Fax Features

## Setting Up Contacts and Contact Groups

You can set up a list of contacts and their fax numbers so you can quickly select them for faxing. You can also set up contact groups to send a fax message to multiple contacts.

**Setting Up Contacts Using the Product Control Panel**

**Importing Contacts Using the Fax Utility - Windows**

**Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac**
Setting Up Contacts Using the Product Control Panel

You can set up your contacts and contact groups using the control panel on your product.

**Note:** Contacts can be locked by an administrator. If you cannot access or change contacts, contact your administrator for assistance.

- Creating a Contact
- Editing or Deleting a Contact
- Creating a Contact Group
- Editing or Deleting a Contact Group

**Creating a Contact**

You can create a list of contacts to save frequently used fax numbers.

**Note:** You can create up to 2,000 contacts and contact groups combined.

1. Press the home button, if necessary.
2. Select Fax.
You see a screen like this:

3. Select the **Recipient** tab.
You see a screen like this:

4. Select Add New.
5. Select Add Contact.
6. Select the number you want to use for the contact you are adding.
You see a screen like this:

7. Select the **Name** field. Use the on-screen keyboard to enter the contact name (up to 30 characters) and select **OK**.

8. Select the **Index Word** field. Use the on-screen keyboard to enter a word to use when searching for an entry (up to 30 characters) and select **OK**. (This field is optional.)

9. Select the **Fax Number** field. Use the on-screen keyboard to enter the fax number. You can enter up to 64 characters.

   **Note:** If necessary, enter an outside line access code (such as 9) at the beginning of the fax number. If the access code has been set up in the **Line Type** setting, enter the # pound sign instead of the code.

10. Set any additional settings, if necessary.

11. Select **OK**.

**Parent topic:** Setting Up Contacts Using the Product Control Panel

**Editing or Deleting a Contact**

You can edit or delete any of the contacts on your list.
1. Press the home button, if necessary.
2. Select **Fax**.
   
   You see a screen like this:

   ![Fax screen](image)

   3. Select the **Recipient** tab.
   4. Select the > icon next to the contact you want to edit or delete.
You see a screen like this:

5. Do one of the following:
   • To delete the contact, select **Delete** and select **Yes** on the confirmation screen.
   • To edit the contact, select **Edit**, select the item you want to change, enter the correct information, and select **OK**. When you finish editing, select **OK**.

Parent topic: Setting Up Contacts Using the Product Control Panel

Creating a Contact Group

You can create a group of contacts so that you can easily send faxes to multiple recipients.

**Note:** You can create up to 2,000 contacts and contact groups combined.

1. Press the **_home** home button, if necessary.
2. Select **Fax**.
You see a screen like this:

3. Select the **Recipient** tab.
4. Select **Add New**.
5. Select **Add Group**.
You see a screen like this:

6. Select the number you want to use for the group you are adding.
7. Select the **Group Name** field. Use the on-screen keyboard to enter the group name (up to 30 characters) and select **OK**.
8. Select the **Index Word** field. Use the on-screen keyboard to enter a word to use when searching for a group (up to 30 characters) and select **OK**. (This field is optional.)
9. Select **Contact(s) Added to the Group**.
   
   You see your contacts list.
10. Select the number next to each contact you want to include in your group.
    
    A check mark appears next to each selected contact.
11. Select **Close** to return to the previous screen.
12. Select **OK**.

**Parent topic:** Setting Up Contacts Using the Product Control Panel
Editing or Deleting a Contact Group

You can edit an existing contact group to add or delete entries. You can also delete the entire contact group.

1. Press the home button, if necessary.
2. Select Fax.

You see a screen like this:

3. Select the Recipient tab.
4. Select the icon next to the group you want to edit or delete.
You see a screen like this:

![Fax interface](image)

**Note:** If you want to delete the entire group, select **Delete**.

5. To edit the group, select **Edit**.
6. Select **Contact(s) Added to the Group**.
   You see a list of the contacts in your group.
7. To add or delete a contact, select the check mark next to it.
8. Select **Close** to return to the previous screen.
9. Select **OK**.

**Parent topic:** Setting Up Contacts Using the Product Control Panel

### Importing Contacts Using the Fax Utility - Windows

You can edit contacts stored in your product and import contacts from your Windows Address Book to the PC-FAX Phone Book in the FAX Utility for Windows.
1. Do one of the following:
   - **Windows 10**: Click and select **EPSON Software**.
   - **Windows 8.x**: Navigate to the **Apps** screen.
   - **Windows (other versions)**: Click or **Start > Programs** or **All Programs > EPSON Software**.

2. Select **FAX Utility**.
   The first time you use the FAX Utility, you see this introduction window:

   ![FAX Utility Introduction Guide](image)

   - **Send faxes from your computer**: To send a fax directly from your computer, open the print screen of the application in which you made the document select the printer name after which (FAX) is displayed, click the print button. And then use the wizard that is displayed.
   - **Save and get notifications on your computer**: FAX Utility can regularly get faxed on the printer and save them to a specified folder (PC-FAX reception). This utility can also display notifications on your screen.

3. Read about the FAX Utility and click **Close** at the bottom of the window.
4. To edit the contacts list on your product, click **Contacts**.

5. Do one of the following:
   - To edit a contact, select it in the list and click the icon.
   - To delete a contact, select it in the list and click the icon.

6. To import fax numbers from your Windows Address Book into the FAX Utility PC-FAX Phone Book, select **Edit PC-FAX Phone Book**.
You see this window:

7. Select **File > Import From Windows Address Book**.
8. Select the contacts you want to import and click **OK**.

   **Note:** For detailed information, select **Help** or **Open Online Help**.

**Parent topic:** Setting Up Contacts and Contact Groups

**Related topics**
Setting Up Contacts and Contact Groups

### Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac

You can set up your speed dial and group dial lists using the FAX Utility. The utility also lets you import fax numbers from the MacAddress Book and back up fax numbers to your product's memory.

**Note:** You can create up to 60 speed dial and group dial entries combined.

1. In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select the **FAX** option for your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.
2. Double-click **FAX Utility**, if necessary.
You see this window:

3. Select your **FAX** product in the Printer list.
4. Select **Speed Dial/Group Dial List**.
   You see this window:
5. To add an entry, double-click an empty entry.

**Note:** To edit an entry, select it and change the information. To delete an entry, select it and press the **Delete** key on your keyboard.

6. Do one of the following:
   - To create a speed dial entry, select **Speed Dial**, enter a name and fax number, and click **OK**.
   - To create a group dial entry, select **Group Dial**, enter a name, select your desired fax numbers, and click **OK**.

7. Repeat the previous steps as necessary to add all your speed dial or group dial entries.

8. To import entries from your MacAddress book, click the icon.

9. When you are finished, click the icon to save the entries to your product's memory.

**Parent topic:** Setting Up Contacts and Contact Groups

**Related topics**

Setting Up Contacts and Contact Groups

**Sending Faxes**

See these sections to send faxes using your product.

- Sending Faxes from the Product Control Panel
- Sending Faxes Using the Fax Utility - Windows
- Sending Faxes Using the Fax Utility - Mac

**Parent topic:** Faxing

**Sending Faxes from the Product Control Panel**

See these sections to send faxes using the product's control panel.

- Sending a Fax Using the Control Panel
- Fax Sending Options
- Sending a Fax at a Specified Time
- Sending a Stored Fax
- Sending a Fax on Demand
- Dialing Fax Numbers from a Connected Telephone
Parent topic: Sending Faxes

Sending a Fax Using the Control Panel

You can send a fax from your product control panel by entering the fax number or selecting an entry from the contact list. You can select to send up to 50 black-and-white fax jobs at one time.

Note: You can send a black-and-white fax to up to 200 recipients at a time, or send a color fax to one recipient at a time. If your recipient’s fax machine does not print in color, your fax is automatically sent in black-and-white.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select Fax.

You see a screen like this:

![Fax screen]

Note: To fax a double-sided document, place your document in the ADF and turn on the ADF 2-Sided setting. (You cannot fax double-sided documents in color.)
4. Do one of the following to select fax recipients:
   • Select Direct Enter, enter a fax number, and select OK. To add another fax number, repeat these steps.

     **Note:** If direct dialing has been restricted, you can only select the number from the contact list or fax history. If necessary, enter an outside line access code (such as 9) at the beginning of the fax number. If the access code has been set up in the Line Type setting, enter the # pound sign instead of the code. If your fax number requires a brief pause, select the icon to insert a pause symbol (–).

   • Select the Recipient tab to display the contact list. Select the checkbox next to one or more contacts (select the checkbox again to deselect it).

   • Select the icon to search for recipients by name, index name, or entry number. Select Close when you finish.

     **Note:** To delete selected recipients, select the Enter Recipient field, select the recipient you want to delete, and select Remove.

5. If you need to change any fax settings, select the Fax Settings tab and select your settings.

6. If you want to preview your fax in black-and-white on the LCD screen, select Preview. (If the preview looks incorrect, select Retry, reposition the document or change the fax settings, and repeat this step.)

     **Note:** If you do not touch the preview screen for 20 seconds, your product sends the fax automatically. You cannot preview images when the Direct Send setting is turned on.

7. If you want to save your fax settings for later use, select Presets and add a new entry.

8. Select Send.

     **Note:** To cancel faxing, check the job status by selecting Job/Status.

     Your product scans your original and prompts you to place additional pages, if necessary. After scanning your originals, your product dials the number and sends the fax.
**Note:** Your product does not save sent color faxes to its memory. If the **Save Failure Data** setting is enabled, faxes that failed to be sent are stored to the product's memory and you can resend them from the Job/Status screen.

**Parent topic:** Sending Faxes from the Product Control Panel

**Related references**
Fax Sending Options

**Related tasks**
Checking Fax Status and Cancelling Fax Jobs
Selecting the Line Type
Using Presets

**Related topics**
Setting Up Contacts and Contact Groups
Placing Originals on the Product

### Fax Sending Options

While sending a fax, you can select **Fax Settings** and select these options.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Size (Glass)</td>
<td>Various sizes</td>
<td>Sets the size for a document placed on the scanner glass</td>
</tr>
<tr>
<td>Original Type</td>
<td>Text</td>
<td>Specifies the document type of your originals and adjusts the quality of your copies</td>
</tr>
<tr>
<td></td>
<td>Text &amp; Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Photo</td>
<td></td>
</tr>
<tr>
<td>Color Mode</td>
<td>Color</td>
<td>Selects whether to scan images in color or black and white</td>
</tr>
<tr>
<td></td>
<td>B&amp;W</td>
<td></td>
</tr>
<tr>
<td>Resolution</td>
<td>Standard</td>
<td>Adjusts the scan resolution and print quality of outgoing faxes</td>
</tr>
<tr>
<td></td>
<td>Fine</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Super Fine</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ultra Fine</td>
<td></td>
</tr>
<tr>
<td>Density</td>
<td>Varying levels</td>
<td>Select from various density levels.</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remove Background</td>
<td>Auto</td>
<td>Automatically removes any background color on scanned images</td>
</tr>
<tr>
<td></td>
<td>Varying levels available</td>
<td>Lets you select from various levels of background color adjustment</td>
</tr>
<tr>
<td>Sharpness</td>
<td>Varying levels available</td>
<td>Adjusts the sharpness level of outgoing faxes</td>
</tr>
<tr>
<td>ADF 2-Sided</td>
<td>Off</td>
<td>Select On to enable 2-sided faxing from the ADF. The Direct Send setting and color faxing are disabled when you turn on this setting.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Select On to enable 2-sided faxing from the ADF. The Direct Send setting and color faxing are disabled when you turn on this setting.</td>
</tr>
<tr>
<td>ADF Continuous Scan</td>
<td>Off</td>
<td>Select On to have the product to ask if you want to scan another page after a document in the ADF has finished scanning</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Select On to have the product to ask if you want to scan another page after a document in the ADF has finished scanning</td>
</tr>
<tr>
<td>Direct Send</td>
<td>Off</td>
<td>Select On to send black-and-white faxes to a single recipient as soon as the connection is made, without saving the scanned image to memory. You cannot use this setting when sending a color fax or sending a fax to multiple recipients.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Select On to send black-and-white faxes to a single recipient as soon as the connection is made, without saving the scanned image to memory. You cannot use this setting when sending a color fax or sending a fax to multiple recipients.</td>
</tr>
<tr>
<td>Priority Send</td>
<td>Off</td>
<td>Select On to send the current fax before other faxes waiting to be sent</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Select On to send the current fax before other faxes waiting to be sent</td>
</tr>
<tr>
<td>Send Fax Later</td>
<td>Off</td>
<td>Select On to send the current fax at a selected time</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Select On to send the current fax at a selected time</td>
</tr>
<tr>
<td>Add Sender Information</td>
<td>Off</td>
<td>Includes a header, your phone number, or a destination list in the selected location on your outgoing faxes</td>
</tr>
<tr>
<td></td>
<td>Outside of Image</td>
<td>Includes a header, your phone number, or a destination list in the selected location on your outgoing faxes</td>
</tr>
<tr>
<td></td>
<td>Inside of Image</td>
<td>Includes a header, your phone number, or a destination list in the selected location on your outgoing faxes</td>
</tr>
<tr>
<td>Notify Send Result</td>
<td>Off</td>
<td>Sends a notification to the selected email address when an outgoing fax is sent</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Sends a notification to the selected email address when an outgoing fax is sent</td>
</tr>
<tr>
<td>Transmission Report</td>
<td>Print on Error</td>
<td>Selects when or if to print transmission reports</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td>Selects when or if to print transmission reports</td>
</tr>
<tr>
<td></td>
<td>Do Not Print</td>
<td>Selects when or if to print transmission reports</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Backup</td>
<td>Off</td>
<td>Saves a copy of the scanned fax to the selected email address or network folder/FTP location</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
</tbody>
</table>

**Parent topic:** Sending Faxes from the Product Control Panel

**Sending a Fax at a Specified Time**

You can send a fax at a time of your choice.

**Note:** Make sure the product's date and time settings are correct. You can send faxes only in black-and-white when you use this option.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select Fax.
   
   You see a screen like this:
4. Enter a fax number or select a recipient.
5. Select the Fax Settings tab.
6. Select Send Fax Later.
7. Select On.
8. Select Time, use the on-screen keyboard to enter your desired time, and select OK.
9. Select Send.

Note: To cancel faxing, check the job status by selecting Job/Status.

After scanning your originals, your product dials the number and sends the fax at the specified time.

Note: If the product is turned off at the specified time, the fax is sent when it is turned on.

Parent topic: Sending Faxes from the Product Control Panel
Related references
Fax Sending Options
Related tasks
Checking Fax Status and Cancelling Fax Jobs
Selecting the Date and Time
Related topics
Placing Originals on the Product
Setting Up Contacts and Contact Groups

Sending a Stored Fax
You can store up to 10 scanned documents (up to 100 black-and-white pages) and send them whenever necessary.

Note: If you try to store more than 10 jobs or 100 pages, they overwrite previously stored documents. Be sure to check how many fax jobs are stored before storing additional jobs.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select Fax.
You see a screen like this:

4. Select **Menu**.
5. Select **Store Fax Data** and select **On**.
6. Select any other fax settings as necessary.

7. Select **Store**.
   Your document is scanned, stored, and briefly previewed.

8. When you are ready to send the document, press the home button, if necessary, and select **Fax Box**.

9. Select **Stored Documents**.
10. Select the stored fax job you want to send.

11. Select **Start Sending**.

**Parent topic:** Sending Faxes from the Product Control Panel
You can store up to 10 scanned documents (up to 100 black-and-white pages) and have them sent automatically when another fax machine requests them. Other fax users can receive the document by calling your fax number and using the polling receive function on their fax machines.

**Note:** If you try to store more than 10 jobs or 100 pages, they overwrite previously stored documents. Be sure to check how many fax jobs are stored before storing additional jobs.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select Fax Box.
4. Select Polling Send/Board.
5. Select Polling Send.
6. Select your settings, if necessary.
7. Select Add Document.
8. Select Store.
   Your document is scanned and stored until you overwrite or delete it.

**Note:** You can delete a stored document from the Job/Status screen.

**Parent topic:** Sending Faxes from the Product Control Panel

**Related references**
Fax Sending Options

**Related topics**
Placing Originals on the Product
Dialing Fax Numbers from a Connected Telephone

If you connected a telephone to the EXT port on your product, you can send a fax by dialing the fax number from the connected telephone. If the recipient's phone number and fax number are the same, you can speak to the recipient before sending the fax.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Dial the fax number from the connected telephone. Speak to the recipient if necessary.

   **Note:** If you are using a pre-paid calling card, enter the number and password required to use the card before entering the destination fax number.

4. Select Fax on the LCD screen.
5. Select Fax Settings and select any settings as necessary.

   **Note:** Your product now communicates with the recipient's fax machine. Do not hang up the telephone.

6. When you hear a fax tone, select **Send** to start sending the fax.

   **Note:** If your recipient's fax machine does not print in color, your fax is automatically sent in black-and-white.

7. Hang up the telephone.

Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related topics
Placing Originals on the Product

Sending Faxes Using the Fax Utility - Windows

You can send a fax from a printing program in Windows. You can fax up to 100 pages at a time, including a cover sheet.

1. Open the file you want to fax and select the print command.
You see a window like this:

2. Select your product with the FAX option as the printer.
3. To change the Paper Size, Orientation, Color, Image Quality, or Character Density settings, click the Preferences or Properties button.

   **Note:** If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties on the next screen. For more information about selecting fax print settings, click Help.

4. Select the Page Range as necessary. (Leave the Number of copies set to 1.)
5. Click Print or OK.
If you’re faxing for the first time, you see a window like this one:

![Enter Sender Information window]

6. Enter your sender information so that recipients can identify the origin of the fax. Then click **OK** to save the sender information.
You see a window like this:

7. Enter the recipient's name and fax number or select a recipient from the phonebook, then click Next.

   **Note:** For detailed instructions on using the Epson FAX Utility, click Help.

8. Select a cover sheet and enter a subject and message, then click Next.
9. Click **Send** to transmit your fax.

   **Parent topic:** Sending Faxes

**Sending Faxes Using the Fax Utility - Mac**

You can send a fax from a Mac printing program using the FAX Utility. You can fax up to 100 pages at a time, including a cover sheet.

   1. Open the file you want to fax.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the **Print** option in the **File** menu, or another command. See your application's help utility for details.

   ![Printer Settings](image)

   3. Select your product **FAX** option as the **Printer** setting.

   4. If necessary, click the arrow next to the Printer setting or the **Show Details** button to expand the print window.

   5. Select the number of pages you are faxing as the **Pages** setting.

      **Note:** Leave the **Copies** setting set to 1.

   6. Select **Recipient Settings** from the pop-up menu.
7. Do one of the following to choose your recipient:
   • Select a name or group from the **Recipient List**.
   • Enter a name, company, and fax number and click the + button.
   • Click the icon and select a recipient from your address book.
8. Select **Fax Settings** from the pop-up menu.
You see this window:

9. Select the **Color** and **Image Quality** settings you want to use for your fax.
10. Click **Fax**.

Parent topic: Sending Faxes

### Receiving Faxes

See these sections to receive faxes with your product.

- Fax Reception
- Receiving Faxes Automatically
- Receiving Faxes Manually
- Forwarding Received Faxes
- Receiving a Fax by Polling
- Saving and Viewing Received Faxes
- Selecting Received Fax Options Using the Fax Utility - Windows

Parent topic: Faxing

### Fax Reception

Your product will automatically receive and print faxes when you set the Receive Mode to **Auto**.
If you connected a telephone to your product so you can use the same phone line for faxes and voice calls, you can also set your product to receive faxes manually. This allows you to check for a fax tone using the telephone and press a button on your product to receive the fax.

Make sure to load paper in your product and select your fax settings before receiving a fax.

**Note:** If you run out of paper during fax printing, load more paper and press the button indicated on your product’s LCD screen to continue.

Parent topic: Receiving Faxes

### Receiving Faxes Automatically

To receive faxes automatically, make sure Receive Mode is set to **Auto** (the default setting for the product).

To change the Receive Mode if necessary, select Settings > General Settings > Fax Settings > Basic Settings > Receive Mode.

If an answering machine is connected, make sure the product’s **Rings to Answer** setting is set higher than the number of rings your answering machine is set to answer a call. For example, if the answering machine is set to pick up on the fourth ring, set the product to pick up on the fifth ring or later.

Parent topic: Receiving Faxes

Related references

- Basic Settings - Fax

Related tasks

- Receiving Faxes Manually

### Receiving Faxes Manually

You can set up your product to receive faxes manually by setting the Receive Mode to **Manual**. This lets you check for a fax tone on the connected telephone before receiving a fax.

1. To change the Receive Mode, select Settings > General Settings > Fax Settings > Basic Settings > Receive Mode and select **Manual**.
2. When the connected telephone rings, answer the call.
3. If you hear a fax tone, select **Fax** on the LCD display.
4. Select **Send/Receive**.
5. Select **Receive**.
6. Select **Receive** to start receiving the fax.
7. Hang up the telephone.

**Parent topic:** Receiving Faxes

**Related references**
- Basic Settings - Fax

**Related tasks**
- Receiving Faxes Automatically

### Forwarding Received Faxes

You can forward received faxes to another fax machine, or convert the faxes into PDF documents and forward them to a shared folder on the network or to an email address. Forwarded faxes are deleted from the product's memory.

Before using this feature, make sure the date and time are set correctly, the forwarding destination is set up in the contact list, and the email server settings are configured.

1. Press the home button, if necessary.
2. Select **Settings**.
3. Select **General Settings**.
4. Select **Fax Settings**.
You see a screen like this:

![Settings](image)

5. Select **Receive Settings**.
6. Select **Save/Forward Settings**.
7. Select **Unconditional Save/Forward**.
8. Select **Forward**.
9. Select **Yes**.

**Note:** If you want to print the fax automatically before forwarding it, select **Yes and Print**.

10. Select **Add Entry** and select the forwarding destination from the contacts list.
11. Select **Close**.
12. Confirm the displayed forwarding destinations and select **Close**.
13. Under Options When Forwarding Failed, select whether you want to print the faxes or save them in the printer's inbox if forwarding received faxes fails.

**Parent topic:** Receiving Faxes
Receiving a Fax by Polling

You can use polling to receive a fax from another fax machine (such as a fax information service).

**Note:** You cannot use polling to receive a fax from a fax information service that uses audio guidance.

1. Press the home button, if necessary.
2. Select Fax.
   
   You see a screen like this:

3. Select Menu.
4. Set Polling Receive to On.
5. Select Close.
6. Enter the fax number you expect to receive the fax from.
7. Select Polling to start receiving the fax.

**Parent topic:** Receiving Faxes
Saving and Viewing Received Faxes

You can save received faxes in your product's memory and view them on the LCD screen.

Note: The inbox can be locked by an administrator. If you cannot access the inbox, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
4. Select Fax Settings.
   You see a screen like this:

5. To save received faxes, select Receive Settings > Save/Forward Settings > Unconditional Save/Forward and set Save to Inbox to On.
6. Press the home button.
7. Select Fax Box.
8. Do one of the following to view stored faxes:
   • Select **Inbox/Confidential Box** to view received faxes.
   • Select **Stored Documents** to view saved faxes that have not been sent (available only when **Store Fax Data** is set to **On**).
   • Select **Polling Send/Board** to view faxes that are stored for fax polling.
9. Select the fax you want to view.
   The LCD screen displays the fax contents.
10. If you want to print or delete a stored fax, select **Menu**.
11. Select one of the printing or deleting options, and follow the on-screen instructions.

   **Note:** Delete faxes after you print or view them to free up the product's memory. When the memory is full, you can only forward or print incoming faxes.

   **Parent topic:** Receiving Faxes

### Selecting Received Fax Options Using the Fax Utility - Windows

You can select options for use with received faxes using the FAX Utility for Windows.

1. Do one of the following:
   • **Windows 10:** Click and select **EPSON Software**.
   • **Windows 8.x:** Navigate to the **Apps** screen.
   • **Windows (other versions):** Click or **Start > Programs** or **All Programs > EPSON Software**.
2. Select **FAX Utility**.
The first time you use the FAX Utility, you see this introduction window:

3. Read about the FAX Utility and click **Close** at the bottom of the window.
You see this window:

4. To save faxes received by your product on your computer, select **Save received faxes on this computer**.

5. Select the destination folder and other options, and click **OK**.
   
   You return to the FAX Utility window.

6. To receive notifications when received faxes arrive in the selected destination folder on your computer, select **Notify me if new faxes exist in forwarding folders**.
7. Select how often you want to be notified of received faxes and click **OK**.

**Note:** For detailed information, click **Help** or **Open Online Help**.

**Parent topic:** Receiving Faxes

## Checking Fax Status and Cancelling Fax Jobs

You can check the status of current, received, saved, or sent fax jobs on the product control panel. You can also cancel sending current fax jobs.

1. Select **Job/Status**.

   You see a screen like this:

   ![Job Status Screen](image)

   You can check the job in progress.

2. Do one of the following:

   - To check the status of current fax jobs, select the fax job you want to check on the **Active** tab. To cancel a job, select **Cancel**.
• To check the history of faxes that have been sent, received, or saved, select Log and select the job you want to check.

Note: If the Received Fax light is flashing, received faxes have been temporarily saved to the product's memory.

Parent topic: Faxing

Printing Fax Reports

You can print several types of fax reports or view the fax log on the LCD screen. You can also print the fax log automatically by turning on the Fax Log Auto Print setting.

1. Press the home button, if necessary.
2. Select Fax.
   
   You see a screen like this:

   ![Fax interface]

3. Select Menu.
4. Select the fax report you want to print, or select Fax Log to view the fax log.
Fax Report Options

Parent topic: Faxing

Related references
Report Settings - Fax

Fax Report Options
Select the fax report or list you want to print.

Last Transmission
Print a report on the fax that was previously sent or received through polling.

Fax Log
View or print a report on recent fax transmissions.

Stored Fax Documents
Print a list of the fax jobs currently stored in the product's memory.

Fax Settings List
Print a list of the current fax communication settings.

Conditional Save/Forward List
Print a list of the current conditional save/forward settings.

Protocol Trace
Print a detailed report for the previously sent or received fax.

Parent topic: Printing Fax Reports
Using External USB Devices with Your Product

Follow the instructions here to work with an external USB device connected to your product.

**Note:** Your product may differ from the images in this guide, but the instructions are the same unless otherwise noted.

- Connecting a USB Device
- Disconnecting a USB Device
- Viewing and Printing from the LCD Screen
- Transferring Files on a USB Device

**Connecting a USB Device**

Connect a USB device or its USB cable to the USB port on the front of the product.

**Note:** Epson cannot guarantee the compatibility of your device. Make sure the files on the device are compatible with the product.

**USB Device Photo File Specifications**

**Parent topic:** Using External USB Devices with Your Product
Related tasks
Disconnecting a USB Device

USB Device Photo File Specifications
You can use USB devices with your product containing files that meet these specifications.

<table>
<thead>
<tr>
<th>File format</th>
<th>JPEG with the DCF (Design Rule for Camera File system) version 1.0 or 2.0 standard*</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TIFF 6.0-compliant uncompressed images: RGB full-color or binary (not CCITT-encoded)</td>
</tr>
<tr>
<td>Image size</td>
<td>80 × 80 pixels to 10200 × 10200 pixels</td>
</tr>
<tr>
<td>File size</td>
<td>Up to 2GB</td>
</tr>
<tr>
<td>Number of files</td>
<td>JPEG: Up to 9990</td>
</tr>
<tr>
<td></td>
<td>TIFF: Up to 999</td>
</tr>
<tr>
<td></td>
<td>PDF: Up to 999</td>
</tr>
</tbody>
</table>

* Files stored on digital cameras with built-in memory are not supported.

Parent topic: Connecting a USB Device

Disconnecting a USB Device
After you finish working with a USB device, follow these steps to remove it.

1. If your product is connected to your computer using a USB cable, do one of the following:
   - Windows: Open the My Computer, Computer, This PC, or Windows Explorer utility. Then right-click the name of your USB device (listed as a removable disk) and select Eject.
   - Mac: Drag the removable disk icon for your USB device from the desktop into the trash.

   **Caution:** Do not remove a USB device before completing the procedure above or you may lose data from the flash drive.

2. Pull the USB device or cable out of the USB port on the front of the product.

Parent topic: Using External USB Devices with Your Product
Viewing and Printing from the LCD Screen

See these sections to view and print photos or other files displayed on your product’s LCD screen.

- Printing JPEG Photos
- Printing TIFF and PDF Files

Parent topic: Using External USB Devices with Your Product

Printing JPEG Photos

You can select JPEG photos for printing as you view them on the LCD screen.

1. Press the home button, if necessary.
2. Select Memory Device.
3. Select JPEG.

You see a screen like this:

Note: If you have more than 999 JPEG images on your device, the images are divided into groups, and you must first select the group you want to display.
4. Do one of the following to select your photos:
   • In **Tile View**, select the thumbnail images of the photos you want to print.
   • In **Single View**, select the thumbnail image of the photo you want to print, then press the left or right arrow buttons to scroll through and select additional photos, or select **Tile View** to return to the thumbnail image view and select additional photos.
   • To select all photos, select the menu icon and select **Select All Images**.

5. To change the print settings, select **Basic Settings** and select the necessary settings.

6. To modify the photos, select **Advanced** and make the necessary adjustments. The adjustments modify only your printed copies, not the original files.

7. To enter the number of copies (up to 99), use the on-screen keyboard or select **Copies**.

8. When you are ready to print, select the **Print** icon.

   **Note:** To cancel printing, select **Cancel** on the LCD screen, then select **Cancel** again to confirm.

---

### Print Setting Options - JPEG Mode

**Parent topic:** Viewing and Printing from the LCD Screen

### Print Setting Options - JPEG Mode

Select the print settings you want to use when printing a JPEG from a USB device.

**Note:** Not all options or settings may be available, depending on the file format.

#### Basic Settings

<table>
<thead>
<tr>
<th>Print settings</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Setting</td>
<td>Various paper size and type settings</td>
<td>Select the paper source that you want to use.</td>
</tr>
<tr>
<td>Layout</td>
<td>1-up</td>
<td>Print one photo per page.</td>
</tr>
<tr>
<td></td>
<td>20-up</td>
<td>Print 20 photos per page.</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>Print numbered photo thumbnails with date information.</td>
</tr>
<tr>
<td>Print settings</td>
<td>Available options</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Fit Frame</strong></td>
<td><strong>On</strong></td>
<td>Automatically crops the photo to fit into the selected photo layout.</td>
</tr>
<tr>
<td></td>
<td><strong>Off</strong></td>
<td>Turns off automatic cropping.</td>
</tr>
<tr>
<td><strong>B&amp;W</strong></td>
<td>—</td>
<td>Prints a color photo in black and white.</td>
</tr>
<tr>
<td><strong>Auto</strong></td>
<td>—</td>
<td>Automatically detects whether the photo is in color or black and white.</td>
</tr>
</tbody>
</table>

**Advanced settings**

<table>
<thead>
<tr>
<th>Print settings</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Finishing</strong></td>
<td><strong>Collate (Page Order)</strong></td>
<td>Select to print multiple copies of a multi-page document in ordered sets.</td>
</tr>
<tr>
<td></td>
<td><strong>Group (Same Pages)</strong></td>
<td>Select to print multiple copies of a multi-page document in unordered groups.</td>
</tr>
<tr>
<td><strong>Eject Paper</strong></td>
<td></td>
<td>Choose if you want printouts ejected offset for each set of copies.</td>
</tr>
<tr>
<td><strong>Staple</strong></td>
<td></td>
<td>Select the staple location.</td>
</tr>
<tr>
<td><strong>Quality</strong></td>
<td><strong>Standard</strong></td>
<td>Provides good quality for most prints.</td>
</tr>
<tr>
<td></td>
<td><strong>Best</strong></td>
<td>Provides the highest quality for special prints.</td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td><strong>Various date formats</strong></td>
<td>Prints the date the photo was taken on the photo in the format you select.</td>
</tr>
</tbody>
</table>
### Print settings - Available options - Description

<table>
<thead>
<tr>
<th>Print settings</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fix Photo</td>
<td>Various settings</td>
<td>Automatically adjusts the brightness, contrast, and saturation of the photo based on the setting that is selected.</td>
</tr>
<tr>
<td>Enhance Off</td>
<td></td>
<td>Turns off automatic adjustments.</td>
</tr>
<tr>
<td>Fix Red-Eye</td>
<td>Off</td>
<td>Automatically fixes the red-eye effect in photos; see Note below.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
</tbody>
</table>

* Displayed when the optional finisher unit is installed.

**Note:** Fix Red-Eye makes corrections to printouts, not the original photo files. Depending on the type of photo, parts of the image other than the eyes may be corrected.

**Parent topic:** Printing JPEG Photos

### Printing TIFF and PDF Files

You can select and print TIFF or PDF files from a USB flash drive.

1. Press the home button, if necessary.
2. Select Memory Device.
3. Select TIFF or PDF. You see a list of the available files.
4. Select the file you want to print. To view information about the file, select the arrow icon at the end of the file name.
5. Do the following as necessary:
   - To print more than one copy (up to 99), use the on-screen keyboard or select Copies.
   - To change the print settings, select Basic Settings or Advanced and select the necessary settings.
6. When you are ready to print, select the Print icon.

**Note:** To cancel printing, select Cancel on the LCD screen, then select Cancel again to confirm.

**Print Setting Options - TIFF Mode**
Print Setting Options - PDF Mode

Parent topic: Viewing and Printing from the LCD Screen

Print Setting Options - TIFF Mode

Select the print settings you want to use when printing a TIFF from a USB device.

Note: Not all options or settings may be available, depending on the file format.

Basic Settings

<table>
<thead>
<tr>
<th>Print settings</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recent to old or Old to recent</td>
<td>—</td>
<td>Change the order of the photos displayed on the LCD screen.</td>
</tr>
<tr>
<td>Paper Setting</td>
<td>Various paper size and type settings</td>
<td>Select the paper source that you want to use.</td>
</tr>
<tr>
<td>Layout</td>
<td>1-up</td>
<td>Print one photo per page.</td>
</tr>
<tr>
<td></td>
<td>20-up</td>
<td>Print 20 photos per page.</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>Print numbered photo thumbnails with date information.</td>
</tr>
<tr>
<td>Fit Frame</td>
<td>On</td>
<td>Automatically crops the photo to fit into the selected photo layout.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Turns off automatic cropping.</td>
</tr>
<tr>
<td>B&amp;W</td>
<td>—</td>
<td>Prints a color photo in black and white.</td>
</tr>
<tr>
<td>Auto</td>
<td>—</td>
<td>Automatically detects whether the photo is in color or black and white.</td>
</tr>
</tbody>
</table>

Advanced settings
<table>
<thead>
<tr>
<th>Print settings</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finishing</td>
<td>Collate (Page Order)</td>
<td>Select to print multiple copies of a multi-page document in ordered sets.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>![Diagram of Collate (Page Order)]</td>
</tr>
<tr>
<td></td>
<td>Group (Same Pages)</td>
<td>Select to print multiple copies of a multi-page document in unordered groups.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>![Diagram of Group (Same Pages)]</td>
</tr>
<tr>
<td>Eject Paper</td>
<td></td>
<td>Select Shift Sort* to eject offset printouts for each set of copies.</td>
</tr>
<tr>
<td>Staple*</td>
<td></td>
<td>Select the staple location.</td>
</tr>
<tr>
<td>Quality</td>
<td>Standard</td>
<td>Provides good quality for most prints.</td>
</tr>
<tr>
<td></td>
<td>Best</td>
<td>Provides the highest quality for special prints.</td>
</tr>
<tr>
<td>Print Order</td>
<td>—</td>
<td>Select the printing order for multi-page documents.</td>
</tr>
<tr>
<td>Date</td>
<td>Various date formats</td>
<td>Prints the date the photo was taken on the photo in the format you select.</td>
</tr>
</tbody>
</table>

* Displayed when the optional finisher unit is installed.

Parent topic: Printing TIFF and PDF Files

Print Setting Options - PDF Mode

Select the print settings you want to use when printing a PDF from a USB device.

Note: Not all options or settings may be available, depending on the file format.

Basic Settings
<table>
<thead>
<tr>
<th>Print settings</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recent to old or</td>
<td>—</td>
<td>Change the order of the documents displayed on the LCD screen.</td>
</tr>
<tr>
<td>Old to recent</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Paper Setting</td>
<td>Various paper size and type settings</td>
<td>Select the paper source that you want to use.</td>
</tr>
<tr>
<td>2-Sided</td>
<td>Off</td>
<td>Two-sided printing is off.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Two-sided printing is on.</td>
</tr>
<tr>
<td>Binding Position</td>
<td>—</td>
<td>Select the binding position for the document.</td>
</tr>
<tr>
<td>Print Order</td>
<td>—</td>
<td>Select the printing order for multi-page documents.</td>
</tr>
<tr>
<td>B&amp;W</td>
<td>—</td>
<td>Prints a color photo in black and white.</td>
</tr>
<tr>
<td>Auto</td>
<td>—</td>
<td>Automatically detects whether the photo is in color or black and white.</td>
</tr>
</tbody>
</table>

**Advanced settings**
<table>
<thead>
<tr>
<th>Print settings</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finishing</td>
<td>Collate (Page Order)</td>
<td>Select to print multiple copies of a multi-page document in ordered sets.</td>
</tr>
<tr>
<td></td>
<td>Group (Same Pages)</td>
<td>Select to print multiple copies of a multi-page document in unordered groups.</td>
</tr>
<tr>
<td></td>
<td>Eject Paper</td>
<td>Select Rotate Sort to print alternate paper orientations and paper sources (make sure the Paper Setting is set to Auto for this option). Select Shift Sort* to eject offset printouts for each set of copies.</td>
</tr>
<tr>
<td></td>
<td>Staple*</td>
<td>Select the staple location.</td>
</tr>
</tbody>
</table>

* Displayed when the optional finisher unit is installed.

Parent topic: Printing TIFF and PDF Files

**Transferring Files on a USB Device**

You can transfer files to and from a USB device inserted into the USB port on the front of your product.

- Setting Up File Sharing for File Transfers from Your Computer
- Transferring Files from a USB Device to Your Computer

Parent topic: Using External USB Devices with Your Product

**Setting Up File Sharing for File Transfers from Your Computer**

Before you transfer files from a computer to a USB device inserted into the USB port on the front of your product, you may need to set up your product's file sharing settings.
Caution: Remove the USB device before you change this setting or you may lose data from the device.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings.
4. Select Printer Settings.
5. Select Memory Device.
   You see a screen like this:

6. Select Enable.

Parent topic: Transferring Files on a USB Device
Transferring Files from a USB Device to Your Computer

You can transfer files to and from a USB device inserted into the USB port on the front of your product and a computer connected to your product.

Note: Do not transfer files to and from a USB device while you are printing from the device.

1. Make sure your product is connected to a computer.
2. Insert a USB device or its USB cable into the USB port on the front of your product.
3. Do one of the following to access your USB device files from your computer:
   - **Windows**: Open the My Computer, Computer, This PC, or Windows Explorer utility, then select the removable disk icon.
   - **Mac with a USB connection**: Look for the removable disk icon on your desktop, then select it.
   - **Mac with a network connection**: Select the hard drive icon on your desktop or select Computer from the Go menu, select your product in the SHARED section of the sidebar (you may need to widen the sidebar to see the name), and select the USBSTORAGE icon.
4. Select the folder that contains your files.
5. Drag the files you want to transfer to the desired folder on your computer or on your USB device.

Note: Your product's LCD screen does not update to display new information about your USB device after you copy files to it or delete files from it. Remove and insert the USB device to update the information.

Parent topic: Transferring Files on a USB Device
Related tasks
Connecting a USB Device
Replacing Ink Cartridges and Maintenance Boxes

The maintenance box stores ink that gets flushed from the system during print head cleaning. When an ink cartridge is expended or the maintenance box is at the end of its service life, you need to replace it.

You may also need to replace a cartridge that is more than six months old if your printouts do not look their best, even after cleaning and aligning the print head.

Note: Please dispose of your used Epson branded ink cartridges and maintenance boxes responsibly and in accordance with local requirements. If you would like to return your used ink cartridges and maintenance boxes to Epson for proper disposal, please go to epson.com/recycle for more information.

Check Cartridge and Maintenance Box Status
Purchase Epson Ink Cartridges and Maintenance Box
Removing and Installing Ink Cartridges
Replacing the Maintenance Box
Replacing the Optional Staple Cartridge

Check Cartridge and Maintenance Box Status

Your product and its software will let you know when an ink cartridge is low or expended, or when the maintenance box needs to be replaced.

Checking Ink Status on the LCD Screen
Checking Ink and Maintenance Box Status with Windows
Checking Cartridge and Maintenance Box Status - Mac

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Checking Ink Status on the LCD Screen

When one of your ink cartridges is low or expended, you see a message on the LCD screen. Select How-to and follow the steps on the LCD screen to replace the ink cartridge.

You can also check the status of the ink cartridges and maintenance box from the product control panel.

Note: You can continue printing while the low ink message is displayed. Replace the ink cartridges when required.

1. Press the home button, if necessary.
2. Select the icon.
3. Select the **Consumables/Others** tab.

   You see a screen like this:

**WF-C17590/WF-C20590:**
WF-M20590/WF-M20590F:

![Status Monitor](image)

**Note:** The displayed ink and maintenance box levels are approximate.

**Parent topic:** Check Cartridge and Maintenance Box Status

**Related tasks**

- Removing and Installing Ink Cartridges
- Replacing the Maintenance Box

### Checking Ink and Maintenance Box Status with Windows

You can check your ink cartridge or maintenance box status at any time using a utility on your Windows computer.

**Note:** You can continue printing while the low ink message is displayed. Replace the ink cartridges when required.

1. To check your status, access the Windows Desktop and double-click the ![icon](image) icon for your product in the right side of the Windows taskbar, or click the up arrow and double-click ![icon](image). Then click **Details**.
You see this window:

WF-C1790/WF-C20590:
WF-M20590/WF-M20590F:

2. Replace or reinstall the ink cartridge or maintenance box as indicated on the screen.

   **Note:** If any of the ink cartridges installed in the product is broken, incompatible with the product model, or improperly installed, Epson Status Monitor will not display an accurate ink status.

**Parent topic:** Check Cartridge and Maintenance Box Status

**Related tasks**
- Removing and Installing Ink Cartridges
- Replacing the Maintenance Box
Checking Cartridge and Maintenance Box Status - Mac

You can check the status of your ink cartridges and maintenance box using a utility on your Mac.

Note: You can continue printing while the low ink message is displayed. Replace the ink cartridges when required.

1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select Open Printer Utility.

2. Select EPSON Status Monitor.

You see this window:

WF-C17590/WF-C20590:
WF-M20590/WF-M20590F:

3. Do the following as necessary:
   • You can update the ink cartridge and maintenance box status by clicking Update.
   • Replace or reinstall the maintenance box or any ink cartridge as indicated on the screen.

   **Note:** If any of the cartridges installed in the product is broken, incompatible with the product model, or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

**Parent topic:** Check Cartridge and Maintenance Box Status  
**Related tasks**  
Removing and Installing Ink Cartridges  
Replacing the Maintenance Box
Purchase Epson Ink Cartridges and Maintenance Box

You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com (U.S. sales), epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

Note: This product is designed to work with genuine Epson inks. Non-Epson ink or any other ink not specified for this printer could cause damage not covered by Epson's warranties.

Ink Cartridge and Maintenance Box Part Numbers

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Ink Cartridge and Maintenance Box Part Numbers

Use these part numbers when you order or purchase new ink cartridges or maintenance boxes.

Maintenance box part number: T6713

WF-C17590

<table>
<thead>
<tr>
<th>Ink color</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>T8871</td>
</tr>
<tr>
<td>Cyan</td>
<td>T8872</td>
</tr>
<tr>
<td>Magenta</td>
<td>T8873</td>
</tr>
<tr>
<td>Yellow</td>
<td>T8874</td>
</tr>
</tbody>
</table>

WF-C20590

<table>
<thead>
<tr>
<th>Ink color</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>T8581</td>
</tr>
<tr>
<td>Cyan</td>
<td>T8582</td>
</tr>
<tr>
<td>Magenta</td>
<td>T8583</td>
</tr>
<tr>
<td>Yellow</td>
<td>T8584</td>
</tr>
</tbody>
</table>

WF-M20590/WF-M20590F
Removing and Installing Ink Cartridges

Make sure you have the replacement ink cartridge(s) handy before you begin. You must install new cartridges immediately after removing the old ones.

Caution: Leave your old cartridges in the printer until you are ready to replace them to prevent the print head nozzles from drying out. Do not open ink cartridge packages until you are ready to install the ink. Cartridges are vacuum packed to maintain reliability.

If an ink cartridge is low or expended, a message appears on your product's LCD screen. Note which ink cartridge needs to be replaced. Select How To and follow the steps on the LCD screen to remove and install the ink cartridges.

1. Open the ink cartridge cover.
2. Push in the ink cartridge that you want to remove until it pops out, then slowly pull it all the way out.

Note: Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.
3. Gently shake the new ink cartridge horizontally back and forth about 15 times, then remove it from its package.

**Caution:** Do not remove any labels or seals, or ink will leak. Do not touch the green chip or the ink supply port on the cartridge. Install the new cartridge immediately after removing the old one; if you do not, the print head may dry out and be unable to print.

![Image of ink cartridge](image)

**Warning:** If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away. Keep ink cartridges out of the reach of children.

4. Insert the new cartridge and push it all the way in until it clicks into place.
5. Close the ink cartridge cover.

The product starts charging the ink. This may take a few minutes. When the home screen appears, ink replacement is complete.

**Note:** Do not turn off the product while charging or you will waste ink.

**Caution:** If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the printer. The valve in the ink supply port is designed to contain any excess ink, but do not touch the ink supply port or surrounding area. Always store ink cartridges with the label facing up; do not store cartridges upside-down.

**Parent topic:** Replacing Ink Cartridges and Maintenance Boxes
Related concepts
Purchase Epson Ink Cartridges and Maintenance Box

Replacing the Maintenance Box

Make sure you have the replacement maintenance box handy before you begin.

Caution: Do not reuse a maintenance box that has been removed and left uninstalled for more than a week. Keep the maintenance box away from direct sunlight.

If the maintenance box is full, a message appears on your product's LCD screen. Select How To and follow the steps on the LCD screen to replace the maintenance box.

1. Open the front cover (L).
2. Push the maintenance box cover (H) tab and open the cover.
3. Pull the maintenance box all the way out.

Note: Do not tilt the used maintenance box or take it apart.

Caution: Be careful when removing the maintenance box; ink may leak when it is pulled out.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away. Keep the maintenance box out of the reach of children and do not drink the ink.
4. Remove the new maintenance box from its package.

   **Caution:** Do not touch the areas shown below on the maintenance box.

5. Insert the new maintenance box and push it all the way in.
6. Close the maintenance box cover (H).
7. Close the front cover (L). When the home screen appears, maintenance box replacement is complete.

**Parent topic:** Replacing Ink Cartridges and Maintenance Boxes

**Related concepts**

Purchase Epson Ink Cartridges and Maintenance Box

---

**Replacing the Optional Staple Cartridge**

Follow the steps below to replace the optional staple cartridge in the optional finisher unit.

You can purchase genuine Epson accessories at [epson.com](http://epson.com) (U.S. sales), [epson.ca](http://epson.ca) (Canadian sales), or [epson.com.jm](http://epson.com.jm) (Caribbean sales). You can also purchase accessories from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.
1. Open the front cover of the finisher unit.

2. Remove the staple cartridge holder.
3. Push in the tabs on the staple cartridge and lift it up to remove it from the holder.

Note: You can remove the staple cartridge from the holder only when it is empty.

4. Insert the new staple cartridge into the holder as shown and push it down firmly.

5. Insert the staple cartridge holder back into the finisher unit and push until it clicks into place.
6. Close the front cover of the finisher unit.

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Related references
Optional Accessories and Replacement Parts
Adjusting Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

If running these utilities does not solve the problem, you may need to replace the ink cartridges.

**Note:** Your product may differ from the images in this guide, but the instructions are the same unless otherwise noted.

Print Head Maintenance

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

**Note:** You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it when a cartridge is low. You must replace the cartridge first.

Checking the Nozzles Using the Product Control Panel
Cleaning the Print Head Using the Product Control Panel

Parent topic: Adjusting Print Quality

Related topics
Replacing Ink Cartridges and Maintenance Boxes

Checking the Nozzles Using the Product Control Panel

You can check the print head nozzles using the control panel on your product.

1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper into one of the paper cassettes.
3. Press the home button, if necessary.
4. Select Settings.
5. Select Maintenance.
   You see a screen like this:

   ![Settings screen with Maintenance tab]

   6. Select Print Head Nozzle Check.
You see a screen like this:

7. Select the paper cassette you want and select **OK**.
   The nozzle pattern prints.
8. Check the printed pattern to see if there are gaps in the lines.
   **Print head is clean**
   **WF-C17590/WF-C20590:**
9. Do one of the following:
   • If there are no gaps, select OK.
   • If there are gaps or the pattern is faint, select NG and continue.

10. Follow the instructions on the screen to clean the print head, check the nozzles, and repeat the process as necessary.

   **Caution:** Never turn off the product or open the front cover during a cleaning cycle or you may not be able to print.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without printing. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be replaced.

**Parent topic:** [Print Head Maintenance](#)
Cleaning the Print Head Using the Product Control Panel

You can clean the print head using the control panel on your product.

1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper into one of the paper cassettes.
3. Press the home button, if necessary.
4. Select Settings.
5. Select Maintenance.
   
   You see a screen like this:

6. Select Print Head Cleaning.
You see a screen like this:

![Print Head Cleaning Screen]

7. Select **Start** to clean the print head.
   When the cleaning cycle is finished, you see a message on the LCD screen.

   **Caution:** Never turn off the product or open the front cover during a cleaning cycle or you may not be able to print.

8. Select **Yes** to print a nozzle check pattern.
   If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without printing. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be replaced.

**Parent topic:** Print Head Maintenance

**Related tasks**
- Checking the Nozzles Using the Product Control Panel

**Related topics**
- Loading Paper
Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

**Note:** Your product may differ from the images in this guide, but the instructions are the same unless otherwise noted.

- Cleaning Your Product
- Cleaning the Automatic Document Feeder
- Cleaning the Paper Rollers
- Cleaning the Optional Bridge Unit
- Cleaning the Optional Finisher Unit
- Moving or Transporting Your Product

Cleaning Your Product

To keep your product working at its best, you should clean it several times a year.

**Caution:** Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it. Do not use oil or other lubricants inside the product or let water get inside it.

1. Turn off the product.
2. Unplug the power cord.
3. Disconnect any connected cables.
4. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.

Parent topic: Cleaning and Transporting Your Product

Cleaning the Automatic Document Feeder

You should clean the ADF if you see lines or streaks in your scanned images.

**Caution:** Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it. Do not use oil or other lubricants inside the product or let water get inside it.

1. Lift the scanner cover all the way up.
2. Clean the scanner glass and the glass area on the left with a soft, dry cloth. You can also use the cleaner tool stored inside the front cover of the product.

**Note:** If the glass is stained with grease or dirt, use a small amount of glass cleaner on a soft, dry cloth to remove it. Wipe off all remaining liquid after removing the dirt.

**Caution:** Do not spray glass cleaner directly on the glass and do not press the glass surface with any force.
3. Lift the edge of the document cover as shown and use a soft, dry cloth to clean the glass strip beneath the ADF.

4. Close the scanner cover.

**Parent topic:** Cleaning and Transporting Your Product

**Cleaning the Paper Rollers**

You can clean the paper rollers in the product to remove dust or ink if your printouts are blurry, smeared, or faint. You should clean the paper rollers about once a month or every 5000 prints.
Note: Depending on the printing environment or the paper type you use, you may need to clean the paper rollers more frequently.

1. ADF cover (F)
2. ADF paper feed rollers
3. Facedown paper eject tray (K)
4. Duplex rollers
1. Open the ADF cover (F).
2. Clean the ADF paper feed rollers with a soft cloth moistened with a little water.
3. Close the ADF cover (F).
4. Open the facedown paper eject tray (K).
5. Clean the duplex rollers with a soft cloth moistened with a little water.
6. Close the facedown paper eject tray (K).
7. Open the cover (J).
8. Clean the duplex rollers with a soft cloth moistened with a little water.
9. Close the cover (J).
10. Open the cover (E).
11. Clean the paper cassette feed rollers with a soft cloth moistened with a little water.
12. Close the cover (E).

**Parent topic:** [Cleaning and Transporting Your Product](#)  
**Related tasks**  
[Checking the Print Counter](#)
Cleaning the Optional Bridge Unit
You can clean the paper guides in the optional bridge unit to remove dust.
1. Open the paper guide (M1).
2. Clean the area with a soft cloth moistened with a little water.
3. Open the paper guide (M3).
4. Clean the area with a soft cloth moistened with a little water.
5. Close the paper guide (M3) and the paper guide (M1).
6. Open the paper guide (M2).
7. Clean the area with a soft cloth moistened with a little water.
8. Close the paper guide (M2).

**Parent topic:** Cleaning and Transporting Your Product
Cleaning the Optional Finisher Unit

You can clean the paper feed rollers and brushes in the optional finisher unit to remove dust.

1. Clean the paper ejection rollers in the finisher tray and the output tray with a soft cloth moistened with a little water.

1. Finisher tray
2. Output tray
2. Lightly wipe downward on the paper ejection brushes in the finisher tray and the output tray with a soft cloth moistened with a little water.

   **Caution:** Do not wipe upward on the paper ejection brushes or you may damage them.

**Parent topic:** Cleaning and Transporting Your Product

### Moving or Transporting Your Product

If you need to move or transport your product, contact Epson support or an authorized Epson service provider or technician.

**Caution:** At least four people are required to move the product.

**Parent topic:** Cleaning and Transporting Your Product

**Related references**

Where to Get Help
Solving Problems

Check these sections for solutions to problems you may have using your product.

Note: Your product may differ from the images in this guide, but the instructions are the same unless otherwise noted.

Viewing the Help Screen
Product Status Messages
Job Status Error Codes
Running a Product Check
Resetting Control Panel Defaults
Solving Setup Problems
Solving Network Problems
Solving Copying Problems
Solving Copy Quality Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving PostScript Printing Problems
Solving Page Layout and Content Problems
Solving Print Quality Problems
Solving Scanning Problems
Solving Scanned Image Quality Problems
Solving Faxing Problems
Solving USB Device Problems
Uninstall Your Product Software
Where to Get Help

Viewing the Help Screen
You can view troubleshooting or how-to topics on the LCD screen at any time.

1. Select the help icon.
You see this screen:

![Image of LCD screen with troubleshooting options]

2. Select a troubleshooting or How To option to view instructional images or animations.

Parent topic: Solving Problems

Product Status Messages

You can often diagnose problems with your product by checking the messages and status icons on its LCD screen. You can also check for errors by selecting **Job/Status > Printer Status**.

Note: If the LCD screen is dark, press the screen to wake the product from sleep mode.

<table>
<thead>
<tr>
<th>LCD screen message</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer error. Turn the power off and on again. For details, see your documentation.</td>
<td>Turn the product off and then back on again. If the error persists, check for and remove any jammed paper or protective materials from the product, and disconnect any optional installed units. If the error persists, contact Epson for support.</td>
</tr>
<tr>
<td>LCD screen message</td>
<td>Condition/solution</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Printer error. For details, see your documentation. Non-printing features are</td>
<td>The product may be damaged, but features such as scanning are still available. Contact Epson for support.</td>
</tr>
<tr>
<td>available.</td>
<td></td>
</tr>
<tr>
<td>Cannot print because XX is out of order. You can print from another cassette.</td>
<td>Turn the product off and then back on again. Reinsert the indicated paper cassette. If the error persists, contact Epson for support.</td>
</tr>
<tr>
<td>HDD error. Turn the power off and on again. If the error continues, contact</td>
<td>The hard disk drive is damaged. You may not be able to receive faxes (WF-C17590/WF-C20590/WF-M20590F) or copy or print documents that contain images. Contact Epson for support.</td>
</tr>
<tr>
<td>support.</td>
<td></td>
</tr>
<tr>
<td>XX is nearing the end of its service life.</td>
<td>A consumable part in your product needs to be replaced. Contact Epson for support.</td>
</tr>
<tr>
<td>You need to replace the following ink cartridge(s). Confirm the procedure, and</td>
<td>Replace the indicated ink cartridge(s).</td>
</tr>
<tr>
<td>then replace them.</td>
<td></td>
</tr>
<tr>
<td>No dial tone detected. (WF-C17590/WF-C20590/WF-M20590F)</td>
<td>Make sure the phone cable is connected correctly and the phone line works. If you connected the product to a PBX (Private Branch Exchange) phone line or Terminal Adapter, change the Line Type setting to PBX. If you still cannot send a fax, turn off the Dial Tone Detection setting. (Turning off the Dial Tone Detection setting may cause the product to drop the first digit of a fax number.)</td>
</tr>
<tr>
<td>Failed to receive faxes because the fax data capacity is full. Touch the Job/</td>
<td>Select Job/Status &gt; Printer Status and resolve any errors that are preventing faxes from printing. Make sure the product is connected to a computer and remove any connected external USB devices.</td>
</tr>
<tr>
<td>Status at the bottom of the Home Screen for details. (WF-C17590/WF-C20590/WF-M20590F)</td>
<td></td>
</tr>
<tr>
<td>The combination of the IP address and the subnet mask is invalid. See your</td>
<td>There is a problem with the network connection to your product. Set up your product on the network again.</td>
</tr>
<tr>
<td>documentation for more details.</td>
<td></td>
</tr>
<tr>
<td>To use cloud services, update the root certificate from the Epson Web Config</td>
<td>Access the Web Config utility and update the cloud service root certificate.</td>
</tr>
<tr>
<td>utility.</td>
<td></td>
</tr>
</tbody>
</table>
### LCD screen message

<table>
<thead>
<tr>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make sure the printer port is correctly configured. In Windows, make sure the port is set to a <strong>USBXXX</strong> setting for a USB connection or <strong>EpsonNet Print Port</strong> for a network connection.</td>
</tr>
</tbody>
</table>

Check that the printer driver is installed on the computer and that the port settings for the printer are correct.

Check that the printer driver is installed on the computer and that the USB port settings for the printer are correct.

Recovery mode

An error has occurred during firmware updating. Connect your product using a USB cable and try downloading the Firmware Update from the Epson support site. If you need help, contact Epson for support.

### Parent topic: Solving Problems

### Related references

Where to Get Help

### Related tasks

Accessing the Web Config Utility
Checking for Software Updates
Selecting the Line Type
Connecting a Telephone or Answering Machine
Removing and Installing Ink Cartridges

### Related topics

Wi-Fi or Wired Networking

### Job Status Error Codes

If a printing, scanning, copying, or faxing (WF-C17590/WF-C20590/WF-M20590F) job does not complete successfully, you can check the error code for the reason. Select **Job/Status > Job/Status** to view the error codes.

<table>
<thead>
<tr>
<th>Code</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>The product was turned off by a power failure.</td>
</tr>
<tr>
<td>101</td>
<td>Memory is full. Reduce the size of the print job.</td>
</tr>
<tr>
<td>Code</td>
<td>Condition/solution</td>
</tr>
<tr>
<td>------</td>
<td>--------------------</td>
</tr>
<tr>
<td>102</td>
<td>Collated printing has failed due to a lack of available memory. Reduce the size of the print job or print one copy at a time.</td>
</tr>
<tr>
<td>103</td>
<td>Print quality was decreased due to a lack of available memory. If the quality of the printout is unacceptable, try simplifying the page by reducing the number of graphics or the number and size of the fonts.</td>
</tr>
<tr>
<td>104</td>
<td>Reverse order printing has failed due to a lack of available memory. Reduce the size of the print job or print in standard order.</td>
</tr>
<tr>
<td>131</td>
<td>Collated printing has failed due to a lack of available memory. Reduce the size of the print job or change the collate settings.</td>
</tr>
<tr>
<td>106</td>
<td>Cannot print from the computer due to access control settings. Contact your product administrator.</td>
</tr>
<tr>
<td>107</td>
<td>User authentication failed and the job has been canceled. Contact your product administrator.</td>
</tr>
<tr>
<td>108</td>
<td>Confidential job data was deleted when the product was turned off.</td>
</tr>
<tr>
<td>109</td>
<td>The received fax was already deleted (WF-C17590/WF-C20590/WF-M20590F).</td>
</tr>
<tr>
<td>110</td>
<td>The job was printed 1-sided because the loaded paper does not support 2-sided printing.</td>
</tr>
<tr>
<td>111</td>
<td>Available memory is running low. Reduce the size of the print job.</td>
</tr>
<tr>
<td>120</td>
<td>Cannot communicate with a server using an open platform. Check the server or network for errors.</td>
</tr>
<tr>
<td>130</td>
<td>Collated printing has failed due to a lack of available memory. Reduce the size of the print job or change the collate settings.</td>
</tr>
<tr>
<td>132</td>
<td>Cannot print due to a lack of available memory. Reduce the size of the print job.</td>
</tr>
<tr>
<td>133</td>
<td>Cannot print 2-sided due to a lack of available memory. Only one side will print. Reduce the size of the print job.</td>
</tr>
<tr>
<td>141</td>
<td>HDD error. The job is canceled. Contact Epson for support.</td>
</tr>
<tr>
<td>151</td>
<td>Cannot print because the user name associated with the confidential job does not match.</td>
</tr>
<tr>
<td>201</td>
<td>The product's memory is full. You can send pages individually, or print received faxes and delete them to free up memory space (WF-C17590/WF-C20590/WF-M20590F).</td>
</tr>
<tr>
<td>202</td>
<td>The line was disconnected by the recipient's fax machine (WF-C17590/WF-C20590/WF-M20590F). Wait a moment, then try again.</td>
</tr>
<tr>
<td>Code</td>
<td>Condition/solution</td>
</tr>
<tr>
<td>-------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>203</td>
<td>The product cannot detect a dial tone (WF-C17590/WF-C20590/WF-M20590F). Make sure the phone cable is connected correctly and the phone line works. If you connected the product to a PBX (Private Branch Exchange) phone line or Terminal Adapter, change the <strong>Line Type</strong> setting to <strong>PBX</strong>. If you still cannot send a fax, turn off the <strong>Dial Tone Detection</strong> setting. (Turning off the Dial Tone Detection setting may cause the product to drop the first digit of a fax number.)</td>
</tr>
<tr>
<td>204</td>
<td>The recipient's fax machine is busy (WF-C17590/WF-C20590/WF-M20590F). Wait a moment, then try again.</td>
</tr>
<tr>
<td>205</td>
<td>The recipient's fax machine does not answer (WF-C17590/WF-C20590/WF-M20590F). Wait a moment, then try again.</td>
</tr>
<tr>
<td>206</td>
<td>The phone cable is incorrectly connected to the product's <strong>LINE</strong> and <strong>EXT</strong> ports (WF-C17590/WF-C20590/WF-M20590F). Connect the phone cable correctly.</td>
</tr>
<tr>
<td>207</td>
<td>The phone cable is not connected (WF-C17590/WF-C20590/WF-M20590F). Connect the phone cable.</td>
</tr>
<tr>
<td>208</td>
<td>The fax could not be sent to some of the specified recipients (WF-C17590/WF-C20590/WF-M20590F). Print a fax log to check which recipients failed to receive the fax. If the <strong>Save Failure Data</strong> setting is turned on, you can resend a fax by selecting <strong>Job Status</strong> in the Job/Status menu.</td>
</tr>
<tr>
<td>301</td>
<td>There is not enough storage space available to save the data in the external memory device. Clear space on the device or use a different device.</td>
</tr>
<tr>
<td>302</td>
<td>The external memory device is write-protected. Disable write protection.</td>
</tr>
<tr>
<td>303</td>
<td>No folder is available for saving the scanned file. Create a folder or use a different memory device.</td>
</tr>
<tr>
<td>304</td>
<td>The external memory device has been removed. Reinsert the device.</td>
</tr>
<tr>
<td>305</td>
<td>An error occurred while saving data to an external memory device. Reinsert the memory device or use a different device.</td>
</tr>
<tr>
<td>306</td>
<td>The product's memory is full. Wait until current jobs are finished processing.</td>
</tr>
<tr>
<td>Code</td>
<td>Condition/solution</td>
</tr>
<tr>
<td>------</td>
<td>--------------------</td>
</tr>
<tr>
<td>311</td>
<td>A DNS error has occurred. From the Home screen, select Settings &gt; General Settings &gt; Network Settings &gt; Advanced &gt; TCP/IP and check the DNS settings for the server, computer, or access point.</td>
</tr>
<tr>
<td>321</td>
<td>An authentication error has occurred. From the Home screen, select Settings &gt; General Settings &gt; Network Settings &gt; Advanced &gt; Email Server &gt; Server Settings and check the server settings.</td>
</tr>
<tr>
<td>411</td>
<td>A communication error has occurred. From the Home screen, select Settings &gt; General Settings &gt; Network Settings &gt; Advanced &gt; Email Server &gt; Server Settings and check the server settings.</td>
</tr>
<tr>
<td>421</td>
<td>The data size exceeds the maximum size for the attached files. From the Home screen, select Scan &gt; Email &gt; Scan Settings and scroll down to select Attached File Max Size. Increase the setting or lower the file size of the scanned image.</td>
</tr>
<tr>
<td>312</td>
<td>The memory is full. Wait for current jobs to finish and try again.</td>
</tr>
<tr>
<td>412</td>
<td>An authentication error occurred while scanning. From the Home screen, select Scan &gt; Network Folder/FTP &gt; Keyboard &gt; Location and check the settings.</td>
</tr>
<tr>
<td>313</td>
<td>A communication error has occurred while scanning. From the Home screen, select Scan &gt; Network Folder/FTP &gt; Keyboard &gt; Location and check the settings. You can also print a network status sheet to check the network connection.</td>
</tr>
<tr>
<td>413</td>
<td>A file with the same name already exists in the specified folder for scanning. Delete the duplicate file or change the file name prefix. From the Home screen, select Scan &gt; Network Folder/FTP &gt; Scan Settings &gt; File Settings.</td>
</tr>
<tr>
<td>322</td>
<td>There is not enough storage space available in the specified folder. Increase the storage space in the specified folder, delete unnecessary files, or lower the file size of the scanned image.</td>
</tr>
<tr>
<td>323</td>
<td>The destination for scanning was wrong or the destination does not exist. From the Home screen, select Scan &gt; Network Folder/FTP &gt; Keyboard &gt; Location and check the settings.</td>
</tr>
<tr>
<td>324</td>
<td>The scanned image size exceeds the maximum limit for the Network Folder/FTP scan option. Lower the scanning resolution or increase the compression ratio.</td>
</tr>
<tr>
<td>Code</td>
<td>Condition/solution</td>
</tr>
<tr>
<td>-------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>332</td>
<td>There is not enough space available for saving the scanned files in the specified folder. Delete unnecessary files from the specified folder.</td>
</tr>
<tr>
<td>333</td>
<td>The destination could not be found because the destination information was uploaded to the server before sending the scanned data. Select the destination again.</td>
</tr>
<tr>
<td>334</td>
<td>An error occurred while sending the scanned data.</td>
</tr>
<tr>
<td>341</td>
<td>A communication error has occurred while scanning. Make sure the product is connected to the computer or network correctly and that you installed Document Capture Pro or Document Capture. Make sure the Event Manager program is not being blocked by your firewall or security software.</td>
</tr>
<tr>
<td>422</td>
<td>An authentication error has occurred while faxing (WF-C17590/WF-C20590/WF-M20590F). From the Home screen, select Settings &gt; General Settings &gt; Fax Settings &gt; Receive Settings &gt; Save/Forward Settings and check the settings for the folder selected in Destination.</td>
</tr>
<tr>
<td>423</td>
<td>A communication error has occurred while faxing (WF-C17590/WF-C20590/WF-M20590F). From the Home screen, select Settings &gt; General Settings &gt; Fax Settings &gt; Receive Settings &gt; Save/Forward Settings. Select the arrow icon at the end of an entry and check the Save/Forward Destination setting. You can also print a network status sheet to check the network connection.</td>
</tr>
<tr>
<td>425</td>
<td>There is not enough storage space available in the forwarding destination folder for faxing (WF-C17590/WF-C20590/WF-M20590F). Increase the storage space.</td>
</tr>
<tr>
<td>428</td>
<td>The destination for faxing was wrong or the destination does not exist (WF-C17590/WF-C20590/WF-M20590F). From the Home screen, select Settings &gt; General Settings &gt; Fax Settings &gt; Receive Settings &gt; Save/Forward Settings. Select the arrow icon at the end of an entry and check the Save/Forward Destination setting.</td>
</tr>
</tbody>
</table>

Parent topic: Solving Problems

Related tasks
Connecting a Telephone or Answering Machine
Saving and Viewing Received Faxes
Selecting the Line Type
Selecting Advanced Fax Settings
Setting User Feature Restrictions (Access Control)
Entering a User ID and Password for Printing
Running a Product Check

Running a product check helps you determine if your product is operating properly.

1. Disconnect any interface cables connected to your product.
2. Load plain paper in the product.
3. Press the home button, if necessary.
4. Select Settings.
5. Select Maintenance.

You see a screen like this:

6. Select Print Head Nozzle Check.
You see a screen like this:

![Print Head Nozzle Check](image)

7. Select a paper cassette and select **OK**.
   The nozzle pattern prints.

8. Do one of the following, depending on the results of the product check:
   - If the page prints and the nozzle check pattern is complete, the product is operating properly. Any operation problem you may have could be caused by your computer, cable, software, or selected settings. Check the other solutions in this book or try uninstalling and reinstalling your printer software.
   - If the page prints but the nozzle check pattern has gaps, clean the print head.
   - If the page does not print, the product may have a problem. Check the other solutions in this manual. If they do not work, contact Epson.

**Parent topic:** Solving Problems

**Related concepts**

**Uninstall Your Product Software**
Resetting Control Panel Defaults

If you have a problem with settings on the product control panel, you can reset them to their factory defaults. You can choose which settings to reset or reset them all.

Note: This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

Note: This product automatically stores names, telephone numbers, and fax data in its internal memory log when faxing or emailing jobs. This product also contains an encrypted hard drive that is used for storing large and/or authenticated print, copy and scan jobs. You may erase data stored on the encrypted hard drive by following the steps outlined in the Administrator's Guide. It is recommended that data is erased before disposing or giving away the product.

1. Press the ⏪ home button, if necessary.
2. Select Settings.
4. Select System Administration. Enter the administrator password, if necessary.
5. Select Restore Default Settings.
You see a screen like this:

6. Select one of these options:
   • **Network Settings**: Resets all network settings.
   • **Copy Settings**: Resets all settings for copying.
   • **Scan Settings**: Resets all settings for scanning.
   • **Fax Settings** (WF-C17590/WF-C20590/WF-M20590F): Resets all settings for faxing.
   • **Clear All Data and Settings**: Resets all control panel settings including the contacts list.

   You see a confirmation screen.

7. Select **Yes** to reset the selected settings. (Select **No** if you want to cancel the operation.)

   **Parent topic**: Solving Problems

**Solving Setup Problems**

Check these sections if you have problems while setting up your product.

**Product Does Not Turn On or Off**
Noise After Ink Installation
Software Installation Problems
Parent topic: Solving Problems

Product Does Not Turn On or Off
If you cannot turn the product on or off, try these solutions:

• If you cannot turn on your product, make sure the power cord is securely connected and hold down the power button a little longer.

• If you cannot turn off your product, hold down the power button a little longer. If you still cannot turn off your product, unplug the power cord, plug the power cord back in, then turn your product on and off again using the power button.

• Make sure the circuit breaker is in the ON position. If the circuit breaker is off, turn it on and turn on the power. If the circuit breaker turns off quickly, unplug the power cord and contact Epson.

Parent topic: Solving Setup Problems
Related tasks
Checking the Circuit Breaker

Noise After Ink Installation
If you hear noises from your product after installing ink, check the following:

• The first time you install the ink cartridges, the product must charge its print head. Wait until charging finishes before you turn off the product, or it may charge improperly and use excess ink the next time you turn it on.

• If the product's print head stops moving or making noise, and the charging process has not finished after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems

Software Installation Problems
If you have problems while installing your product software, try these solutions:

• Make sure your product is turned on and any necessary cables are securely connected at both ends. Also make sure your system meets the requirements for your operating system. If you still have problems installing software, contact your system administrator.
• Close any other programs, including screen savers and virus protection software, and install your product software again.

• In Windows, make sure your product is selected as the default printer and the correct port is shown in the printer properties.

• If you see any error message or your software does not install correctly in Windows, you may not have software installation privileges. Contact your system administrator.

• If you are printing over a network, make sure your product is set up properly on the network.

Parent topic: Solving Setup Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
Mac System Requirements

Solving Network Problems

Check these solutions if you have problems setting up or using your product on a network.

Note: Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is not responsible for backing up or recovering data and settings during or after the warranty period. We recommend that you make your own backup or print out your fax and network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network
Product Does Not Appear in Mac Printer Window
Cannot Print Over a Network
Cannot Scan Over a Network

Parent topic: Solving Problems

Product Cannot Connect to a Wireless Router or Access Point

If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product’s LCD screen is not lit or does not appear, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.
• Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

**Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

• Verify that your router or access point is operating correctly by connecting to it from your computer or another device.

• Print a network connection report and check the codes and messages on the report to help determine the cause of the problem.

• You may need to disable the firewall and any anti-virus software on your wireless router or access point.

• Try restarting your router following the instructions in your router documentation.

**Note:** If you are reading these instructions online, you will lose your Internet connection when you restart your router.

• Check to see if access restrictions, such as MAC address filtering, are set on the router or access point. If access restrictions are set, add your product's MAC address to your router's address list. To obtain your product's MAC address, print a network status sheet. Then follow the instructions in your router or access point documentation to add the address to the list.

• If your router or access point does not broadcast its network name (SSID), follow the instructions that came with your product to enter your wireless network name manually.

• If your router or access point has security enabled, determine the kind of security it is using and any required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA passphrase correctly.

• Check if your computer is restricting the available wireless channels. If so, verify that your wireless access point is using one of the usable channels and change to a usable channel, if necessary.

• If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection settings from your device and enter a new password. See your device documentation for instructions.
• If you connected your product to a Windows computer using Wi-Fi Direct and it automatically selected Access Point Mode, you may have trouble accessing a low-priority Internet connection. Check the network connection or adapter settings in the Windows Control Panel and set the Internet metric setting to 100 for your version of the Internet Protocol.

Parent topic: Solving Network Problems

Related concepts
Wi-Fi Direct Mode Setup

Related tasks
Selecting Wireless Network Settings from the Control Panel
Printing a Network Status Sheet

Related topics
Wi-Fi or Wired Networking

Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:
• Make sure your product is turned on and connected to your network. Verify the connection using your product control panel.
• Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-ASCII characters.
• Make sure your product is not connected to a guest network.
• If necessary, reinstall your product software and try running EpsonNet Setup again:
  1. Reset your product’s network settings to their factory defaults.
  2. Windows only: Uninstall your product software.
  3. Restart your router following the instructions in your router documentation.

  Note: If you are reading these instructions online, you will lose your Internet connection when you restart your router, so note the next step before restarting it.

  4. Download your product software from the Epson website, or contact your system administrator.
• If you have replaced your router, reinstall your product software to connect to the new router.

  Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

- Check to see if your wireless router or access point has an enabled Privacy Separator function that is preventing detection of your device over the network. See your router or access point documentation for instructions on disabling the Privacy Separator function.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related topics
Wi-Fi or Wired Networking

Product Does Not Appear in Mac Printer Window

If your product does not appear in the Mac printer window, try these solutions:

- Turn your product off, wait 30 seconds, then turn it back on again.

- If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product's LCD screen is not lit, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.

- If you are connecting the product wirelessly via EpsonNet Setup and you do not see the Wi-Fi antenna icon with connection bars on your LCD screen, make sure your product software was installed correctly. If necessary, reinstall your software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Cannot Print Over a Network

If you cannot print over a network, try these solutions:

- Make sure that your product is turned on.
• Make sure you install your product’s network software as described in your product documentation, or contact your system administrator.

• Print a network status sheet and verify that the network settings are correct. If the network status is **Disconnected**, check any cable connections and turn your product off and then on again.

• Print a network connection report and check the codes and messages on the report to help determine the cause of the problem.

• If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your network does not assign IP addresses using DHCP, set the IP address manually.

• Make sure your computer and product are both using the same wireless network.

• If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place your product closer to your router or access point. Avoid placing your product near a microwave oven, cordless phone, or large metal object, such as a filing cabinet.

**Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

• Try restarting your router following the instructions in your router documentation.

**Note:** If you are reading these instructions online, you will lose your Internet connection when you restart your router.

• Check to see if your wireless router or access point has an enabled Privacy Separator function that is preventing printing from a device over the network. See your router or access point documentation for instructions on disabling the Privacy Separator function.

• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product’s LCD screen is not lit, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.

• Check your wired LAN router or access point to see if the LED for the port to which your product is connected is on or flashing. If the link LED is off, try the following:
  • Make sure the Ethernet cable is securely connected to your product and to your router, access point, switch, or hub.
  • Try connecting your product to a different port or a different router, access point, switch, or hub.
  • Try connecting with a different Ethernet cable.
• Try printing to your product from another computer on the network.

**Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

• If you are connecting the product via EpsonNet Setup and the Wi-Fi icon does not appear lit on the LCD screen, make sure your product software was installed correctly. If necessary, reinstall your software.

**Parent topic:** Solving Network Problems

**Related concepts**

Uninstall Your Product Software

**Related tasks**

Printing a Network Status Sheet

**Related topics**

Wi-Fi or Wired Networking

### Cannot Scan Over a Network

If you have problems scanning over a network, try these solutions:

• If you cannot scan from your product control panel, make sure you restarted your computer after installing the product software. Make sure the Event Manager program is not being blocked by your firewall or security software.

**Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

• If you are scanning a large original at a high resolution, a network communication error may occur. Try scanning again at a lower resolution.

• If network communication was interrupted while starting Epson Scan 2, exit Epson Scan 2, wait a few seconds, and restart it. If Epson Scan 2 cannot restart, turn off your product, turn it back on, and try restarting Epson Scan 2 again.
Check the scanner setting and reset the connection if necessary using Epson Scan 2 Utility:

**Windows 10:** Click and select **EPSON > Epson Scan 2 Utility.** Make sure your product is selected. If necessary, select the **Other** tab and click **Reset.**

**Windows 8.x:** Navigate to the **Apps** screen, select **EPSON,** and select **Epson Scan 2 Utility.** Make sure your product is selected. If necessary, select the **Other** tab and click **Reset.**

**Windows (other versions):** Click or **Start > All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan 2 Utility.** Make sure your product is selected. If necessary, select the **Other** tab and click **Reset.**

**Mac:** Open the **Applications** folder, click **Epson Software,** and click **Epson Scan 2 Utility.** Make sure your product is selected. If necessary, select the **Other** tab and click **Reset.**

- You may need to disable the firewall and any anti-virus software on your wireless router or access point.

**Parent topic:** Solving Network Problems

**Related tasks**
- **Starting a Scan Using the Product Control Panel**
- **Starting a Scan Using the Epson Scan 2 Icon**
- **Entering a User ID and Password for Scanning**

**Solving Copying Problems**

Check these solutions if you have problems copying with your product.

**Product Cannot Copy**

**Product Makes Noise, But Nothing Copies**

**Product Makes Noise When It Sits for a While**

**Originals Do Not Feed From the Automatic Document Feeder**

**Parent topic:** Solving Problems

**Product Cannot Copy**

If your product cannot make copies, try these solutions:

- If user restriction has been enabled, you may need to enter a user name and password. Contact your administrator for assistance.
- If the product has an error, such as a paper jam, you cannot make copies. Check the LCD screen for any errors, and follow the onscreen instructions to clear the error.
Product Makes Noise, But Nothing Copies

If your product makes a noise, but nothing copies, try these solutions:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• If the nozzle check page does not print, but the product's power is on, make sure your product software is installed correctly.
• Make sure your product is level (not tilted).

Parent topic: Solving Copying Problems
Related tasks
Checking the Nozzles Using the Product Control Panel

Product Makes Noise When It Sits for a While

Your product is performing routine maintenance. This is normal.

Parent topic: Solving Copying Problems

Originals Do Not Feed From the Automatic Document Feeder

If your originals do not feed when placed in the ADF, try these solutions:

• Make sure the ADF icon lights up on the Copy, Fax, or Scan screen on the LCD screen. If not, reload the originals.
• Make sure the size, weight, and number of your originals are supported by the ADF.
• Make sure the originals are loaded correctly.
• Make sure the document is not curled or creased.
• Try cleaning the inside of the ADF.
• Do not load originals above the arrow mark on the ADF edge guide.

Parent topic: Solving Copying Problems
Related references
Automatic Document Feeder (ADF) Specifications

Related tasks
Placing Originals in the Automatic Document Feeder
Cleaning the Automatic Document Feeder

Solving Copy Quality Problems
Check these sections if your copies have a quality problem.

Copies Have Incorrect or Faint Colors
Position, Size, or Margins of Copies are Incorrect

Parent topic: Solving Problems

Copies Have Incorrect or Faint Colors
If your copies have incorrect, uneven, smeared, or faint colors, try these solutions:

- Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if necessary.
- Do not press too hard on the original when you copy from the scanner glass.
- Clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the cloth, if necessary. Paper towels are not recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

- Clean the ADF.
- If the colors are smeared, try lowering the copy density setting on the LCD screen.

Parent topic: Solving Copy Quality Problems

Related tasks
Checking the Nozzles Using the Product Control Panel
Cleaning the Automatic Document Feeder

Position, Size, or Margins of Copies are Incorrect
If the position, size, or margins of your copies are incorrect, try these solutions:

- When placing originals in the ADF, make sure the edge guides are against the edges of the paper.
• When placing originals on the scanner glass, make sure the original is placed correctly for scanning. Align the corner of the original with the corner indicated by the symbol on the scanner glass. If necessary, move the original away from the edges of the scanner glass slightly.
• Clean the scanner glass and ADF.
• Make sure the paper is loaded in the correct direction.
• Select the appropriate original size copy setting on the LCD screen.

**Parent topic:** Solving Copy Quality Problems

**Related tasks**
- Placing Originals in the Automatic Document Feeder
- Cleaning the Automatic Document Feeder

---

**Solving Paper Problems**

Check these sections if you have problems using paper with your product.

**Paper Feeding Problems**
- If you have problems feeding paper, try these solutions:
  • Make sure the paper cassette is inserted all the way in the printer.
  • If paper does not feed correctly, remove and reload it in the cassette and adjust the edge guides. Make sure the paper stack is not above the tab on the edge guides inside the cassette.
  • If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
  • Do not load more than the recommended number of sheets.
  • Make sure your paper meets the specifications for your product.
  • If paper jams when you print on both sides of the paper, try loading fewer sheets.
  • For best results, follow these guidelines:
    • Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
    • Load paper in the cassette printable side down.
    • Follow any special loading instructions that came with the paper.
Paper Jam Problems
If a paper jam occurs in the product, a message appears on the LCD screen. Follow the on-screen instructions to locate the paper jam and remove the paper.

Related references
Paper Jam Problems
Paper Loading Capacity
Paper Specifications
Related topics
Loading Paper

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:

- If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper. Select the correct paper size when you reprint.
- If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select the correct paper type setting when you reprint.

Related tasks
Viewing the Help Screen

Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.

Note: For problems while printing with the Epson Universal Print Driver or PostScript (PS3) printer software, see the sections covering that software in this manual.

Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Printing is Slow
Nothing Prints

If you have sent a print job and nothing prints, try these solutions:

• Make sure your product is turned on and connected to your computer.
• Make sure any interface cables are connected securely at both ends.
• If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print, connect your product directly to your computer instead of the hub.
• Make sure the printer status is not offline or pending.
• Run a product check to see if a test page prints. If the test page prints, check to see if your product software is installed correctly.
• Make sure your system meets the requirements for your operating system. If you are printing a high-resolution image, you may need more than the minimum requirements. Print the image at a lower resolution or if necessary, increase your system's memory.
• In Windows, make sure your product is selected as the default printer and the printer port setting matches the printer connection port.
• In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in the printer settings window, and cancel any stalled print jobs.
• On a Mac, make sure the printer is added to the printer list and the printer is not paused.
• Make sure the Printing Language in the Settings menu is set to Auto or PS3.
• Make sure your product is selected as the printer in your printing program.

Parent topic: Solving Problems Printing from a Computer
Related tasks
Running a Product Check
Entering a User ID and Password for Printing

Product Icon Does Not Appear in Windows Taskbar

If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does not work, try this solution:

1. Do one of the following:

   • Windows 10: Click 📧 and select 📦 (Settings) > Devices > Printers & scanners. Select your product name and select Manage > Printing preferences.
• **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click your product name, select Printing Preferences, and select your product name again if necessary.

• **Windows 7**: Click and select Devices and Printers. Right-click your product name, select Printing Preferences, and select your product name again if necessary.

• **Windows Vista**: Click , select Control Panel, and click Printer under Hardware and Sound. Right-click your product name, select Printing Preferences, and select your product name again if necessary.

• **Windows XP**: Click Start and select Printers and Faxes. (Or open the Control Panel, select Printers and Other Hardware, if necessary, and Printers and Faxes.) Right-click your product name, select Printing Preferences, and select your product name again if necessary.

2. Click the Maintenance tab.
3. Click the Extended Settings button.
4. Select Enable EPSON Status Monitor 3 and click OK.
5. Click the Monitoring Preferences button.
6. Click the checkbox for the option that adds the shortcut icon to the taskbar.
7. Click OK to close the open program windows.

**Parent topic:** Solving Problems Printing from a Computer

**Printing is Slow**

If printing becomes slow, try these solutions:

- Make sure your system meets the requirements for your operating system. If you are printing a high-resolution image, you may need more than the minimum requirements. If necessary, increase your system's memory.

- If you are using Windows 7, close the Devices and Printers window before you print.

- Make sure Quiet Mode is turned off.

- Clear space on your hard drive or run a defragmentation utility to free up existing space.

- Close any programs you are not using when you print.

- If your product is connected to a USB hub, connect it directly to your computer instead.
• If printing becomes slower after printing continuously for a long time, the product may have automatically slowed down to protect the print mechanism from overheating or becoming damaged. Let the product rest with the power on for 30 minutes, then try printing again.

• If you are printing over a wireless network, factors such as interference, network traffic, or weak signal strength may affect your printing speed.

  **Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

• If you are using the Windows PostScript printer software, try selecting **Fast** as the **Print Quality** setting on the Advanced tab of the printer software.

For the fastest printing, select the following settings in your product software:

• Make sure the paper type setting matches the type of paper you loaded.

• Turn on any high speed settings in your product software.

• Select a lower print quality setting.

• **Windows:** Click the **Maintenance** or **Utility** tab, select **Extended Settings** or **Speed and Progress**, and select the following settings:

  • **Always Spool RAW Datatype**
  • **Page Rendering Mode**
  • **Print as Bitmap**

If printing is still slow and you are using Windows 7 or Windows Vista, try the following:

1. Click 📋 and select **Computer** or **My Computer**. Double-click the C: drive and open these folders: **ProgramData > EPSON > PRINTER**.

   **Note:** If you do not see the ProgramData folder, open the Organize menu and select **Folder and search options**. In the window that appears, click the View tab, select **Show hidden files, folders, and drives** in the Advanced settings list, and click **OK**.

2. Right-click the EPAUDF01.AUD file and select **Delete**.
3. Restart your computer and try printing again.

**Parent topic:** Solving Problems Printing from a Computer
Related references
Windows System Requirements
Mac System Requirements
Paper or Media Type Settings - Printing Software

Related tasks
Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Mac

Solving PostScript Printing Problems
Check these solutions if you have problems using the PostScript printing software.

Nothing Prints Using the PostScript Printing Software
If your document doesn't print, try these solutions:
• Make sure your product is turned on and connected to your computer.
• Make sure the Printing Language in the Settings menu is set to Auto or PS3.
• Make sure your product is selected as the printer in your printing program.

Parent topic: Solving Problems

Related topics
Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Documents Print Incorrectly Using the PostScript Printing Software
If your document does not print correctly, try these solutions:
• If the file you are printing was created in an application that allows you to change the data format, such as Adobe Photoshop, make sure the settings in the application match the printer software settings.
• EPS files created in binary format may not print correctly. Try creating the file in ASCII format instead.
• In Windows, the product cannot print binary data if it is connected to the computer using a USB cable. Try selecting ASCII or TBCP as the Output Protocol setting on the Device Settings tab in the printer properties.

• In Windows, select the appropriate substitution fonts on the Device Settings tab in the printer properties.

• In Windows, if the printed colors are incorrect, try adjusting the Color Mode setting on the Advanced tab of the printer software.

• In Windows, if printing is slow, try selecting Fast as the Print Quality setting on the Advanced tab of the printer software.

Parent topic: Solving PostScript Printing Problems

Related tasks
Accessing Printer Properties - PostScript - Windows

Accessing Printer Properties - PostScript - Windows

You can access the printer properties to view and change product settings for PostScript printing.

1. Do one of the following:

   • **Windows 10**: Click and select (Settings) > Devices > Printers & scanners. Select your product name and select Manage > Printer properties.

   • **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click the postscript driver for your product, and select Printer properties.

   • **Windows 7**: Click and select Devices and Printers. Right-click the postscript driver for your product and select Printer properties.

   • **Windows Vista**: Click and select Control Panel. Click Printer under Hardware and Sound, then right-click the postscript driver for your product and select Properties.

   • **Windows XP**: Click Start and select Printers and Faxes. Right-click the postscript driver for your product and select Properties.

2. Click any tab to view and change the printer property settings.

Parent topic: Solving PostScript Printing Problems

Solving Page Layout and Content Problems

Check these sections if you have problems with the layout or content of your printed pages.
Inverted Image

If your printed image is inverted unexpectedly, try these solutions:

• Turn off any mirror or inversion settings in your printing application.
• Turn off the **Mirror Image**, **Flip horizontally**, or **Reverse page orientation** settings in your printer software. (This option has different names, depending on your operating system version.)

**Parent topic:** Solving Page Layout and Content Problems

**Related tasks**

- Selecting Additional Print Options - Windows
- Selecting Print Layout Options - Mac

Too Many Copies Print

Make sure that the **Copies** setting in your printing program or printer software is not set for multiple copies.

**Parent topic:** Solving Page Layout and Content Problems

**Related tasks**

- Selecting Basic Print Settings - Windows
- Selecting Basic Print Settings - Mac

Blank Pages Print

If blank pages print unexpectedly, try these solutions:

• Make sure you selected the correct paper size settings in your printing program and printer software.
• If a blank page exists in a document you are printing and you want to skip printing it, select the **Skip Blank Page** setting in your printer software, if available.
• Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if necessary.
• Make sure your product is selected as the printer in your printing program.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Checking the Nozzles Using the Product Control Panel
Cleaning the Print Head Using the Product Control Panel
Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• Make sure you selected the correct margins for your paper size in your printing program.
• Make sure your paper is positioned correctly for feeding into the product.
You can use the preview option in your printer software to check your margins before you print.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac

Related topics
Loading Paper

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
• Make sure any cables are securely connected at both ends.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If you are using the PostScript printer software, EPS files created in binary format may not print correctly. Try creating the file in ASCII format instead.
• If you are using the Windows PostScript printer software, the product cannot print binary data if it is connected to the computer using a USB cable. Try selecting ASCII or TBCP as the Output Protocol setting on the Device Settings tab in the printer properties.
• If you are using the Windows PostScript printer software, select the appropriate substitution fonts on the Device Settings tab in the printer properties.

**Parent topic:** Solving Page Layout and Content Problems

---

**Incorrect Image Size or Position**

If your printed image is the wrong size or in the wrong position, try these solutions:

• Make sure you selected the correct paper size and layout settings in your printing program and printer software.
• Make sure you selected the correct paper size on the control panel.
• Make sure your paper is positioned correctly for feeding into the printer.
• Clean the scanner glass and document cover.
• If the edges of a copy are cropped, slightly move the original away from the edges of the scanner glass.

You can use the preview option in your printer software to check your margins before you print.

**Parent topic:** Solving Page Layout and Content Problems

**Related tasks**

- Selecting Basic Print Settings - Windows
- Selecting Additional Print Options - Windows
- Selecting Basic Print Settings - Mac
- Selecting Page Setup Settings - Mac
- Cleaning the Automatic Document Feeder

---

**Slanted Printout**

If your printouts are slanted, try these solutions:

• Slide the edge guides against the edges of the paper.
• Select a higher print quality setting in your printer software.
• Turn off any high speed settings in your product software.
• Adjust the print quality.
• Make sure the product is not printing while tilted or at an angle.

**Parent topic:** Solving Page Layout and Content Problems

**Related tasks**

Selecting Basic Print Settings - Windows  
Selecting Basic Print Settings - Mac

**Related topics**

Loading Paper

---

### Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your computer screen.

- White or Dark Lines in Printout
- Blurry or Smeared Printout
- Faint Printout or Printout Has Gaps
- Grainy Printout
- Incorrect Colors

**Parent topic:** Solving Problems

---

### White or Dark Lines in Printout

If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.

• Make sure the paper type setting matches the type of paper you loaded.

• Make sure you loaded the printable side of the paper correctly for your product.

• Turn off any high speed settings in your product software.

• Adjust the print quality in the product software.

• If you continue to see horizontal bands or streaks in your printouts after cleaning the print head and adjusting the print quality, make print quality adjustments for each paper type.

• You may need to replace the ink cartridges.

**Parent topic:** Solving Print Quality Problems
Blurry or Smeared Printout

If your printouts are blurry or smeared, try these solutions:

• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Use a support sheet with special paper, or load special paper one sheet at a time.
• Make sure your paper meets the specifications for your product.
• Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
• Make sure the paper type setting in your product software matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• If you are printing on thick paper, select a thick paper Paper Type setting on the control panel.
• Remove each sheet from the output tray as it is printed.
• Avoid handling printouts on glossy paper right after printing to allow the ink to set.
• Turn off any high speed settings in your product software.
• If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first. Adjust the density and/or ink drying time settings.
• Lower the copy density setting on the product control panel.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• Adjust the print quality in the product software.
• Clean the paper rollers.
Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems

Related references
Compatible Epson Papers
Paper Specifications

Related tasks
Checking the Nozzles Using the Product Control Panel
Cleaning the Print Head Using the Product Control Panel
Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Additional Print Options - Windows
Cleaning the Paper Rollers

Faint Printout or Printout Has Gaps

If your printouts are faint or have gaps, try these solutions:

- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- The ink cartridges may be old or low on ink, and you may need to replace them.
- Make sure the paper type setting matches the type of paper you loaded.
- Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
- Adjust the print quality in the product software.
- Clean the paper rollers.

Parent topic: Solving Print Quality Problems

Related references
Paper or Media Type Settings - Printing Software

Related tasks
Checking the Nozzles Using the Product Control Panel
Cleaning the Print Head Using the Product Control Panel
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Grainy Printout

If your printouts are grainy, try these solutions:

- Make sure you loaded the printable side of the paper correctly for your product.
- Select a higher print quality setting and turn off any high speed settings in your product software.
- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- Adjust the print quality in the product software.
- You may need to increase the image resolution or print a smaller size; see your software documentation.

**Note:** Images from the Internet may be low resolution and not result in a high quality printout.

- If you enlarged the image size in an image-editing program, you need to increase the image resolution setting to retain a high image quality. Increase the image resolution by the same amount you increase the image size. For example, if the image resolution is 300 dpi (dots per inch) and you will double the image size for printing, change the resolution setting to 600 dpi.

**Note:** Higher resolution settings result in larger file sizes, which take longer to process and print. Consider the limitations of your computer system when selecting a resolution, and select the lowest possible resolution that produces acceptable quality to keep file sizes manageable.

**Parent topic:** Solving Print Quality Problems

**Related tasks**

- Checking the Nozzles Using the Product Control Panel
- Cleaning the Print Head Using the Product Control Panel
- Selecting Basic Print Settings - Windows
- Selecting Additional Print Options - Windows
- Selecting Basic Print Settings - Mac
- Selecting Printing Preferences - Mac
Incorrect Colors

If your printouts have incorrect colors (WF-C17590/WF-C20590), try these solutions:

- Make sure the paper type setting matches the paper you loaded.
- Make sure the Black/Grayscale or Grayscale setting is not selected in your printer software.
- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- The ink cartridges may be old or low on ink, and you may need to replace them.
- After you print, the colors in your printout need time to set as the ink dries. During this time, the colors may look different than you expect. To speed up drying time, do not stack your printouts on top of each other.
- Your printed colors can never exactly match your on-screen colors. However, you can use a color management system to get as close as possible. Try using the color management options in your printer software.
- If you are using the Windows PostScript printer software, try adjusting the Color Mode setting on the Advanced tab of the printer software.
- For best results, use genuine Epson paper.

Parent topic: Solving Print Quality Problems

Related references

Compatible Epson Papers

Related tasks

Checking the Nozzles Using the Product Control Panel
Cleaning the Print Head Using the Product Control Panel
Selecting Basic Print Settings - Windows
Selecting Additional Print Options - Windows
Selecting Basic Print Settings - Mac
Managing Color - Mac

Solving Scanning Problems

Check these solutions if you have problems scanning with your product.
Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan 2
Parent topic: Solving Problems

Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:

• Make sure your computer has adequate memory and meets the system requirements for your operating system.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so, wake your system and restart your scanning software.
• If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.
• In Windows, make sure your product is listed as a valid device in the **Scanners and Cameras** control panel.

Parent topic: Solving Scanning Problems
Related references
Windows System Requirements
Mac System Requirements
Related tasks
Uninstalling Product Software - Windows
Uninstalling Product Software - Mac

Cannot Start Epson Scan 2
If you cannot start Epson Scan 2, try these solutions:

• Make sure your product is turned on and any interface cables are securely connected at both ends.
• Make sure Epson Scan 2 is selected as your scanning program.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so, wake your system and restart Epson Scan 2.
• Check the connection setting and test the connection using Epson Scan 2 Utility:

  **Windows 10**: Click `EPSON` and select **Epson Scan 2 Utility**. Make sure the correct product is selected. If necessary, select the **Other** tab and click **Reset**.

  **Windows 8.x**: Navigate to the **Apps** screen and select **Epson Scan 2 Utility**. Make sure the correct product is selected. If necessary, select the **Other** tab and click **Reset**.
Windows (other versions): Click 📱 or Start > All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other tab and click Reset.

Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other tab and click Reset.

• Make sure you do not have multiple versions of Epson Scan 2 installed. If you do, uninstall both versions and install one version.
• If you upgraded your operating system but did not reinstall Epson Scan 2, try reinstalling it.
• If the user restriction feature (Access Control) is enabled, a user ID and password are required to scan. If you do not know the user ID or password, contact your administrator for assistance.

Parent topic: Solving Scanning Problems

Related tasks
Starting a Scan Using the Epson Scan 2 Icon
Entering a User ID and Password for Scanning

Solving Scanned Image Quality Problems

Check these sections if a scanned image on your computer screen has a quality problem.

Image Consists of a Few Dots Only
Line of Dots Appears in All Scanned Images
Straight Lines in an Image Appear Crooked
Image is Distorted or Blurry
Image Colors are Patchy at the Edges
Image is Too Dark
Back of Original Image Appears in Scanned Image
Ripple Patterns Appear in an Image
Scanned Image Colors Do Not Match Original Colors
Scanned Image Edges are Cropped

Parent topic: Solving Problems

Image Consists of a Few Dots Only

If your scanned image consists only of a few dots, try these solutions:

• Make sure you placed your original for scanning facing the correct way.
• If the **Image Type** setting is **Black & White**, adjust the **Threshold** and scan again.

**Parent topic:** Solving Scanned Image Quality Problems

**Related references**

Additional Scanning Settings - Advanced Settings Tab

**Related topics**

Placing Originals on the Product

---

**Line of Dots Appears in All Scanned Images**

If a line of dots appears in all your scanned images, try these solutions:

• Clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the cloth, if necessary. Paper towels are not recommended.

  **Caution:** Do not spray glass cleaner directly on the scanner glass.

• Make sure any interface cables are securely connected at both ends.

If you are scanning from the ADF, make sure the ADF edge guides fit against the loaded originals. You can also try cleaning the ADF and scanning again.

**Parent topic:** Solving Scanned Image Quality Problems

**Related tasks**

Cleaning the Automatic Document Feeder

---

**Straight Lines in an Image Appear Crooked**

If straight lines in an original appear crooked in a scanned image, make sure to place your original straight when you scan it.

If you are scanning from the ADF, make sure the ADF edge guides fit against the loaded originals. You can also try cleaning the ADF and scanning again.

**Parent topic:** Solving Scanned Image Quality Problems

**Related tasks**

Cleaning the Automatic Document Feeder

**Related topics**

Placing Originals on the Product
Image is Distorted or Blurry

If a scanned image appears distorted or blurry, try these solutions:
- Do not move your original or your product during scanning.
- Your product will not operate properly while tilted at an angle. Place your product on a flat, stable surface that extends beyond its base in all directions.
- Adjust these Epson Scan 2 settings (if available) and try scanning again:
  - Increase the Resolution setting.
  - If the Image Type setting is Black & White, adjust the Threshold setting.
  - If the Image Type setting is Color or Grayscale, select the Unsharp Mask setting.
  - If the Image Type setting is Black & White, select Text Enhancement. If the Image Type setting is Color or Grayscale, change the Text Enhancement setting to High.

Parent topic: Solving Scanned Image Quality Problems
Related references
   Additional Scanning Settings - Advanced Settings Tab

Image Colors are Patchy at the Edges

If you are scanning a thick or warped original, cover its edges with paper to block external light as you scan it.
Parent topic: Solving Scanned Image Quality Problems

Image is Too Dark

If your scanned image is too dark, try these solutions:
- If the Image Type is set to Color or Grayscale, adjust the Brightness setting.
- Check the brightness and contrast settings of your computer monitor.

Parent topic: Solving Scanned Image Quality Problems
Related references
   Additional Scanning Settings - Advanced Settings Tab

Back of Original Image Appears in Scanned Image

If an image from the back of a thin original appears in your scanned image, try these solutions:
- Place a piece of black paper on the back of the original and scan it again.
• Adjust these Epson Scan 2 settings (if available) and try scanning again:
  • Select the **Advanced Settings** tab and adjust the **Brightness** setting.
  • If the **Image Type** is set to **Black & White**, select **Text Enhancement**. If the **Image Type** is set to **Color** or **Grayscale**, change the **Text Enhancement** setting to **High**.

**Parent topic:** Solving Scanned Image Quality Problems

**Related references**
- Additional Scanning Settings - Advanced Settings Tab

**Ripple Patterns Appear in an Image**

You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused by interference from differing pitches in the scanner's screen and your original's halftone screen. To reduce this effect, adjust these Epson Scan 2 settings (if available) and try scanning again:
  • Select the **Descreening** setting.
  • Select a lower **Resolution** setting.

**Parent topic:** Solving Scanned Image Quality Problems

**Related references**
- Additional Scanning Settings - Main Settings Tab
- Additional Scanning Settings - Advanced Settings Tab

**Scanned Image Colors Do Not Match Original Colors**

Printed colors can never exactly match the colors on your computer monitor because printers and monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use CMYK (cyan, magenta, yellow, and black).

Check the color matching and color management capabilities of your computer, display adapter, and the software you are using to see if they are affecting the palette of colors you see on your screen.

To adjust the colors in your scanned image, adjust these Epson Scan 2 settings (if available) and try scanning again:
  • If the **Image Type** setting is **Color** or **Grayscale**, adjust the **Contrast** setting.
  • If the **Image Type** setting is **Black & White** or **Grayscale**, adjust the **Color Enhance** setting.

**Parent topic:** Solving Scanned Image Quality Problems

**Related references**
- Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab

**Scanned Image Edges are Cropped**

If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If necessary, move your original away from the edges of the scanner glass slightly.

*Parent topic: Solving Scanned Image Quality Problems*

*Related tasks*
Cleaning the Automatic Document Feeder

*Related topics*
Placing Originals on the Product

**Solving Faxing Problems**

Check these solutions if you have problems faxing with your product (WF-C17590/WF-C20590/WF-M20590F).

Cannot Send or Receive Faxes
Cannot Receive Faxes with a Telephone Connected to Your Product
Fax Memory Full Error Appears
Sent Fax Quality is Poor
Sent Fax is Received in an Incorrect Size
Received Fax Quality is Poor
Received Fax is Not Printed

*Parent topic: Solving Problems*

**Cannot Send or Receive Faxes**

If you cannot send or receive faxes, try these solutions:

- If an error code is displayed on the control panel, try the solutions suggested in the error code list.
- If you are faxing from a computer, use the Epson FAX Utility to send your fax.
- Make sure the recipient's fax machine is turned on and working.
- Make sure paper is loaded correctly in your product.
- Make sure you have set up your header information and have not blocked your caller ID. Otherwise, your faxes might be rejected by the recipient's fax machine.
• If user restriction has been enabled, you may need to enter a user name and password. Contact your administrator for assistance.

• If you did not connect a telephone to your product, set the Receive Mode setting to Auto so you can receive faxes automatically.

• Check that the cable connecting your telephone wall jack to your product's LINE port is secure.

• Print a fax connection report using your product control panel or fax software to help diagnose the problem.

• Verify that the telephone wall jack works by connecting a phone to it and testing it.

• If there is no dial tone and you connected the product to a PBX (Private Branch Exchange) phone line or Terminal Adapter, change the Line Type setting to PBX. If you still cannot send a fax, turn off the product's dial tone detection setting. (Turning off the dial tone setting may cause the product to drop the first digit of a fax number.)

• If you connected your product to a DSL phone line, you must connect a DSL filter to the phone jack to enable faxing over the line. Contact your DSL provider for the necessary filter.

• If your telephone line has static, turn off your product's error correction mode fax communication setting and try faxing again.

• Try lowering your product's fax speed setting.

• Make sure the error correction mode (ECM) setting is turned on if you are trying to send or receive a color fax.

• If your telephone line uses call waiting and you have trouble receiving faxes, turn off call waiting to prevent disruption of incoming faxes.

• If you have subscribed to a call forwarding service, the product may not be able to receive faxes. Contact your service provider for assistance.

• Check your inbox and delete faxes after reading or printing them. If the inbox is full, the product cannot receive faxes.

• If you cannot send faxes at a specified time, make sure the date and time are set correctly on the product.

• If you cannot receive A3-size faxes, make sure you selected the correct paper size setting for the paper source containing the A3-size paper. Also, be sure to enable the paper source to receive faxes as the Auto Select Settings option.

**Note:** If your product is connected to a VoIP (Voice over Internet Protocol) phone line, keep in mind that fax machines are designed to work over analog phone lines. Epson cannot guarantee that fax transmission will work when using VoIP.
If your phone line includes voice mail answering services, calls or faxes may be inadvertently received by your voice mail service.

**Parent topic:** Solving Faxing Problems

**Related references**

Job Status Error Codes

**Related tasks**

Connecting a Telephone or Answering Machine
Using the Fax Setup Wizard
Selecting the Line Type
Selecting Advanced Fax Settings
Receiving Faxes Automatically
Printing Fax Reports
Saving and Viewing Received Faxes

**Related topics**

Loading Paper

---

**Cannot Receive Faxes with a Telephone Connected to Your Product**

If you cannot receive faxes when a telephone is connected to your product, try these solutions:

- Make sure your telephone is connected to your product's **EXT** port.
- Make sure the Receive Mode is set to **Manual**.

**Note:** When answering a call that is a fax, wait until the product's LCD screen displays a message that a connection has been made before you hang up.

**Parent topic:** Solving Faxing Problems

---

**Fax Memory Full Error Appears**

If you see an error message telling you that the product's fax memory is full, try these solutions:

- If you set the product to save received faxes in the product's memory or inbox, delete any faxes you have already read.

**Note:** Your product can store up to 100 faxes before its inbox is full.
• If you set the product to save received faxes on a computer, turn on the selected computer. Once the faxes are saved on the computer, they are deleted from the product's memory.

• If you set the product to save received faxes on a USB device, connect the selected USB device containing the save fax folder to the product. Once the faxes are saved on the USB device, they are deleted from the product's memory.

  **Note:** Make sure the USB device has enough available memory and is not write protected.

• If the memory is full, try the following:
  • Send a monochrome fax using the direct sending feature
  • Send your faxes in smaller batches

• If the product cannot print a received fax due to a product error, such as a paper jam, the memory full error may appear. Clear any product errors, then ask the sender to resend the fax.

**Parent topic:** Solving Faxing Problems

**Related references**
Fax Sending Options

**Related tasks**
Saving and Viewing Received Faxes

### Sent Fax Quality is Poor

If the sent fax quality is poor, try these solutions:

• Clean the scanner glass.

• Clean the ADF.

• Try changing the resolution or density setting on the control panel.

• Try changing the original type setting on the control panel.

• If you are sending a monochrome fax to a single recipient, try sending the fax using the **Direct Send** feature.

  **Note:** If you send a high-resolution monochrome fax without using the **Direct Send** feature, the product may automatically lower the resolution.

• Try enabling the error correction mode (ECM) setting.

**Parent topic:** Solving Faxing Problems
Related tasks
Cleaning the Automatic Document Feeder

Sent Fax is Received in an Incorrect Size
If your recipient receives a fax in an incorrect size, try these solutions:
• If you are trying to fax an A3-size document, make sure the recipient's fax machine supports the paper size. If the message **OK (Reduced Size)** appears in the fax transmission report, the recipient's fax machine does not support A3-size documents.
• If you are sending a fax using the scanner glass, make sure your original is placed correctly and that the correct paper size is selected on the control panel.
• Clean the scanner glass and document cover.

Parent topic: Solving Faxing Problems

Received Fax Quality is Poor
If you receive a poor quality fax, try these solutions:
• Try enabling the error correction mode (ECM) setting.
• Contact the fax sender and ask them to send the fax in a higher resolution.
• Try reprinting the received fax.

Parent topic: Solving Faxing Problems

Received Fax is Not Printed
If a received fax is not printed, try these solutions:
• Make sure the product is free of errors. The product cannot print received faxes if an error has occurred with the product, such as a paper jam.
• If the product has been set to save received faxes in the product’s memory or inbox, received faxes are not automatically printed. Check the Receive Settings options on the product control panel and change them, if necessary.

Parent topic: Solving Faxing Problems
Related references
Receive Settings - Fax

Solving USB Device Problems
Check these solutions if you have problems using USB devices with your product.

Cannot View or Print from a USB Device
Cannot Save Files on a USB Device
Cannot Transfer Files To or From a USB Device

Parent topic: Solving Problems

Cannot View or Print from a USB Device
If you cannot view or print photos or documents from a USB device connected to your product, try these solutions:
• Make sure memory devices are enabled on the product.
• Make sure your device is compatible with the product.
• Make sure the files on your device are in the correct format.

Parent topic: Solving USB Device Problems
Related references
Interface Specifications
External USB Device Specifications

Related tasks
Setting Up File Sharing for File Transfers from Your Computer

Related topics
Viewing and Printing from the LCD Screen

Cannot Save Files on a USB Device
If you cannot save files on a USB device connected to your product, try these solutions:
• Make sure the device is not write-protected.
• Make sure the device has enough available space.
• Make sure memory devices are enabled on your product.
• Make sure the device is compatible with the product.

Parent topic: Solving USB Device Problems

Related references
Interface Specifications

Related tasks
Setting Up File Sharing for File Transfers from Your Computer

Cannot Transfer Files To or From a USB Device
If you have problems transferring files to or from a USB device connected to your product, try these solutions:
• Make sure your device is compatible with the product.
• Make sure your product is securely connected to your computer.
• Make sure that the file sharing setting for your product is enabled.

Parent topic: Solving USB Device Problems

Related references
Interface Specifications

Related tasks
Transferring Files from a USB Device to Your Computer

Uninstall Your Product Software
If you have a problem that requires you to uninstall and re-install your software, follow the instructions for your operating system.

Uninstalling Product Software - Windows
Uninstalling Product Software - Mac

Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
1. Turn off the product.
2. Disconnect any interface cables.

3. Do one of the following:

- **Windows 10**: Click ☰ and select (Settings) > Apps or System > Apps & features. Then select the program you want to uninstall and select Uninstall.

- **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Programs > Programs and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

  **Note**: If you see a User Account Control window, click Yes or Continue.

Select your product again, if necessary, then select OK, and click Yes to confirm the uninstallation.

- **Windows (other versions)**: Click ☰ or Start, and select All Programs or Programs. Select EPSON, select your product, then click EPSON Printer Software Uninstall.

  **Note**: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product and click OK. Then follow any on-screen instructions.

4. Do one of the following to uninstall Epson Scan 2, then follow any on-screen instructions:

- **Windows 10**: Select Epson Scan 2 and click Uninstall.

- **Windows 8.x/Windows 7/Windows Vista**: Select Epson Scan 2 and click Uninstall/Change.

- **Windows XP**: Select Epson Scan 2 and click Change/Remove.

5. Restart your computer, then re-install your software.

  **Note**: If you find that re-installing your product software does not solve a problem, contact Epson.

**Parent topic**: Uninstall Your Product Software

**Uninstalling Product Software - Mac**

In most cases, you do not need to uninstall your product software before re-installing it. However, you can download the Uninstaller utility from the Epson support website to uninstall your product software as described here.

  **Note**: If you find that re-installing your product software does not solve a problem, contact Epson.
1. To download the Uninstaller utility, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

2. Click Downloads.

3. Select your operating system, click Utilities, locate the Uninstaller utility, and click Download.

4. Run the file you downloaded.

5. Double-click the Uninstaller icon.

6. In the Epson Uninstaller screen, select the checkbox for each software program you want to uninstall.

7. Click Uninstall.

8. Follow the on-screen instructions to uninstall the software.

9. Reinstall your product software.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan, or Printers & Scanners window, select your product name and click the – (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help

If you need to contact Epson for technical support services, use the following support options.

Internet Support

Visit Epson’s support website at epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative

Before you call Epson for support, please have the following information ready:

• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem
Then call: (866) 212-8743, 6 AM to 6 PM, Pacific Time, Monday through Friday.
Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

**Purchase Supplies and Accessories**
You can purchase genuine Epson ink and paper at epson.com (U.S. sales), epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

**Parent topic:** Solving Problems
Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this site (Canada) for information on how to return your Epson products for proper disposal.

Windows System Requirements
Mac System Requirements
Paper Specifications
Printable Area Specifications
Scanning Specifications
Automatic Document Feeder (ADF) Specifications
Fax Specifications (WF-C17590/WF-C20590/WF-M20590F)
Ink Cartridge Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
External USB Device Specifications
Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating systems:

• Windows 10
• Windows 8.x
• Windows 7
• Windows Vista
• Windows XP Professional x64 Edition
• Windows XP SP3 or later
Windows Server supports only the printer driver, Epson Scan 2, and Document Capture Pro Server; any additional included software is not supported.

Note: For the latest product software available for your operating system, visit the Epson support site at epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean), select your product, and select Downloads.

Parent topic: Technical Specifications

Mac System Requirements

To use your product and its software, your Mac should use one of these operating systems:

- macOS 10.15.x
- macOS 10.14.x
- macOS 10.13.x
- macOS 10.12.x
- OS X 10.11.x
- OS X 10.10.x
- OS X 10.9.x
- OS X 10.8.x
- OS X 10.7.x
- OS X 10.6.8

Note: For the latest product software available for your operating system, visit the Epson support site at epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean), select your product, and select Downloads.
Parent topic: Technical Specifications

Paper Specifications

**Note:** Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a sample of paper stock before purchasing large quantities or printing large jobs.

**Single-sheets**

<table>
<thead>
<tr>
<th>Size</th>
<th>Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>13 × 19 inches</td>
<td>(330 × 483 mm)</td>
</tr>
<tr>
<td>11 × 17 inches</td>
<td>(279 × 432 mm)</td>
</tr>
<tr>
<td>11 × 14 inches</td>
<td>(279 × 356 mm)</td>
</tr>
<tr>
<td>A3 (11.7 × 16.5 inches)</td>
<td>(297 × 420 mm)</td>
</tr>
<tr>
<td>A4 (8.3 × 11.7 inches)</td>
<td>(210 × 297 mm)</td>
</tr>
<tr>
<td>A5 (5.8 × 8.2 inches)</td>
<td>(148 × 210 mm)</td>
</tr>
<tr>
<td>A6 (4.1 × 5.8 inches)</td>
<td>(105 × 148 mm)</td>
</tr>
<tr>
<td>B4 (13.9 × 9.84 inches)</td>
<td>(353 × 250 mm)</td>
</tr>
<tr>
<td>B5 (7.2 × 10.1 inches)</td>
<td>(182 × 257 mm)</td>
</tr>
<tr>
<td>B6 (5 × 7.2 inches)</td>
<td>(128 × 182 mm)</td>
</tr>
<tr>
<td>Letter (8.5 × 11 inches)</td>
<td>(216 × 279 mm)</td>
</tr>
<tr>
<td>Legal (8.5 × 14 inches)</td>
<td>(216 × 356 mm)</td>
</tr>
<tr>
<td>Executive (7.25 × 10.5 inches)</td>
<td>(184 × 267 mm)</td>
</tr>
<tr>
<td>Half Letter (5.5 × 8.5 inches)</td>
<td>(140 × 216 mm)</td>
</tr>
<tr>
<td>4 × 6 inches</td>
<td>(102 × 152 mm)</td>
</tr>
<tr>
<td>5 × 7 inches</td>
<td>(127 × 178 mm)</td>
</tr>
<tr>
<td>8 × 10 inches</td>
<td>(203 × 254 mm)</td>
</tr>
<tr>
<td>16:9 wide (4 × 7.1 inches)</td>
<td>(102 × 181 mm)</td>
</tr>
</tbody>
</table>
Paper types

Plain paper and thick paper

Note: Your product also supports compatible papers distributed by Epson. See the link at the end of this topic for a list of compatible Epson papers.

Weight

Plain paper: 16 lb (60 g/m²) to 42 lb (160 g/m²)
Thick paper: 43 lb (161 g/m²) to 90 lb (350 g/m²)

Envelopes

Size

No. 10 (4.1 × 9.5 inches [105 × 241 mm])

Paper types

Plain bond paper

Weight

20 lb (75 g/m²) to 24 lb (90 g/m²)

Parent topic: Technical Specifications
Related references
Compatible Epson Papers

Printable Area Specifications

Single sheets

Margin: 0.12 inch (3 mm)
* Direction paper is fed

Envelopes

1 Left/right margin: 0.12 inch (3 mm)
2 Top/bottom margin: 0.20 inch (5 mm)

Parent topic: Technical Specifications

Scanning Specifications

Scanner type: Flatbed
Photoelectric device: CIS
Effective pixels: 7020 × 20400 pixels at 7020 dpi
Document size:
- Maximum: 11.7 × 17 inches (297 × 431.8 mm)
- Scanner glass: A3 (11.7 × 16.5 inches [297 × 420 mm])
Scanning resolution:
- 600 dpi (main scan)
- 1200 dpi (sub scan)
Output resolution: 50 to 9600 dpi in 1 dpi increments
**Color depth**

- **Color:**
  - 30 bits per pixel internal (10 bits per pixel per color internal)
  - 24 bits per pixel external (8 bits per pixel per color external)

- **Grayscale:**
  - 10 bits per pixel external
  - 8 bits per pixel external

- **Black and white:**
  - 16 bits per pixel internal
  - 1 bit per pixel external

**Light source**

LED

Parent topic: Technical Specifications

---

**Automatic Document Feeder (ADF) Specifications**

- **Paper size**
  - A6 (4.1 × 5.8 inches [105 × 148 mm]) to A3 (11.7 × 16.5 inches [297 × 420 mm])

- **Paper type**
  - Plain paper, high-quality paper, recycled paper

- **Paper weight**
  - 14 lb (52 g/m²) to 35 lb (128 g/m²)

- **Sheet feeding capacity**
  - Total thickness: 0.65 inch (16.5 mm)
  - Approximately 150 sheets at 20 lb (75 g/m²)

**Note:** Depending on the quality of the paper, originals that meet the ADF specifications still may not feed or scan correctly.

Parent topic: Technical Specifications

---

**Fax Specifications (WF-C17590/WF-C20590/WF-M20590F)**

- **Fax type**
  - Walk-up black-and-white and color fax capability (ITU-T Super Group 3)
Support line
Standard analog telephone lines
PBX (Private Branch Exchange) telephone systems

Speed
Up to 33.6 kbps

Resolution
**Monochrome**
Standard: 203 pixels per inch × 98 lines per inch (8 pixels per mm × 3.85 lines per mm)
Fine: 203 pixels per inch × 196 lines per inch (8 pixels per mm × 7.7 lines per mm)
Super Fine: 203 pixels per inch × 392 lines per inch (8 pixels per mm × 15.4 lines per mm)
Ultra Fine: 406 pixels per inch × 392 lines per inch (16 pixels per mm × 15.4 lines per mm)

**Color**
200 × 200 dpi

Page memory
Up to 550 pages (ITU-T No. 1 chart; monochrome draft mode)

Redial
2 times (with 1 minute interval)

Interface
RJ-11 Phone Line
RJ-11 Telephone set connection

Parent topic: Technical Specifications

**Ink Cartridge Specifications**

**Note:** We recommend that you use genuine Epson maintenance boxes and cartridges and do not refill them. The use of other products may affect your print quality and could result in printer damage.

Part of the ink from the included set of cartridges is used for charging the printer. Yields vary considerably based on images printed, print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink remains in the cartridge after the "replace cartridge" indicator comes on.

**Color**
**WF-C17590/WF-C20590:** Cyan, Magenta, Yellow, Black
**WF-M20590/WF-M20590F:** Black
Ink cartridge life

Unopened package: do not use if the date on the package has expired.

Temperature

Storage: –4 to 104 °F (–20 to 40 °C)

1 month at 104 °F (40 °C)

Ink freezes at –6.8 °F (–14 °C)

Ink thaws and is usable after approximately 12 hours at 77 °F (25 °C)

Parent topic: Technical Specifications
Related references
Ink Cartridge and Maintenance Box Part Numbers

Dimension Specifications

Printer only

Storage:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>48.5 inches (1231 mm)</td>
</tr>
<tr>
<td>Width</td>
<td>26.5 inches (674 mm)</td>
</tr>
<tr>
<td>Depth</td>
<td>29.8 inches (757 mm)</td>
</tr>
</tbody>
</table>

Printing:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>48.5 inches (1231 mm)</td>
</tr>
<tr>
<td>Width</td>
<td>56.1 inches (1426 mm)</td>
</tr>
<tr>
<td>Depth</td>
<td>29.8 inches (757 mm)</td>
</tr>
</tbody>
</table>

All covers, trays, cassettes, and the ADF open:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>63.1 inches (1603 mm)</td>
</tr>
<tr>
<td>Width</td>
<td>60.8 inches (1544 mm)</td>
</tr>
<tr>
<td>Depth</td>
<td>48.2 inches (1255 mm)</td>
</tr>
</tbody>
</table>
Weight (without consumables)  Approx. 394.6 lb (179.0 kg)

Printer with optional finisher unit, bridge unit, and high-capacity input tray

Storage:
- Height 48.5 inches (1231 mm)
- Width 85.4 inches (2170 mm)
- Depth 29.8 inches (757 mm)

Printing:
- Height 48.5 inches (1231 mm)
- Width 91.5 inches (2325 mm)
- Depth 29.8 inches (757 mm)

All covers, trays, cassettes, and the ADF open:
- Height 63.1 inches (1603 mm)
- Width 110.6 inches (2808 mm)
- Depth 50.0 inches (1271 mm)

Weight (without consumables)  Approx. 685.4 lb (310.9 kg)

Parent topic: Technical Specifications

Electrical Specifications

- Power supply rating 100 to 240 V
- Rated frequency range 50/60 Hz
- Rated current 9.0 to 4.5 A
Power consumption
(with LAN and fax connection)

<table>
<thead>
<tr>
<th>Model</th>
<th>Standalone copying:</th>
</tr>
</thead>
<tbody>
<tr>
<td>WF-C17590</td>
<td>Approx. 170 W (ISO/IEC24712)</td>
</tr>
<tr>
<td>WF-C20590/WF-M20590/WF-M20590F</td>
<td>Approx. 180 W (ISO/IEC24712)</td>
</tr>
<tr>
<td>Ready mode</td>
<td>77 W</td>
</tr>
<tr>
<td>Sleep mode</td>
<td>1.4 W</td>
</tr>
<tr>
<td>Power off mode</td>
<td>0.4 W</td>
</tr>
<tr>
<td>Maximum power consumption:</td>
<td></td>
</tr>
<tr>
<td>WF-C17590</td>
<td>Approx. 300 W</td>
</tr>
<tr>
<td>WF-C20590/WF-M20590/WF-M20590F</td>
<td>Approx. 320 W</td>
</tr>
</tbody>
</table>

Parent topic: Technical Specifications

Environmental Specifications

Temperature
- Operating: 50 to 95 °F (10 to 35 °C)
- Storage (before initial ink charging): –4 to 104 °F (–20 to 40 °C)
- Storage (after initial ink charging): 6.8 to 104 °F (–14 to 40 °C)
  1 month at 104 °F (40 °C)

Humidity
- Operating: 15 to 85% RH
- Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications

Interface type
- Super-Speed USB (Device Class for computers)
- Hi-Speed USB (for Mass storage class for external storage)

Note: Epson cannot guarantee the operation of externally connected devices.

Parent topic: Technical Specifications
External USB Device Specifications

Do not use devices with the following requirements:

• Dedicated driver
• Security settings

**Note:** Use only external storage devices with independent AC power sources. External storage devices that are powered via USB are not recommended. Epson cannot guarantee the operation of externally connected devices.

<table>
<thead>
<tr>
<th>Hard disk and USB flash drives</th>
<th>2TB</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Formatted in FAT, FAT32, or exFAT.</td>
</tr>
</tbody>
</table>

**Parent topic:** Technical Specifications

Network Interface Specifications

**Note:** Wireless LAN standard complies with either IEEE 802.11 b/g or IEEE 802.11 b/g/n, depending on purchase location.

**Wi-Fi**

<table>
<thead>
<tr>
<th>Standard</th>
<th>IEEE 802.11 b/g/n; complies with either IEEE 802.11 b/g or IEEE 802.11 b/g/n, depending on purchase location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security</td>
<td>WEP (64/128 bit)</td>
</tr>
<tr>
<td></td>
<td>WPA2-PSK (AES)</td>
</tr>
<tr>
<td></td>
<td>WPA-2 Enterprise</td>
</tr>
<tr>
<td>Frequency band</td>
<td>2.4 GHz</td>
</tr>
<tr>
<td>Communication mode</td>
<td>Infrastructure mode</td>
</tr>
<tr>
<td></td>
<td>Wi-Fi Direct (Simple AP); not supported for IEEE 802.11b</td>
</tr>
</tbody>
</table>
Ethernet

Standards
- IEEE802.3i (10BASE-T)
- IEEE802.3u (100BASE-TX)
- IEEE802.3ab (1000BASE-T); to prevent risk of radio interference, use a Category-5e or higher shielded twisted pair cable
- IEEE802.3az (Energy Efficient Ethernet); connected device should be IEEE802.3az compliant

Communication mode
- Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100Mbps Full duplex, 100Mbps Half duplex

Connector
- RJ-45

Security Protocol
- IEEE802.1X (requires a connected device compliant with IEEE802.1X)
- IPsec/IP Filtering
- SSL/TLS; HTTPS Server/Client and IPPS
- SMTPS; STARTTLS and SSL/TLS
- SNMPv3

Parent topic: Technical Specifications

Safety and Approvals Specifications

United States
- Safety: UL60950-1
- EMC: FCC part 15 Subpart B class B

Canada
- Safety: CAN/CSA C22.2 No. 60950-1
- EMC: CAN ICES-3 (B)/NMB-3 (B)

This equipment contains the following wireless module:
- Manufacturer: Askey Computer Corporation.
- Type: WLU6320-D69 (RoHS)

This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102 of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities: hands, wrists, feet and ankles).

**Parent topic:** Technical Specifications
Notices

Check these sections for important notices about your product.

**Note:** Epson offers a recycling program for end of life Epson products. Please go to [this site](#) (U.S) or [this site](#) (Canada) for information on how to return your Epson products for proper disposal.

**Important Safety Instructions**

Before using your Epson product, read and follow these safety instructions.

**General Product Safety Instructions**

- Be sure to follow all warnings and instructions marked on the product.
- Use only the type of power source indicated on the product's label.
- Use only the power cord that comes with the product. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
- Make sure the AC power cord meets the relevant local safety standard.
- Place the product near a wall outlet where the plug can be easily unplugged.
- Avoid plugging the product into an outlet on the same circuit as a photo copier or air control system that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
• Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or run over. Be careful to keep the cord straight at each end.

• If you use an extension cord with the product, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

• Always turn off the product using the power button, and wait until the power light stops flashing before unplugging the product or cutting off power to the electrical outlet.

• If you will not be using the product for a long period, unplug the power cord from the electrical outlet.

• Place the product on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.

• Allow space behind the product for the cables, and space above the product so that you can fully raise the document cover.

• Leave enough space in front of the product for the paper to be fully ejected.

• Leave enough space in front and on the sides of the product for printing and maintenance.

• Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

• Do not place or store the product outdoors.

• Do not place the product near excessive heat sources or in direct sunlight.

• Leave enough room around the product for sufficient ventilation. Do not block or cover openings in the case or insert objects through the slots.

• Keep the product away from potential sources of electromagnetic interference, such as loudspeakers or the base units of cordless telephones.

• When connecting the product to a computer or other device with a cable, ensure the correct orientation of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may damage both devices connected by the cable.

• Do not sit or lean on the product. Do not place heavy objects on the product.

• Do not move the print head by hand; this may damage the product.

• Do not put your hand inside the product while it is printing.

• Do not spill liquid on the product or use the product with wet hands.

• Do not use aerosol products that contain flammable gases inside or around the product. Doing so may cause fire.
• Do not press too hard on the scanner glass when placing originals.
• Do not open the scanner section while the product is copying, printing, scanning, or performing any other functions.
• Be careful not to trap your fingers when closing the document cover or scanner.
• Except as specifically explained in your documentation, do not attempt to service or disassemble the product yourself.
• Unplug the product and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.
• Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may prevent the product from printing.
• When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down; otherwise, ink may leak.
• Do not attempt to move the product by yourself.
• Make sure the adjuster bolts are locked when using the product. Do not move the product when the adjuster bolts are locked.

Note: The lithium batteries in this product contain Perchlorate Material - special handling may apply. Click here for details.

Parent topic: Important Safety Instructions

Ink Cartridge Safety Instructions

• Keep ink cartridges out of the reach of children and do not drink the ink.
• Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.
• Do not put your hand inside the product or touch any cartridges during printing.
• Install a new ink cartridge immediately after removing an expended one. Leaving cartridges uninstalled can dry out the print head and may prevent the product from printing.
• Do not remove or tear the label on the cartridge; this can cause leakage.
• Do not remove the transparent seal from the bottom of the cartridge. This may cause the cartridge to become unusable.
• Do not break the hooks on the side of the cartridge when removing it from the packaging.
• Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation.
• Do not shake cartridges after opening their packages; this can cause them to leak.
• If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the product. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.
• Use an ink cartridge before the date printed on its package.
• Do not dismantle an ink cartridge. This could damage the print head.
• Store ink cartridges in a cool, dark place.
• Make sure to install all ink cartridges. The printer only works when all ink cartridges are properly installed.
• After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least 12 hours before using it.
• Store ink cartridges with their long narrow sides down and their labels facing upward.

Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions

Radio waves from this product may adversely affect the operation of medical equipment or automatically controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near such devices or inside a medical facility, follow the directions from authorized staff members at the facility, and follow all posted warnings and directions on the device to avoid causing an accident.

Parent topic: Important Safety Instructions

LCD Screen Safety Instructions

• Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
• If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.
• Do not press too hard on the LCD screen or subject it to heavy impacts.
• Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
• If the LCD screen chips or cracks, do not touch or attempt to remove the broken pieces; contact Epson for support.
• Do not subject your product to sudden changes in temperature or humidity; this may cause condensation to develop inside the LCD screen and degrade its performance.

Parent topic: Important Safety Instructions

Telephone Equipment Safety Instructions

When using telephone equipment, you should always follow basic safety precautions to reduce the risk of fire, electric shock, and personal injury, including the following:

• Do not use the Epson product near water.
• Avoid using a telephone during an electrical storm. There may be a remote risk of electric shock from lightning.
• Do not use a telephone to report a gas leak in the vicinity of the leak.

Caution: To reduce the risk of fire, use only a No. 26 AWG or larger telecommunication line cord.

Parent topic: Important Safety Instructions

FCC Compliance Statement

For United States Users
This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council for Terminal Attachments ("ACTA") . On the surface of this equipment is a label that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided to the telephone company.

Applicable certification jack Universal Service Order Codes ("USOC") for the equipment: RJ11C.

A plug and jack used to connect this equipment to the premises wiring and telephone network must comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular plug is provided with this product. It is designed to be connected to a compatible modular jack that is also compliant. See installation instructions for details.

The REN is used to determine the number of devices that may be connected to a telephone line. Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices that may be connected to a line, as determined by the total RENs, contact the local telephone company. For products approved after July 23, 2001, the REN for this product is part of the product
identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal point (e.g., 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.

If this equipment causes harm to the telephone network, the telephone company will notify you in advance that temporary discontinuance of service may be required. But if advance notice isn’t practical, the telephone company will notify the customer as soon as possible. Also, you will be advised of your right to file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations or procedures that could affect the operation of the equipment. If this happens the telephone company will provide advance notice in order for you to make necessary modifications to maintain uninterrupted service.

If you have problems with this product and require technical or customer support, please visit www.epson.com for more information.

This product is not intended to be repaired by the customer. If you experience trouble connecting this equipment to a telephone line, please contact:

Name: Epson America, Inc.
Address: 3840 Kilroy Airport Way, Long Beach, CA 90806 U.S.A.
Telephone: (562) 981-3840

If the equipment is causing harm to the telephone network, the telephone company may request that you disconnect the equipment until the problem is resolved.

This equipment may not be used on coin service provided by the telephone company. Connection to party line service is subject to state tariffs. Contact the state public utility commission, public service commission or corporation commission for information.

If your home has specially wired alarm equipment connected to the telephone line, ensure the installation of this equipment does not disable your alarm equipment. If you have questions about what will disable alarm equipment, consult your telephone company or a qualified installer.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic device, including fax machines, to send any message unless such message clearly contains in a margin at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it is sent and an identification of the business or other entity, or other individual sending the message and the telephone number of the sending machine or such business, other entity, or individual. (The telephone number provided may not be a 900 number or any other number for which charges exceed local or long-distance transmission charges.)

In order to program this information into your fax machine, click the link below for instructions on entering fax header information.

According to the FCC’s electrical safety advisory, we recommend that you may install an AC surge arrester in the AC outlet to which this equipment is connected. Telephone companies report that
electrical surges, typically lightning transients, are very destructive to customer terminal equipment connected to AC power sources and that this is a major nationwide problem.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification or Declaration of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

1. This product meets the applicable Innovation, Science and Economic Development Canada technical specifications.

2. The Ringer Equivalence Number indicates the maximum number of devices allowed to be connected to a telephone interface. The termination of an interface may consist of any combination of devices subject only to the requirement that the sum of the RENs of all the devices does not exceed five.

CAN ICES-3(B)/NMB-3(B)

Le présent produit est conforme aux spécifications techniques applicables d'Innovation, Sciences et Développement économique Canada.

L'indice d'équivalence de la sonnerie (IES) sert à indiquer le nombre maximal de dispositifs qui peuvent être raccordés à une interface téléphonique. La terminaison d'une interface peut consister en une combinaison quelconque de dispositifs, à la seule condition que la somme des IES de tous les dispositifs n'excède pas cinq.
Binding Arbitration and Class Waiver

1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS

1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term "Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim, controversy or action between you and Epson arising out of or relating to this Agreement, Epson branded products (hardware and including any related software), or other transaction involving you and Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation, ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement, (c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson also agree, notwithstanding Section 1.6, that a court, not an arbitrator, may decide if a claim or cause of action is for an IP Claim.

1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED. Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C. §1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this Agreement.

1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3840 Kilroy Airport Way, Long Beach, CA 90806 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent address Epson has in its records for you. For this reason, it is important to notify us if your address changes by emailing us at EAILegal@ea.epson.com or writing us at the Epson Address above. Notice of the Dispute shall include the sender's name, address and contact information, the facts giving rise to the
Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson and you agree to act in good faith to resolve the Dispute before commencing arbitration.

1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small claims court of your state or municipality if the action is within that court's jurisdiction and is pending only in that court.

1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED. ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION PROCEEDING.

1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration on a class or representative basis (the "JAMS Rules"), available at http://www.jamsadr.com or by calling 1-800-352-5267, and under the rules set forth in this Agreement. All Disputes shall be resolved by a single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising out of or relating to the interpretation, applicability, enforceability or formation of this Agreement, including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1 above. The arbitrator shall be empowered to grant whatever relief would be available in a court under law or in equity. The arbitrator may award you the same damages as a court could, and may award declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent necessary to provide relief warranted by that party's individual claim. In some instances, the costs of arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration than in court. The arbitrator's award is binding and may be entered as a judgment in any court of competent jurisdiction.

You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by telephone shall take place in a location reasonably accessible from your primary residence, or in Orange County, California, at your option.

a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties agree to the following procedure:
(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount of damages sought to be recovered. You can find a copy of a Demand for Arbitration at http://www.jamsadr.com ("Demand for Arbitration").

(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North State College Blvd., Suite 600 Orange, CA 92868, U.S.A.

(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute Notice), or as otherwise agreed by the parties.

b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled. The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during the arbitration.

c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.

d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and expenses to be paid by Epson pursuant to this Section 1.6d).

e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section 1.6d) above does not limit your rights to attorney's fees and expenses under applicable law; notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and expenses.

1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual arbitration procedure and waiver of class and representative proceedings specified in this Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent to this Agreement (including without limitation the purchase, download, installation of the Software or other applicable use of Epson Hardware, products and services) that specifies (i) your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding individual arbitration procedure and waiver of class and representative proceedings specified in this Section 1. In the event that you opt-out consistent with the procedure set forth above, all other terms shall continue to apply, including the requirement to provide notice prior to litigation.

1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and
class action waiver provisions (other than a change to Epson’s address) in this Agreement, Epson will obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you timely elected to opt-out when you first assented to this Agreement).

1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not apply to the prohibition against class or representative actions as provided in Section 1.5. This means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1) shall be null and void.

Parent topic: Notices

### Trademarks

EPSON® is a registered trademark, EPSON Exceed Your Vision is a registered logomark, and Epson Connect™, Epson iPrint™, and Remote Print™ are trademarks of Seiko Epson Corporation.

Epson Store℠ is a service mark of Epson America, Inc.

Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.

Apple, App Store, iPhone, Mac, OS X, and macOS are trademarks of Apple Inc., registered in the U.S. and other countries.

Use of the Works with Apple badge means that an accessory has been designed to work specifically with the technology identified in the badge and has been certified by the developer to meet Apple performance standards.

Google® is a registered trademark and Android™, Chromebook™, Gmail™, Google Chrome™, Google Cloud Print™, and Google Drive™ are trademarks of Google LLC.

Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables other than those designated as Epson approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

libTIFF Software Acknowledgment

Copyright © 1988-1997 Sam Leffler

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (I) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.
THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Parent topic: Copyright Notice

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to sleep to a shorter interval.

Parent topic: Copyright Notice

Copyright Attribution

© 2020 Epson America, Inc.
4/20
CPD-53697R5

Parent topic: Copyright Notice